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1 Overview

1.1 Benefits

[ ] Easy Backup of

Microsoft Exchange Server 2000 / 2003

Microsoft SQL Server 7.0 / 2000

Lotus Domino/Notes 5.0 or above

Oracle 8i or above

MySQL 3.2.4 or above

Windows System State

Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab)

Important personal settings, e.g. Desktop, Favorite, My Documents and History etc
9.  Other common files (e.g. *.doc, *.xIs)

Support backing up only changes within a file (using in-file delta technology)

Support backing up of open files on Windows XP/2003 (Volume Shadow Copy)

Support backing up of Windows NTFS access privileges, Linux access privileges and modes, Mac OS

X metadata and resource forks

] Easy to use, deploy and maintain

ONouhwNE

1.2 Features

(New in 5.2) Full support of Microsoft Exchange individual email, contacts, calendars, tasks etc.
(New in 5.2) Choose whether to restore “file permissions” during restore.

(New in 5.2) For “Local Copy” backup, ability to choose whether to perform a local copy backup only
and skip the offsite backup.

(New in 5.2) Lotus Notes/Domino agent for Linux.

(New in 5.2) Auto Upgrade Agent to automatically upgrade the client software.

User configurable incremental / differential in-file delta backup mode (i.e. backing up only changes
within a file since the last incremental or full backup according to each user’s preference).

u Allow in-file delta backup mode to be overridden by each user individually according to backup time
(e.g. enforcing full (or incremental or differential) backup of all files every Sunday or the 1% day of
every month).

] Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g.
Outlook.pst).

] In-File Delta backup (i.e. backing up only changes within files).

u Off-line backup mode and logout backup reminder.

] Customizable backup schedule allows backups to be scheduled at any time.

u Compress and encrypt data automatically before sending them to the server (server stores only
encrypted data).

u Increment backup strategy ensures that only new or updated files are sent to the backup server.

] Support both full backup (database backup) and incremental backup (transaction log backup) for
Microsoft SQL Server 7.0/2000, Microsoft Exchange Server 2000/2003, Lotus Domino/Notes 5.0 and
Oracle 8i or above.

u Can integrate with external “Open File Manager” to provide open file backup support to all open files.

] Access backup data anytime, anywhere by using a web browser.

u Comprehensive backup report lists all files backed up. Backup report delivered automatically via email.

] Backup data are CRC validated before they are stored on server.

u Fully user customizable data retention policy allows users to have access to deleted files using the
least possible storage space on the backup server.

u Can select source backup files easily by using a backup filter, e.g. selecting all *.doc and *.xIs in your
computer in a single operation.

] Run any custom OS commands before/after a backup job.

[ ] Run on Windows, Mac OS X, Linux, NetWare, Unix and all other platforms supporting a Java2

Runtime Environment.
] Periodic backup files validation on backup server ensures backup files are 100% valid and fully
restorable when needed.
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1.3 Security

128-bit point-to-point SSL communication between server and client

Support HTTP/HTTPS Proxy and Socks v4/v5 firewall

Data are 128-bit encrypted when stored on the backup server

Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard

(AES)

Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining

(CBC)

] An random initializing vector, salt and iteration count will be generated by the software automatically
for each file when encrypting your data

] Each backup user can restrict online access to his files to his pre-defined list of IP addresses

1.4 System Requirements

Server Software (OBS)

[ ] Operating System:
1.  Windows 2000/ XP /2003 *
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel
2.6.9-34 or above is recommended)
3. Mac OS X 10.2 or above
4.  All other operating systems that supports Java2 Runtime Environment 1.4.1 or above
] Memory: 128MB (minimum), 512MB (recommended)
] Disk Space: 250MB
] Network Protocol: TCP/IP (http/https)

* The use of Windows 2000 WorkStation and XP Professional is only recommended for backup system with less
than 20 users. For 20 or more users, please use Windows 2000 or 2003 Server instead.

Client Software (OBM)

] Operating System:
1. Windows 95/98/ME /NT /2000 / XP /2003
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel
2.6.9-34 or above is recommended)
Solaris 2.x or above
Mac OS X 10.2 or above
NetWare 5.1 or above (with Perl v5.8.4 or above)
All other operating systems that supports Java2 Runtime Environment 1.3.1 or above
] Memory 128MB (minimum), 256MB (recommended)
] Disk Space: 100MB
] Network Protocol: TCP/IP (http/https)

oUW

** Standard C++ libraries for backwards compatibility compiler (compat-libstdc++-x.x-y.y.y.y.i386.rpm) must be
installed if you are not using a Linux 2.2 kernel. These libraries are required to run all Java applications.
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2

Installing OBM

Before you can start backing up data to the Offsite Backup Server, you need to install the Online Backup Manager
(OBM) client onto your computer.

2.1

Installing OBM for Windows

2. Double click the icon to run the installer.

3. Follow on screen instructions.

4. After installation, OBM will start automatically.

3 Online Backup Services Management Console - Microsoft Internet Explorer =210

Select your Operating System

WMy

solaris

Erini

Installation Guide - OBM - Windows

System Requirement

Operating System : Windows 95 / 98 / ME / NT / 2000 / XP / 2003
Memory : 128 Mbytes
Disk Space : 100 Mbytes
Network Protocol : TCP/IP (Http/Https)
Additional Requirement:
o E'vmdows 95 - Please download and install Windows Socket 2 Update for Windows 95
w9Sws2setup.exe)
O Windows NT / 2000 / XP / 2003 - Please make sure you have logged onto Windows
using an account with administrative privileges

Online Backup Manager - cbm-win.exe

1. Download the setup file (obm-win.exe) above and run it

LU L

2. Follow the instructions on the installation wizard to complete installation

3. When finished, a new icon (OBM) will be installed to the system tray (near the clock)
automatically and OBM will be launched automatically.

4. (optional) Enter the backup server host name in the [Address] field and press the [Next]
button.

-

=l

Download the Online Backup Manager installer (obm-win.exe) from the website.
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2.2

Installing OBM for Mac OS X

1. Download the Online Backup Manager installer (obm-mac.zip) from the website.

2. Expand the zip file.

3. Double click the pkg file icon to run the installer.

4. Follow on screen instructions.

5. After installation, the installer will need to restart your computer.

6. After restarting your computer, click the newly added OBM icon on your desktop. You can manually drag

the icon to your dock bar if you wish.

3 Online Backup Services Management Console - Microsoft Internet Explorer

=101 x|

Select your Operating System

ey Pl
iy ‘! é N solaris
Installation Guide - OBM - Mac 0S X print =

Operating System : Mac 05 X v10.x
Memory : 128 Mbytes
Disk Space : 20 Mbytes
Network Protocol : TCP/IP (Http/Https)
Additional Requirement:
O Apple Java2 Standard Edition 1.3.x or above must be installed already

LB

Online Backup Manager - gbm-mac.zip

1. Download the setup file (obm-mac.zip) above

2. Expand the archive and run the installation wizard [OBM] within the archive
3. Follow the instructions on the installation wizard to complete installation

4. Restart your Mac. Double click the desktop OBM icon to start.

S. (optional) Enter the backup server host name in the [Address] field and press the [Next]
button.

6. If you don't have a backup account, select [Trial Registration] and press the [Next] button

=
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2.3

3 Online Backup Services Management Console - Microsoft Internet Explorer

Installing OBM for Linux

Download the Online Backup Manager tarball release (obm-linux.tar.gz) from the website.

Set the OBM_HOME environment variable

# export OBM_HOME=/usr/local/obm

Expand the client software to $OBM_HOME

# mkdir $0BM_HOME
# tar —x —C $OBM_HOME -zvf obm-linux.tar.gz

Install OBM

# cd $OBM_HOME
# ./bin/install.sh

Start Auto Upgrade Agent

# /etc/init.d/auaobm start

Start backup scheduler

# /etc/init.d/obm-scheduler start

Set the DISPLAY environment variable

# export DISPLAY=IP_ADDRESS_OF XTERMINAL[:0.0]

Run OBM

# sh $OBM_HOME/bin/BackupManager.sh &

=101 x|

Select your Operating System

Y ‘! Q N sof;;‘;fg

LU

Get Started - X Window Mode

1.

2.

Installation Guide - OBM - Linux Print

System Requirement

Operating System : Linux Kernel 2.2 or above (e.g. Redhat 6.0 or above)

Memory : 128 Mbytes

Disk Space : 100 Mbytes

Network Protocol : TCP/IP (Http/Https)

Additional Requirement:

0 The Standard C++ libraries for backwards compatibility compiler {(compat-libstdc++-

X.X-¥.¥.¥.y.i386.rpm) are required to run Online Backup Manager correctly. If it is not
installed already, please download and install this library from your Linux vendor.

Online Backup Manager - cbm-linux.tar.gz

Download the setup file (obm-linux.tar.gz) above

Set the OBM_HOME environment variable (directory to where Online Backup Manager is to
be installed)

export OBM_HOME=/usr/local/obm
Unpack the install file to OBM_HOME

mkdir $§0BM_HOME

Far v o~ EOEM HOME »uf ahmolings bar e
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2.4

Installing OBM for Netware

2. Expand the zip file to SYS:\OBM

3. Install OBM

SYS:\> SYS:\OBM\aua\bin\install-aua.ncf

4. Start Auto Upgrade Agent

SYS:\> SYS:\OBM\aua\bin\startup.ncf

5. Start backup scheduler

SYS:\> SYS:\OBM\bin\Scheduler.ncf

6. Run OBM

SYS:\> SYS:\OBM\bin\RunBackupManager.ncf

7} Online Backup Services Management Console - Microsoft Internet Explorer

Download the Online Backup Manager zip release (obm-netware.zip) from the website.

=10l x|

Select your Operating System

Wiy,

solaris

Installation Guide - OBM - NetWare

System Requirement

Erini

Operating System : Novell NetWare 5.1 or above
Memory : 128 Mbytes

Disk Space : 100 Mbytes

Network Protocol : TCP/IP (Http/Https)
Additional Requirement:

LU L

O Novell JVM 1.3.x or above for NetWare must be installed already

Online Backup Manager - chm-netware.zip

1. Download the setup file (obm-netware.zip) above
2. Expand the zip file to SYS:\OBM
3. Install OBM

SYS:\OBM\aua\bin\install-aua.ncf

4. Start Auto Upgrade Agent

)

¥S:\OBM\aua\bin\startup.ncf

-

Leb Shama Company Limited

Page 10 of 122

(February 12, 2008)



[ )
AHJ{LU Offsite Backup Server v5.2

committed to the success of your business User’'s Guide

2.5 Installing OBM for Sun Solaris

1. Download the Online Backup Manager tarball release (obm-solaris.tar.gz) from the website.

2. Set the OBM_HOME environment variable

# export OBM_HOME=/usr/local/obm; export OBM_HOME

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE)
1.4.x has been installed

# export JAVA_HOME=/usr/java/j2rel.4.x; export JAVA_HOME

4. Expand the client software to $OBM_HOME
# mkdir $OBM_HOME

# cd $OBM_HOME
# gunzip -c obm-solaris.tar.gz | tar —xf -

5. Install OBM

# ./bin/install.sh

6. Start Auto Upgrade Agent

# /etc/init.d/auaobm start

7. Start backup scheduler

# /etc/init.d/obm-scheduler start

8. Set the DISPLAY environment variable

# export DISPLAY=IP_ADDRESS_OF XTERMINAL[:0.0]

9. Run OBM

# sh $OBM_HOME/bin/BackupManager.sh &

3 Online Backup Services Management Console - Microsoft Internet Explorer

Y

Installation Guide - OBM - Solaris Print =

System Requirement

Operating System : Sun Solaris 2.5 or above
Memory : 128 Mbytes

Disk Space : 100 Mbytes

Network Protocol : TCP/IP (Http/Https)

Online Backup Manager - gbm-solaris.tar,

1. Download the setup file (obm-solaris.tar.gz) above

Select your Operating System

Wiy

solaris

2. Set the OBM_HOME environment variable (directory to where Online Backup Manager is to
be installed)

export OBM_HOME=/usr/local/obm

3. Set the JAVA_HOME environment vanable (directory where J25E Java Runtime Environment
(JRE) 1.4.x has been installed)

JAVA_HOME=/usr/java/j2rel.4.x; export JAVA_HOME

4. Unpack the install file to OBM_HOME
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3 Uninstalling OBM

This section describes the steps required to uninstall OBM from your computer.

3.1

3.2

3.3

3.4

Uninstalling OBM for Windows

Open [Start] -> [Control Panel] -> [Add/Remove Programs]

Select [OBM] from the list and press the [Remove] button

Uninstalling OBM for Mac OS X

Remove all program files by running

# cd $OBM_HOME/bin
# sudo ./uninstall.sh

Remove all backup setting by removing ~/.obm

# rm —rf —~/.obm

Restart your computer

Uninstalling OBM for Linux

Change user to “root” or equivalent

Remove all program files by running

# cd $OBM_HOME/bin
# ./uninstall.sh

Remove all backup setting by removing ~/.obm

# rm —rf —~/.obm

Uninstalling OBM for Netware

Stop the running backup scheduler by running

SYS:\> touch SYS:\OBM\ipc\Scheduler\stop

Stop the running auto upgrade agent by running

SYS:\> SYS:\OBM\aua\bin\shutdown.ncf
Remove all program files by removing the directory SYS:\OBM

Remove all backup settings by removing the directory SYS:\.OBM
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3.5 Uninstalling OBM for Solaris

1. Change user to “root” or equivalent

2. Set the OBM_HOME environment variable

# export OBM_HOME=/usr/local/obm; export OBM_HOME

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE)
1.4.x has been installed

# export JAVA_HOME=/usr/java/j2rel.4.x; export JAVA_HOME

4. Remove all program files by running

# cd $OBM_HOME/bin
# ./uninstall.sh

5. Remove all backup setting by removing ~/.obm

# rm —rf —~/.obm
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4 Using OBM

This chapter will describe all the features available in OBM and outline how you can use OBM to meet various

backup needs.

4.1 System Tray Launcher (Windows Only)

After you have successfully installed OBM onto your computer, an OBM icon will be added to the system tray area
(next to your system clock) automatically.

Backup 4
Backup and Logoff 4
Backup and Eestart 4
Backup and Shutdown  *

Help

Exit

D 1446

This icon is the entry point to OBM. Right clicking the icon will show a menu that provides the following functions:

Menu Item What it does
Open Run OBM.
Backup Runs a specific backup set (or all backup sets) chosen from the sub-

menu in silent background mode.

Backup and Logoff

Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and then logoff from Windows when
finished.

Backup and Restart

Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and restart Windows when finished.

Backup and Shutdown

Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and shutdown the computer when
finished.

Help

Shows a help dialog

Stop running backup

Interrupts a running backup set (or all backup sets) chosen from the
sub-menu.

Exit

Close this system tray launcher application.

4.2 Logon Dialog

Before you can use OBM, you have to be authenticated by the Offsite Backup Server first. The logon dialog shown
below will check if you have the right to access OBM by submitting the username and password you provided to

the backup server.
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= E

\ Login Name: Idemo

* password: ["**

¥ Save password
Language

|Engl|sh L]
Backup Server

& hitp  hitps

Address: [www backup-provider.com|

Proxy Setting
 Proxy " Socks + MNone
Ok | Cancel Options <<

Please logon to Online Backup Manager.

For secure communication, you can choose to communicate with Offsite Backup Server in SSL (Secure Socket
Layer) by selecting the [https] option.

The [Address] field shows the Offsite Backup Server to which OBM will connect to authenticate your username
and password. You can use either a resolvable host name (e.g. backup.your-domain.com) or an IP address (e.g.
192.168.1.1).

If the Offsite Backup Server is not accepting connection from the standard ports (Port 80 and 443 for http and
https respectively), you can append a semi-colon “:” and the custom port number to the host name of the
[Address] field (e.g. www.backup-provider.com:8080) to connect to the server using the custom port number
(port 8080 in this case).

If you need to connect to the server through proxy, just enter your proxy setting in the [Proxy Setting] section.
For [SOCKS] proxy, both v4 and v5 without user authentication are supported.

4.3 Language Selection

You can switch the language of the OBM user interface by choosing the desired language available from the
[Language] drop down list. The languages available includes English, Czech, Danish, Dutch, French, Spanish,
Portuguese, Icelandic, Norwegian, Finnish, Italian, German, Swedish, Chinese (Traditional and Simplified),
Japanese, Lithuanian and Slovenian.

=

\( Login Name: Idemo

Password: |‘“"

¥ Save password
Language

English -

0K | Cancel | Options ==

Please logon to Online Backup Manager.
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4.4 User Profile

After the backup server authenticates you successfully, the OBM main window appears. You can then use OBM to
update your user profile.

RI=EY

Backup Set Backup Restore Tools View Help
|5 save Setting |} Start Backup [l Stop Backup |

t.'} Backup Controller r_x [—_‘. User Profile

[—’;‘.L,!serProﬂle
=H @) FileBackupSet-1

~User Infarmation

i Backup Source Login Marne:  derno
)
= Eackun S.chedule Passwird: S Change
4 Backup Filter —_—
—E Command Line Tool Dizplay Name: Demaonstration Account Change
1 setting
[—laad Eneryption ~Account Infarmation
—\T—;_[ Retention Palicy _
Extra Backup Cluota: A0m
% In-File Delta Tirme Zone: [GMT+08:00 (HKT) =
—éLocal Copy
~Contact
|dem0@vuur—c0mpany.c0m LI

Contact Mame: Demonstration Account
Email Address: demog@your-company.com

Add Remaove Froperties
& Backup Ib\ Restore| & L0g|
|We|cometu Online Backup Manager! |Quota (Remaining ! Totaly: 50M 1 a0n |LastBackup: -

You can perform the following update to your user profile.

To change your [Password], press the [Change] button next to the password field. A Change Password dialog will
appear. Enter your original password and new password into the text field of this dialog and press [OK].

01 Paszword:

|
Wewr Paspunord: I
!

Confirm New Password:

DE | Cancel |

To change your [Display Name], press the [Change] button next to the display name field. A Change Display
Name dialog will appear. Enter the new display name and press [OK].

Display Mame: |Dem|:| Accaunt

0K | el |

To change your [Time Zone], just select your time zone from the drop down list next to the time zone entry.

To add a new contact email to this account, press the [Add] button in the [Contact] section. A [Add New Contact]
dialog will appear. Enter a name and an email address in the text field provided and then press the [OK] button.
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Contact Mame: I

Ermail Address: I
(0):4 | Cancel |

To remove a contact email, select the email that is to be removed from the email list and press the [Remove]
button. Press [OK] to confirm the removal.

To update a contact email, select the email that is to be updated from the email list and press the [Properties]
button. A [Update Contact Property] dialog will appear. After you have made the changes that you want, press
the [OK] button.

Contact Marme: IDemn Accuunﬂ

Email Address; Idemn@yuur—cumpanv.cum

)4 | Canrel |

4.5 Backup Logs

All backup activities are logged to backup activity log files. They are available for reviewing from OBM.

How to review backup activities?

You can review all your backup Jobs by

1. Select the [Log] tab available at the bottom of OBM

2. Select the Backup Job you want to review on the [Log Controller] panel

Il
Backup Set Backup Restore Tools View Help
H Save Setting |
|6 Log Contraller (2] Log Table (2007-01-15-21-00-01 log) Page: [1/1 =]
= FileBackupSet-1 Type | Log | Time
I F_‘ | @ Start[Windows XF (solomon), OBM 5.2.1.0] [2007/01115 21:00:01] &
2] 2007-01-15-18-28-34 log| @ Start running pre-commands [2007/01/15 21:00:02)
I 200?-01-15-1?-30-10 log \’D Finlshed running pre-commands 120070115 21:00:02)
A1 2007-011517-2043108 | & garting 1o create Shadow Copy Set. 12007701415 21:00:02)
$ Shadow Copy Set created successfully [2007/01/15 21:00:05)
@  Downloading server file list [2007/01/15 21:00:06]
@  Reading backup source from hard disk.. [2007/01415 21:00:07)
Q',‘- Reading backup source from hard disk... Completed [2007/01/15 21:00:08)
@  [Local Copyl Start running local backup 1200701115 21:00:08]
@ [Local Copy] Reading local backup files from hard disk... [2007/01/15 21:00:08)
1) Downloading server file list.. Completed [2007/01/15 21:00:08)
CD [Local Copy] Reading local backup files from hard disk... Com [2007/01/15 21:00:08)
@ [Local Copy] Getting all files which have been added.. Comple... [2007/01/15 21:00:08)
Q/“ [Local Copy] Getting all files which have been updated... Comp... 120070115 21:00:08)
@ [Local Copy] Getting all files which have been deleted... Compl... [2007/01/15 21:00:08)
(L) [Local Copy] Getting all files which have been moved... Comple.. [2007/01/15 21:00:08)
@  [Local Copy] Total New Files =0 (200701115 21:00.08]
@  [Local Copy] Total Updated Files = 0 [2007/01415 21:00:09]
C? [Local Copy] Total Update File Permission= 0 [2007/01/15 21:00:09)
@ [Local Copy] Total Deleted Files =1 [2007/01/15 21:00:09)
@  [Local Copy] Total Moved Files = 0 [2007/01415 21:00:09]
Cf,‘- [Local Copy] [Deleted File] Deleting "C\LocalBackupil 168848 [2007/01/15 21:00:09) _']
ATV 0 mnnl Aasid Fimiab commins fnaal astnoe AnTIAe e A AR
4 |»| Show: Fu - | Logs per page: |500 -I

\o> Backup| &) Restore g Log

Backup Completed Successfully

|Quota (Remaining / Total): 9.86G /106 |Last Backup: 2007-01-15 21:00
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5

Setting Up Backup Sets

A backup set contains all backup settings of a backup operation. This section will describe all features available
within a backup set and explain how you can use each of them to achieve various tasks.

Each backup account can have multiple backup sets. Each backup set is an individual and independent entity. For
example, if you want one directory to be backed up during the day and another directory to be backed up during
the night, you can create two backup sets, each with a different backup schedule and backup source, to serve

this need.

To create a new backup set, simply click [Backup Set] -> [New] and choose a backup set type. For example, let’s
create a “File Backup Set” for the rest of this chapter.

Backup Set Backup Restore Tools View Help

(A Remove  »

|&) File Backup Set

|éb Systern State Backup Set

=18 %]

Change I
on Account  Change |

106G

Time Zone: |GMT‘08'DU (HKT) -

|| save Setting i Lotus Backup Set
“f Ext | MS Exchange Backup Set
T 1) Backup 5o | ' MS Exchange Mail Level Backup Set
“Backup S¢ |7 M5 SQOL Server Backup Set
o ?‘;:”m"a:;' [+ MySQL Backup Set
§ setting |@ Oracle Database Backup Set

) Encryption Account Information
W Retention Policy _
.ﬁ Extra Backup Quota:
L In-File Delta
"-“j Local Copy

Contact

[demn@'our-cnmpany‘com _d
Contact Name: Demonsiration Account
Email Address: demo@your-company.com

agd | Remove | Properties |

& Backup | &) Restore | @& Log|
Backup Completed Successfully

Quota (Remaining / Total): 9.86G 710G |Last Backup: 2007-01-

5.1 Backup Set Type

A backup set can be of one of the following types:

1521:.00

Backup Type

Description

File

Backup set type to backup common files/directories

Microsoft SQL Server

Backup set type to backup Microsoft SQL Server 7.0/2000

Oracle Database Server

Backup set type to backup Oracle 8i/9i database

Lotus Domino/Notes

Backup set type to backup Lotus Domino/Notes

Microsoft Exchange Server

Backup set type to backup Microsoft Exchange Server 2000 / 2003

MySQL

Backup set type to backup MySQL Server

System State

Backup set type to backup Microsoft Window’s System State

Microsoft Exchange Mail
(MAPI)

Backup set type to backup individual emails, contacts, calendars,
tasks etceteras from Microsoft Exchange Server 2000 / 2003

Backup set type is defined at backup set creation and cannot be modified. If you want to change the backup set
type, you have to create another backup set in the new backup set type.
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5.2 Backup Source

A “Backup Source” defines the files/directories that are to be included in a backup set. There are two types of
backup source: Selected and Deselected. Selected backup source defines files/directories that are to be included
in a backup set while deselected backup source defines files/directories that are to be excluded from a backup set.

Online Backup Manager will generate appropriate backup source setting for you automatically when you make
your backup source selection on OBM.

Please note that for Windows operating systems, if the “Hide protected operating files (Recommended)” setting is
enabled for the file explorer, system folders/files will not be shown in the backup source. By selecting the parent
folders however, all subfolders (including system folders/files) will be included in the backup set. Thus if you want
to exclude system folders (e.g. recycle bin) from the backup, please select the desired folders/files directly rather

than selecting the parent folder. Alternatively, you can enter the corresponding system path to the [Exclude List]
of the backup set using the web interface.

From the [Standard] node available at the top of the [Backup Source] tree, you can easily select the following
common folders to be backed up:

1. “My Documents” folder

2. “Outlook” and “Outlook Express” mail store folder
3. “Favorites” folder

4. “Desktop” folder

From the [Options] node available below the [Standard] node, you can easily select other common folders to be
backed up as well. They include the “Application Data” folder, the “Start Menu” folder, the “Templates” folder, the
“All Users’ Documents” folder, the “Temporary Internet Files” folder, the “Cookies” folder, the “Font” folder, the

“History” folder, the “Applications Data” folder, the “Nethood” folder, the “Printhood” folder, the “Recent” folder
and the “Send to” folder.

2 Onfine Backup Manager

=10] ]
Backup Set Backup Restore Tools View Help
151 5ave Setting | P> “1rtEaciun [ Stop Backup
\o> Backup Controller | # |1 Backup Source (FileBackupSet-1) (2]
2 User Profile = %3 Standard
= ﬂ“ FileBackupSet-1 -4 L) My Documents (C\Documents and Settingsyohn smithiMy Documents)
",'_'_,‘-;Barkup Source @[ G Outlook Express
{ Backup Schedule [ ¢ Favorites
Backup Filter +-[4(3 Desktop
{5 command Line T | -1 & Options
{§ Setting =~ i My Computer
e Encryplion -1 M4 34 Floppy (A)
i Retention Policy #-[0 % Local Disk (C)
&5 Extra Backup +-[] e Local Disk (D!
"4 In-File Delta jcal Disk (E)

) Local Copy 4[] % Local Disk (F)

#-[] & DVD-RW Drive (G)

-] & My Sharing Folders

& Wy Network Places

= (@ Entire Network
+- (9 Microsoft Terminal Services
#- (% Microsoft Windows MNetwork
+- ) web Client Network

Log Table (FileBackupSet-1) s
Type | Log

Time

T [
& Backup [© Restore] @ Log]

'Waiting for other Backup Job finish

|Quota (Remaining / Total): 10G /10G |Last Backup: -
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The checkbox next to the files/directories shown above can be in one of the following mode:

Mode | Description

[+ | All files/directories (recursively) under this directory will be backed up

backed up as well.

[¥ | All files/directories (recursively), except those explicitly excluded, under this directory will
be backed up. If you add files/directories to this directory in the future, they will be

[T | Only the checked files/directories under this directory will be backed up. If you add
files/directories to this directory in the future, they will NOT be backed up.

[T | Nothing under this directory will be backed up.

5.3 Mapped Network Drive

If you need to backup a mapped network drive on Windows (it will only work in Windows NT/2000/XP/2003), you
must enter your Window’s domain, username and password into the [Network Resources Authentication for
Windows] section as shown below. It is required because scheduled backups will always run under the context of
Window’s “Local System” account (which does not have the privileges required to access network resources) by
default. OBM needs to collect your Windows username, password and domain name to authenticate itself to the
windows domain controller to acquire the required access privileges to the network files to be backed up. If you
don’t supply a username and password, OBM will have problems accessing network resources in its scheduled

backup Jobs.

If you need to backup network mapped drive in scheduled backup, please do this:

Backup Set Backup Restore Tools View Help
- save Setting | P Start Backup [l <10

Select the backup set from the left panel and press the [Properties] button

=10l x|

\.': Backup Controller (Ll |2 Backup Set - FileBackupSet-1
W UserProfle Backup Set
=HEFI kupSet-1; .

‘.'.'_J Backup Source Name: FileBackupSet-1

]

) Backup Schedule D 1168848359906

Backup Filter
=] Command Line Tool
] setting
L Encrypltion
fiy Retention Policy
=] Extra Backup
{4 In-File Delta
e Local Copy

Type:  File Backup

Metwork Resources Authentication for Windows
Domain:

User Name:

Password:

Properties |

¥ Run scheduled backup on this computer

E] Log Table {FileBackupSet-1)

Type | Log

Time

&> Backup | &) Restore| & Log|
Backup Completed Successfully

Quota (Remaining / Total): 10G /110G |Last Backup: 2007-01-1517:20

Enter your Windows domain, username and password into the dialog shown below and press [OK]
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FileBackupSet-1 Properties ﬂ

MName: [FileBackupSet—‘l
Type: File Backup
Network R Anih tion for Wind

Domain: |w|nd ows-domain

User Name: |dem0-user

Password: Im

ot | _oma

iii. Press the [Save Setting] button on the toolbar

The steps above apply only to computers running in a Windows domain. If you don’t have a windows domain with
your network and you are using a workgroup or using a NetWare server, please use the “net use” command to

authenticate the running backup process against the computer hosting the mapped drive. Otherwise, you will get
“Access Denied” error from the backup report.

For example, if you want to backup \\SERVER\SHARE that is located on a NetWare server (or another computer

in a windows workgroup) and you are getting "Network drive is not accessible" error message, please try adding
the following command as a [Pre-backup command]

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]J\[USERNAME]
E.g.

Add new Pre-backup Command Line Tool x|

MName: |Pre-backup Command-1

Command: [n et use Netware\Data oassword JUSER peter

‘Working Directory: [ Browse
oK | Cancel

Enter one of the following commands directly into the Pre-Backup Command:

net use \\Netware\Data password /USER:peter
net use \\WorkgroupComputerl\Data password /USER:WorkgroupComputerl\peter

This will authenticate the current process with the NetWare server (or another computer in a windows workgroup)
and backup will then run correctly.

Leb Shama Company Limited Page 21 of 122 (February 12, 2008)



Bay
AHJ{LU Offsite Backup Server v5.2

committed to the success of your business User’'s Guide

5.4 Backup Schedule

A “Backup Schedule” defines the frequency and the time that backups should run automatically.

._7 Online Backup Manager =18 x|
Backup Set Backup Restore Tools View Help

| save Setting P> Start Backup [l
\.'5 Backup Controller LAEl Backup Schedule (FileBackupSet-1)

= User Profile
=@ FileBackupSet-1

edule-1 (Type: Daily)

BackupSchedule- 1 Properties x|

. Name: |BackupSchedule-1
Backup Filter I

1 Command Line Too Backup
{4 setiing Files
L& Encryption
T

iy Retention Paolicy e
5 Extra Backup  Daily oy custom
;

& In-File Delta
e Local Copy Day

Backup on the following day{s) every week:
™ Sunday ™ Monday I~ Tuesday [ Wednesday

I™ Thursday [ Friday ¥ Saturday
d Remove Properties
aa 4| | |
Start Time (hhomm): |21 'I: 0o 'I
Stop ] Time |
' Stop on completion (Full Backup)
o ’ I
0K Cancel I
& Backup | &) Restore| @ Log |
Backup completed with waming(s) Quota (Remaining / Total): 9.86G /106G |Last Backup: 2007-01-15 21:00

Backup schedule can be in one of the following types:

Type Description
Daily Backup Jobs will run everyday
Weekly | Backup Jobs will run on the specified day(s) of every week

Monthly| Backup Jobs will run on the specified day or on a day with a given criteria (e.g. first
weekend, last weekday) of every month

Custom | Backup job will run once on any particular date

For each schedule type above, backup will run at the scheduled time for a maximum of the duration specified (or
until all data are backed up if [Stop on backup completion] option is chosen). If a backup job does not finish
within the maximum duration specified, it will be interrupted.

Please note that you can have more than one schedule within a backup set. For example, you can have a daily
backup schedule that runs at 13:00 at noon and another daily backup schedule that runs at 00:00 at midnight.
The combination of these schedules effectively creates a backup schedule that runs daily at 00:00 and 13:00
everyday.

5.5 Backup Filter

A “Backup Filter” defines the file selection rules that allow user to easily include/exclude files into/from the
backup set by applying user defined criteria(s) to the file names or directory names.

There are some basic rules regarding backup filters:

i. Filters are checked in creation order. Once inclusion/exclusion has been identified, the remaining
filters won't be checked.

ii. Inclusion/Exclusion made by filter always takes precedence over backup source selections

iii.  If all filters do not apply to a particular file, this file is then checked for inclusion/exclusion backup
source selections
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.7 Online Backup Manager =18 x|
Backup Set Backup Restore Tools View Help
H Save Sefting ’ Start Backup . tof:
\.1 Backup Controller Lol Backup Filter (FileBackupSet-1)
= UserProe X
=+ FileBackupSet-1
i Backup Source Name: [Fitter-1
{5 Backup Schedule Top Direciory: |
Backup Filter :
=] Command Line Tool Browse |
(] setting
e Encryption Apply To
iy Retention Policy ¥ File ™ Directory
*-I Extra Backup
£ In-File Delta Pattern Matching
4 Local Copy Type: (= Text " Regular Expression
" starts with + contains ™ ends with
Pattern: Add
I Time
Firter Mode
& Include matched " Exclude matched
™ exclude all others
I Cancel I
& Backup | &) Restore| (@1 Log|
Backup completed with warning(s) Quota (Remaining / Total): 9.86G /106G [Last Backup: 2007-01-15 21:00

Key

Description

Name

The name of a filter

Top Directory

The top directory to which this filter is applied. Filtering rules will be applied to
all files and/or directories under this directory.

Apply To

Define whether to apply the filtering rule to files and/or directories

Pattern Matching

It defines the filtering rules of a filter. A filtering rule can be of one of the
following types:

[Starts With] Include/Exclude all files/directories with name starting
with a certain pattern.
For example: You can use B* to match all files with
name starting with a ‘B’ character

[Contains] Include/Exclude all files/directories with name
containing a certain pattern.
For example: You can use *B* to match all files with
name containing with a ‘B’ character

[Ends With] Include/Exclude all files/directories with name ending
with a certain pattern.
For example: You can use *.doc to match all files with
name ending with ‘.doc’ (all Word documents)

[Regular Expression] Include/Exclude all files/directories with name matching
a regular expression.

Filter Mode Defines whether you want to include or exclude matched files into/from the
backup set. Also, for those unmatched files, you can choose to exclude (if
include filter type) or include (if exclude filter type) them into/from the
backup set.

Example 1:

If you want to backup only Word, Excel and PowerPoint documents in your document directory (e.g. C:\My
Documents), you should setup your backup filter as follows.

Top Directory
Apply To
Matching Type
Matching Patterns
Filter Mode
Exclude all others

= C:\My Documents
= File (true)

= End With

= *.doc, *.xls, *.ppt
= Include

= True
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Example 2:
If you want to backup all files, excluding all *.exe, *.dll and *.tmp, in C:\Applications, you should setup your

backup filter as follows.

Top Directory = C:\Applications
Apply To = File (true)
Matching Type End With
Matching Patterns *.exe,*.dll, *.tmp

Filter Mode = Exclude
Include all others = True
Example 3:

If you have made your selection of files (all under C:\) from the backup source setting but you want exclude all
images (e.g. *.jpg and *.gif) from your selection, you should setup your backup filter as follows.

Top Directory =C:\

Apply To = File (true)
Matching Type = End With
Matching Patterns = *.jpg, *.gif
Filter Mode = Exclude
Include all others = false

Please note that the [Include all others] setting is not enabled because you don’t want to include all other files
(NOT *.jpg, *.gif) under C:\ into the backup set.

Example 4: (advanced)

If you want to include everything, except the “log” directory, under C:\Applications into a backup set, you should
setup your backup filter as follows.

Top Directory = C:\Applications
Apply To = Directory (true)
Matching Type = Regular Expression
Matching Patterns = "log$

Filter Mode = Exclude

Include all others = True

Example 5: (advanced)

If you want to include all directories named “log” from the backup set files with file name starting with “B” and
ending with “*.doc” under C:\My Documents into the backup set, you can use a regular expression of
“~B.*\.doc$” to do your selection. The filter backup can then be setup as follows.

Top Directory = C:\My Documents
Apply To = File (true)
Matching Type = Regular Expression
Matching Patterns = ~B.*\.doc$

Filter Mode = Include

Exclude all others = True

5.6 Pre/Post-Backup Command

The “Command Line Tool” feature has two major components, the [Pre-Backup] command and the [Post-Backup]
command. You can use the [Pre-Backup] or [Post-Backup] commands to run any native OS (operating system)
commands before or after running a backup job.
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._7 Online Backup Manager

Backup Set Backup Restore Tools View Help
| save getting P> Start Backup [l “10r

\e» Backup Controller

el =] Command Line Tool (FileBackupSet-1)

=181 x|

= User Profile

=@ FileBackupSet-1
il Backup Source
2 Backup Schedule

Backup Fitter

E]icommand Line Tool
4 Setting
L& Encryption
iy Retention Palicy
& extra Backup
(4 In-File Detta
e Local Copy

Pre-backup

|N0 existing Command Line Tool
Command:
‘Warking Directory:

i | | Froperies |

Name:

|Pre backup (‘0mmanu-1|

Command: |

Browse
Cancel
T

Working Directory: [

| I ]

[ Log Table (FileBackupSet-1)

Type I Log

Time

& Backup | &) Restore| @ Log|

Backup completed with warning(s)

Quota (Remaining / Total): 9.86G / 106G |Last Backup: 2007-01-15 21:00

Both [Pre-Backup] and [Post-Backup] commands comprise of the following parameters:

Key Description
Name Name of this Command
Command The command to be run

(e.g. C:\My Documents\Application.exe or C:\My Documents\BatchJob.bat)

Working Directory

The directory at which this command will run

The backup set type affects the time at which [Pre-Backup] and [Post-Backup] commands run. The following
table outlines when [Pre-Backup] and [Post-Backup] commands will run in different types of backup set.

Backup Set Type

When Pre-Backup Commands run?

When Post-Commands run?

File

Before uploading backup files

After uploading all backup files

(e.g. Microsoft SQL
Server)

Non-File Backup Sets

Before spooling backup files to
temporary directory

After spooling backup files to
temporary directory (i.e. before
the first backup file is uploaded)

Note: You should never backup an application while it is running as this can result in inconsistent and unusable
files getting backed up. Please use the “Volume Shadow Copy” feature if you're running Windows XP/2003 or
make use of the Pre-Backup Command feature to shutdown your application before running a backup job and use
the Post-Backup Command feature to restart your application after the backup job has completed.

For Example

You want to stop Microsoft Outlook using the Pre-Backup Command and restart it after backup using the Post-
Backup Command, create the two following text files and assigned the files to Pre-Backup and Post-Backup

Command.

1. Create a text file named “OutlookClose.vbs” using notepad with the following two lines:

Set obj OLK = createObject ("Qutl ook. Application")

obj OLK. qui t

2. Create a text file named “OutlookStart.bat” using notepad with the following line:

"C:\Program Fil es\M crosoft O fice\ OFFI CE11\ QUTLOCK. EXE"
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5.7 Temporary directory

If you are running a file backup job with in-file delta enabled or a database type backup job, OBM will generate
temporary files and the directory that will be used to store all these files are defined by [Setting] -> [Temporary
directory for storing backup files]. Please set this to a non-system disk partition that has enough free space to
avoid problems.

You can set the [Temporary directory for storing backup files] to a mapped network drive. If you choose to do
this, please use a UNC path (e.g. \SERVER\SHARE) and don’t forget to configure the [Backup Set] -> [Network
Resources Authentication for Windows] setting.

To conserve the use of disk space, you can set the [Remove temporary files after backup] option to delete the
temporary files automatically after a backup job has finished.

5.8 Transfer Block Size

Transfer block size defines the block size OBM will use to transfer your backup blocks. Generally, backup jobs
using a larger block size will have better performance, because of the smaller number of connections involved.

However, some firewalls or proxy servers may block out-going network traffic (HTTP/HTTPS POST method) with
large block size for security reasons. If you are in a network with this type of restriction, please lower the transfer
size value and try again.

To change the transfer block size of any backup set, please select the [Setting] node on the left panel to invoke
the [Setting] panel on the right. You can then make changes to the [Transfer Block Size]. After you have made
your changes, just press the [Save Setting] button on the toolbar.

181

Backup Set Backup Restore Tools View Help
5] save Setting P> Start Backup [l °f

.n.'? Backup Controller (& || ] setting (FileBackupSet-1)

= User Profile
=H@ FileBackupSet-1

Temporary directory for storing backup files

{9 Backup Source |C'1Documents and Settings\iohn.smithLobmiipciBackupSet ﬂ]
] Backup Schedule
Backup Filter Transfer Block Size
r_‘_“]aandLmeTnol I_jIEBk <] Bytes
.:-1 ng
. Encryption : _

W Retention Policy
‘_iEsmaBackup
(% In-File Delta o &
e Local Copy
Volume Shadow Copy (Windows 2003 & XP)
Enable Volume Shadow Copy

 Yes & No

] Log Table (FileBackupSet-1)

Type | Log Time
& Backup Ig'\ Restore | @ Log |
Backup Completed Successfully Quota (Remaining / Total): 9.86G /110G |Last Backup: 2007-01-15 21:00

5.9 Follow Symbolic Link (Linux/Unix/Mac only)

Under Unix/Linux/Mac, users can create a symbolic link to link a file/directory from another directory. This setting
defines whether you want OBM to traverse any symbolic links encountered on your backup path.

To change the follow symbolic link of any backup set, please select the [Setting] node on the left panel to invoke
the [Setting] panel on the right. You can then make changes to the [Follow Symbolic Link]. After you have made
your changes, just press the [Save Setting] button on the toolbar.
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5.10 Microsoft’s Volume Shadow Copy Service (VSS)

Microsoft Volume Shadow Copy Service (VSS) allows you to backup files that are exclusively opened. Without
VSS, you will get the error message “The process cannot access the file because another process has locked a
portion of the file” if you are trying to backup a file that is exclusively opened (e.g. Outlook PST file).

Please note that VSS is only available on Windows XP / 2003 and you must have administrative privileges to start
the VSS service on a computer. Also VSS will only work if at least one of your partitions is formatted using NTFS.

If you are running Windows 2003, please install the Windows 2003 VSS hot fix available in
http://support.microsoft.com/default.aspx?scid=kb;en-us;887827 before running VSS.

If you are running into problems with VSS running on Windows XP / 2003, Microsoft's recommendation is to try

re-registering the Volume Shadow Copy Service again. Simply run the script [OBM Home]\bin\RegisterVSS.bat to
do so.

For more information, please take a look at the following page for a technical introduction to Volume Shadow
Copy Services (VSS):

http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42¢c3-b6c9-59¢145b7765f1033.mspx

5.11 Encryption

Before your files are sent to the Offsite Backup Server, all your files are compressed and encrypted using your

choice of encryption algorithm, mode and key. The following table explains all encryption parameters available
within a backup set.

Note:

Encryption settings are set at backup set creation time and cannot be modified. You need to create a new backup
set if you want to change your encryption settings for a backup set.

RI=TEY
Backup Set Backup Restore Tools View Help

| save Setting | P> StartBackup [l 5t

ke Backup Controlier [ & | 4 Encryption (FileBackupSet-1)
= ser Profile "
=H@ FileBackupSet-1 ST
i Backup Source Algorithm: AES
{) Backup Schedule Mode: ECE
1 Backup Filter Encrypting Key: I.—.—
] Command Line Tool
] Setting ¥ Mask Encrypting Key
Y
14 Retention Policy
] Extra Backup
{4 In-File Delta
ﬁ Local Copy

[ Log Table FileBackupSet1)

Type I Log Time
& Backup [ € Restore | [ Log
Backup Completed Successfully Quota (Remaining f Total): 10G /106G |Last Backup: 2007-01-1517:20
Parameter Description

Encryption Algorithm |It defines the encrypting algorithm used to encrypt your backup files. There are
three encryption algorithms available:

[AES] Advanced Encryption Standard algorithm
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[DESede] Triple DES algorithm
[Twofish] Twofish algorithm

We recommend the use of AES as it has been chosen as the encryption standard
for commercial use. Please refer to references on Cryptography for more
information about encryption algorithms.

Encryption Mode It defines the encrypting mode used to encrypt your backup files. There are two
encryption modes available:

[ECB] Electronic Cook Book Mode
[CBC] Cipher Block Chaining Mode

We recommend the use of CBC mode as it offers better security. Please refer to
references on Cryptography for more information about encryption modes.

Encrypting Key The key used to encrypt all files within a backup set. Please write it down on

paper and keep it in a safe place. If the key is lost, you will not be able to
recover your files from the encrypted backup files.

5.12 Retention Policy

During backup, if OBM finds that you have deleted a file (or updated a file) on your computer, it will put the
corresponding deleted (or updated) file already backed up on the backup server into a retention area. The

retention policy setting defines how long files inside the retention area will be kept on the backup server before
they are deleted automatically from the server.

Retention policy will only affect “retained” file (i.e. files that have already been deleted or updated on your
computer and thus are moved to the retention area of the backup server). For those files that have not been
updated on your computer, the backup of these files is kept in the data area on the backup server and won't be
affected by the setting of retention policy. These backup files of unchanged files will stay on the backup server
forever until the original files are removed (or updated) from your computer.

Standard Retention Policy

The [Standard] retention policy allows you to delete retained files automatically after a user defined number of
days or after a user defined number of backup Jobs. To change the retention policy setting of any backup set,
please select the [Retention Policy] node on the left panel. You can then make changes to your retention policy

under the [Retention Policy] section. After you have made your changes, just press the [Save Setting] button on
the toolbar.

18/

Backup Set Backup Restore Tools View Help
I save Setting | P> Start Backup [l

\e» Backup Controlier A | £ Retention Policy (FileBackupSet-1)
= ser Profile @ I_—j
=i FileBackupSet-1 Keep deleted file(s) for |7 +] [oays =]
, Backup Source " Agvanced
) Backup Schedule
Backup Filter F R
{£] Command Line Tool
ﬂ Sefting
ali Encryption
14 Retention Policy
& Extra Backup
{4 In-File Delta
= Local Copy
[E Log Table (FileBackupSet-1)
Type I Log I Time I
& Backup | &) Restore | (& Log
Backup Completed Successiully Quota (Remaining / Total): 10G 710G |Last Backup: 2007-01-1517:20
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Advanced Retention Policy

.. Online Backup Manager

Backup Set Backup Restore Tools View Help

| Save Setiing P> Start Backup [l

& Backup Controller

| # | Retention Policy (FileBackupSet1)

=10l |

= User Profile
=HE FileBackupSet-1
{5 Backup Source
5] Backup Schedule
Backup Filter
{1 Command Line Tool
{4 Setting
& Encryption
fiir Retention Policy

{4 In-File Delta
£ Local Copy

" Keep deleted file(s) for | -” s~

" Advanced

Retention Policy-1 (Type: Daily)
Retention Policy-2 (Type: Weekly)
Retention Policy-3 (Type: Monthhy)

Retention Policy-5 (Type: Yearly)

Log Table (FileBackupSet-1)

Retention Policy-4 (Type: Quarterty)

Add | Remaove | Properties |

Type ]

Log

Time ]

O Backup [ Restore T Log

Backup Completed Successfully

Quota (Remaining / Total): 10G 710G |Last Backup: 2007-01-1517:20

The [Advanced] retention policy allows you to configure a more flexible retention policy. It allows you to keep a
set of snapshots of all backup files based on the time of the backup Jobs. For example, you can configure the
advanced retention policy to keep the following sets of backup files to mimic the retention policy of the old days
when you were still doing tape rotations:

€ All files available within the last 7 days

* & o o

All files available on the last 4 Saturdays within the last 28 days
All files available on the 1%t day of each month within the last 3 months
All files available on the 1% day of each quarter within the last 12 months

All files available on the 1% day of each year within the last 7 years

To do so, you need to setup your advanced retention policy as follows:

¢ Type = Daily; Number of copy to keep = 7

* & o o

Type = Weekly; Frequency = Saturday; Number of copy to keep = 4

Type = Monthly; Frequency = Day 1; Number of copy to keep = 3

Type = Yearly; Frequency = Date 01-01; Number of copy to keep = 7

Type = Quarterly; Frequency = Day 1 of Jan, Apr, Jul, Oct; Number of copy to keep = 4

Assuming today is 17-Jan-2006, if [Remove retention files for overlap policy] is NOT enabled, a total of 22
snapshots (provided you have run backups daily for more than 7 years) will be kept on the server accordingly,

ie.:

Daily Weekly Monthly Quarterly Yearly
16-Jan-2006 14-Jan-2006 01-Jan-2006 01-Jan-2006 01-Jan-2006
15-Jan-2006 07-Jan-2006 01-Dec-2005 01-Oct-2005 01-Jan-2005
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14-Jan-2006 31-Dec-2005 01-Nov-2005 01-Jul-2005 01-Jan-2004
13-Jan-2006 24-Dec-2005 01-Apr-2005 01-Jan-2003
12-Jan-2006 01-Jan-2002
11-Jan-2006 01-Jan-2001
10-Jan-2006 01-Jan-2000

If [Remove retention files for overlap policy] is enabled, only the following snapshots are kept:

Daily Weekly Monthly Quarterly Yearly

16-Jan-2006 14-Jan-2006 B61-Jan-2006 B61-Jan-2006 01-Jan-2006
15-Jan-2006 07-Jan-2006 01-bee-2665 B81-0et-2065 01-Jan-2005
14-Jan-2006 31-Bee-2065 B61-Nev-20065 0643ul-2005 01-Jan-2004
13-Jan-2006 24-Dee-2005 B1-Apr-2065 01-Jan-2003
12-Jan-2006 01-Jan-2002
11 -Jan-2006 01-Jan-2001
10-Jan-2006 01-Jan-2000

The weekly policy overrides the daily policy so the snapshots of 10-Jan-2006, 11-Jan-2006, 12-Jan-2006, 13-
Jan-2006 and 14-Jan-2006 are removed. The monthly policy overrides the weekly policy so the snapshots of 24-
Dec-2005 and 31-Dec-2005 are removed. The same applies to the monthly, quarterly and yearly policy giving a
total of 11 snapshots.

5.13 Extra Backup (Off-line backup, Logout Reminder)

Off-line backup is basically designed for notebook users who are off-line most of the time and cannot rely on the
backup schedule to backup regularly. The "Backup Interval" allows notebook users to specify the interval that
they would like their data to backup. When the machine is online and this interval has elapsed, backup will run
automatically. If “Backup Alert” is enabled, a popup message box will ask the user to confirm starting the backup.

The "Email Notification" setting is the number of days since the last backup that triggers the backup server to
send email notification to the client to remind him to run an off-line backup.

When the “Logout Reminder” setting is enabled, a popup message box will ask the user to start a backup before
logging out / shutting down Windows.
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Backup Set Backup Restore Tools View Help

|7 save Setting | P> Start Backup Wl =10p S0k

&> Backup Controller [# | =] Exra Backup (FileBackupSet-1)

=2 User Profile
=+ FileBackupSet-1

) Backup Source

) Backup Schedule

41 Backup Filter

£] Command Line Tool

f ]Sang

&) Encryption

i Retention Policy

0

La £ ]
e Local Copy

Off-line Backup
¥ Enable off-line backup
Backup Interval
[ =] oawa [0 =] Hourts)
Email Nofification
[~ =] pay(s) twhen no backup done)

Backup Alert
¥ Enable backup alert

System Logout Backup Reminder (Windows)
[~ Enable System Logout Backup Reminder

Backup
Files

[ Log Table (FileBackupSet-1)

£y

Type ] Log

Time

& Backup [ ©) Restore] @ Log]|

Backup Completed Successfully

|Quota (Remaining § Total: 10G /106 |Last Backup: 2007-01-1517:20

5.14 In-File Delta

Please refer to the in-file delta section for more information on this topic.

5.15 Local Copy

If you want to save an extra copy of backup data on your local hard disk (in addition to a copy of backup data
stored on the backup server) to minimize file-restoring time and/or to provide an extra safety precaution, you

can do the following:

i Open OBM from the System Tray (see previous sections for details)

ii. Setup your backup set (see previous sections for details)

iii.  Select [Local Copy] under your backup set from the left panel
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-7 Online Backup Manager _'_l_n]!]
Backup Set Backup Restore Tools View Help
|| save Setting | P> Start Backup [l Siop Baciun
o Backup Controller (A | = Local Copy (FileBackupSet-1)
-2 User Profile
@ FileBackupSet 1 e
[ Backup Source Copyto
I r§’ Backup Schedule |cLocalBackup\1 1688483599061
£ Backup Filter
=] Command Line Tool Change |
] setting I
&) Encryption ~Zip
\—faf Retention Policy Zip copied file(s)?
—aEma Backup r:p Ya: s (N:)
{4 In-File Delta
~File Permissi
Retain permissions on files that are copied?
C Yes & No
~Offsite Backup
Skip backup to offsite backup server?
 Yes (* No
Log Table (FileBackupSet-1) o
Type | Log | Time |
& Backup [ @ Restore | @ Log]
IWell:orne to Online Backup Manager IQuoia (Remaining / Total): 9.86G /106G |Las1 Backup: 2007-01-15 21:00

iv.

Check the [Copy to Local Hard Disk] checkbox

V. Enter a directory to where you want an extra copy of your backup files to be stored in the [Copy to]
field provided (preferably a directory under another hard disk)

Vi.

conserve free Space usage

(Optional) Select the [Yes] radio button if you want to store your backup files in compressed form to

vii. An extra copy of backup will be saved in the [Copy to] directory when you run your backup job
=181 x]
Backup Set Backup Restore Tools View Help
| save Setting P> Start Backup [l 5100 Backup
&> Backup Controller (# || Backup Set- FileBackupSet-1
2 User Profile Backup Set f]
&8 Backup Source [ Name: FileBackupSet-1 =l
1= Backup Schedule Log Table (FileBackupSet-1) “
4 Backup Filter
. Type Lo Time
= | Command Line Tool L I — - g I r
L seting @ Finished running pre-commands [2007/01/16 11:37:48] =]
- (& Encryption CD Reading backup source from hard disk... [2007/01/16 11:37:48]
_ﬁ' Retention Policy (D Reading backup source from hard disk... Completed [2007/01/16 11:37:49]
{5 Extra Backup @ [Local Copy) Start running local backup [2007/01/16 11:37:49]
{_}\__ In-File Delta CD [Local Copy] Reading local backup files from hard disk. [2007/01/16 11:37:49]
4 Local Copy @  [Local Copy] Reading local backup files from hard disk... Compl [2007/0116 11:37:49]
@  [Local Copy] Getting all files which have been added... Completed [2007/01/16 11:37:49)
@ [Local Copy] Getting all files which have been updated... Compl.. [2007/01/16 11:37:49)
C,D [Local Copy] Getting all files which have been deleted... Comple... [2007/01/16 11:37:49]
(D [Local Copy] Getting all files which have been moved... Complet... [2007/01/16 11:37:49]
@ [Local Copy] Total New Files = 0 [2007/0116 11:37:49]
CD [Local Copy] Total Updated Files=0 [2007/01/16 11:37:49]
@  [Local Copy] Total Update File Permission = 0 [2007/01/16 11:37:49]
@  [Local Copy] Total Deleted Files = 1 [2007/01/16 11:37:49]
@ [Local Copy] Total Moved Files = 0 [2007/01/16 11:37:49)
C,D [Local Copy] [Deleted File] Deleting "CALocalBackup\l 1688483, [2007/01/16 11:37:49]
(D [Local Copy] Finish running local backup [2007/01/16 11:37:49]
(D Start running post-commands [2007/01/16 11:37:50]
CD Finished running postcommands [2007/01/16 11:37:50]
@  Backup Completed Successfully [2007/01/16 11:37:51] =]
& Backup [ &) Restore] 1@ Log|
Backup Completed Successfully |Quota (Remaining / Total): 8.86G /106 [Last Backup: 2007-01-15 21:00

If you want to make local copy to a directory located on a NetWare server (or another computer is a windows
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workgroup) and you are getting "Network drive is not accessible" error message, please try adding the following
command as a [Pre-backup command]

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]J\[USERNAME]
E.g.

C:\> net use \\Netware\Data password /USER:peter
C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputerl\peter

This will authenticate the current process with the NetWare server (or another computer is a windows workgroup).
Backup will then be allowed to run correctly.

How to restore “Local Copy” files

“Local Copy” files are stored in the [Copy to] directory (under [Local Copy] setting). To restore backup files,
please do the followings:

i. Choose [Tools] -> [Unzip Local Copy]

181
Backup Set Backup Restore | Tools View Help

- save seting B> start gcku [ IETIRIR I

4 Decrypt Files Wizard

o> Backup C bset-1
B e [ackup Set B
' 1? ?;;Bzikﬂzusedur:ce Name: FileBackupSet-1 =l
© Backup Schedule Log Table (FileBackupSet-1) A
I ackup Filter
=] Command Line Tool Tyne I — - Loy I LLL) I
(] setting D F|n|sl'?ed running pre-commands . [2007/01716 11:37:48) =]
I Encryption \’D Reading backup source from hard disk.. [2007/01/116 11:37:48]
{—fiy Retention Policy @ Reading backup source from hard disk . Completed [2007/01/16 11:37:49]
|—{=] Extra Backup @ [Local Copy] Start running local backup [2007/0116 11:37:49]
L& In-File Delta @ [Local Copy] Reading local backup files from hard disk.. [2007/01116 11:37:49]
L Local Copy @  [Local Copy] Reading local backup files from hard disk... Compl [2007/01/16 11:37:49)
(D [Local Copy] Getting all files which have been added... Completed [2007/01116 11:37:49]
\’D [Local Copy] Getting all files which have been updated... Compl... [2007/0116 11:37:49]
iD [Local Copy] Getting all files which have been deleted... Comple... [2007/0116 11:37:49]
CD [Local Copy] Gefting all files which have been moved... Complet.. [2007/01116 11:37:49]
@  [Local Copy] Total New Files = 0 [2007/01/16 11:37:49)
@  [Local Copy] Total Updated Files = 0 [2007/01/16 11:37:49]
\’D [Local Copy] Total Update File Permission=0 [2007/0116 11:37:49]
iD [Local Copy] Total Deleted Files =1 [2007/0116 11:37:49]
CD [Local Copy] Total Moved Files=0 [2007/0116 11:37:49]
fD [Local Copy] [Deleted File] Deleting “CiLocalBackupl1 1688483 [2007/01/16 11:37:49]
(D [Local Copy] Finish running local backup [2007/01/16 11:37:49]
\’D Start running post-commands [2007/0116 11:37:50]
iD Finished running post-commands [2007/0116 11:37:50]
@ Backup Completed Successfully [2007/0116 11:37:51] z
& Backup | &) Restore | g Log|
Backup C S sfull |Quota (Remaining / Total): 9.86G /106G |Last Backup: 2007-01-15 21:00

ii.  Select the required [Backup Set] from the drop down list
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Backup Set: IFileBackupSet—l
~Source Directory

|C:\LocaJBackup

rDestination Directory

ID:\Restnre

[2005-06-258 22:25:22] Start

[2005-06-28 22:25:22] Copying CALocalBackuphC_VZONFIGSYE zip' to DiRestoretC_VCONFIG YR
[2005-06-28 22:25:33] Copying C:\LocalBackopdC_‘drvnet img zip' to TRestoreC_WMrvnet.img'
[2005-06-28 22:25:22] Completed Successfully

Start | Biop

Fill in the [Source Directory] (directory where “Local Copy” files are stored) and [Destination

Directory] (directory to where you want “Local Copy” files to be restored)

iv. Click [Start]

5.16 Using One Backup Account for Multiple Computers

OBM allows you to backup multiple computers using a single backup account. To backup multiple computers, you
need to create a different backup set to backup each individual computer and to configure the [Run scheduled

backup on this computer] checkbox.

.. Online Backup Manager

Backup Set Backup Restore Tools View Help
|5l Save Setting | P> Start Backup [l 510p Backur

=181 x|

\e» Backup Controller
= User Profile

(% || Backup Set- FileBackupSet1

U[J Backup Source

{© Backup Schedule

' Backup Filter

=] Command Line Tool
{*§ Setting

a) Encryption

fif Retention Palicy
’=1Ertra Backup
£ In-File Delta
"ﬁ Local Copy

& Backup | &) Restore | g Log |

Backup Set

Mame: FileBackupSet-1
ID: 1168848353906
Type: File Backup
Network Resources Authentication for Windows
Domain:
User Name:
Password:

Properies |

¥ Run scheduled backup on this computer

Log Table (FileBackupSet-1)

7]

Type | Log Time

Backup Completed Successfully

For version 5.2

|Quota (Remaining f Total): 9.86G f10G |Last Backup: 2007-01-15 21.00

Since the computer that created the backup set will have its computer name associated with the backup set. The
backup scheduler running on each computer will only run backup sets with the same computer name as itself.
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Thus, you just need to make sure that all your computer names using a single backup account are unique.

For version 5.1 or Earlier

You must configure OBM on each computer that it only runs scheduled backup for the intended backup sets only.
If this is not setup properly, scheduled backup job of the same backup set from different computers will both be
started. This will result in lots of checksum errors and files being deleted on the backup server.

To allow multiple computers to be backed up under a single backup account, you are required to do the following
for each computer that has installed OBM under the same backup account:

i. Logon to one of the computers that has OBM installed under the same backup account.
ii. Open OBM and select a backup set that is not intended to run on this computer from the left panel.

iii. Make sure that the [Run scheduled backup on this computer] checkbox on the right panel is not
checked.

iv. Repeat the previous step for the rest of the backup sets that are not intended to run on this
computer.

V. Repeat steps ii to iv for each computer that has OBM installed under the same backup account.

IMPORTANT If you create a new backup set or want to backup another computer using the same backup
account at a later date (this implies that you need to create an additional backup set under this backup account
for the new computer), please make sure to repeat the procedure above (i.e. uncheck the [Run scheduled backup
on this computer] checkbox for the added backup set) for each computer.
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6

Backing Up Files

This chapter describes how files are backed up by OBM to the backup server

6.1 How files are backed up

The diagram below describes how OBM backup your files.

Backup Operations:

1. Collect all files which are new or have
been updated since last backup

2. Each of these files is zipped,
encrypted and securely backed up
to Online Backup Server through
Secure Socket Layer (SSL)

User’'s Computer Backup Server

- Authentication B
User Directory parmeters & Backup Directory
Zipped & encrypted fies Zipped & ;
- Miw Raw Encrypted @aresentinSSL  Encrypted A M:my
— File File File —{1
—= <0 lec ] =
k 3 =] :
), | Data Y= | P ]
[ 3 John [ John
L —__1

All users files are encrypted by &

worlc s first class 128-bit encryptior
algorithm with a user defined encrypting
key File content is meaningless to
everyone except the user

Online Backup Manager can be configured

to start automatically every night All user

files createc/updated during the day wil

then be backed up to the backup server on the
same night without any user intervention

Run backup at scheduled time automatically

Once you set your backup scheduled, a backup job will be started automatically to perform backup operation for
you at your absence. You can have backup running at your scheduled time as often as you want (e.g. twice a day
or hourly during office hour) without requiring doing any extra work.

Incremental Backup

Unchanged files are already backed up to server and need not to be backed up again. OBM will pick the new or
updated files from your backup set files and upload only these files to the server. It significantly reduces the time
required to perform the backup operation since most users update less than 5% of their total data each day.

Compress and encrypt data automatically

Data are compressed and encrypted before they are uploaded to the server. Not only does it reduce the storage
space to keep you backup files, it also ensures the privacy of your data.

File Retention Policy

The built-in file retention policy allows you to access multiple versions of the same file or even deleted files from
your backup set. Backup files are put into a retention area before they are removed from the server. If you want
to get back a deleted file (or you want to get back the previous versions of an updated files) within the retention
period, these files will always be available in the retention area. This feature is particularly useful when you have
accidentally deleted a file or incorrectly updated a file within the file retention period (file retention period is user
customizable).
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6.2 Backup files directly to the backup server

You can backup your data to an Offsite Backup Server by following instructions below.
vi. Open OBM
vii. Right click OBM icon available in the system tray and choose [Open]

a. Create a backup set

b.  From the Menu, Choose [Backup Set] -> [New] -> [File Backup Set]

181X
Backup Set Backup Restore Tools View Help
|2 File Backup Set
A Remove » |4 System State Backup Set
|1 Save Sefting e Lotus Backup Set
d Exit | MS Exchange Backup Set
T T Ui Backup 50 | MS Exchange Mail Level Backup Set
(S Backup St [13) M SQL Server Backup Set Change
4% Backup Fill oy  E—
: Iy QL Backup Set
I E] Command ! . L . on Account  Change
- ‘ Setting |@ Oracle Database Backup Set _
[~ Encryption Account Information
1 Retention Policy _
|—{5] Extra Backup Quota; 100
{—£& In-File Delta Time Zone: IGMT+08'UO (HKT) hd |
"'l Local Copy
Contact
|d EMmOo@your-company.com d
Contact Name: Demonsiration Account
Email Add : demo@you com
agd | Remove | Properties |
& Backup | & Restore | @ Log |
Backup C g fully Quota (Remaining / Total). 9.86G f 106G |Last Backup: 2007-01-15 21:00

C. Enter a name for your backup set

Add new File Backup Set x|

~Backup Set

Please type a name for this Backup Set.

Name: |FileBackupSet-1|

10 1168919585156
Type: File Backup

Cancel | = Previous Mext =

d. Select the files/directories you want to backup
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Add new File Backup Set x|

~Backup Source

Please selectfiles orfand directories to bhe bhacked up.

- =) Standard -]
B by Documents (CADocuments and Settingsisolo
|§| Cutlook (CADocuments and Settingsisalomon.yu
[F14) Outiook Express
¢ Favorites
(2} Desktop
ﬁ:l:l[ﬁ Options
= If My Computer
[ Local Disk (C3
[J%e Lacal Digk (D)
[J=e Local Disk (E3
[J=e Local Disk (F)
.4 DVD-RW Drive (G5
2 iRoseiPublict (P} [

C1lEg Wy Sharing Folders =
| ’

Cancel | = Previous | Mext =

e. Set the backup schedule (Note: You can have more than one schedule in a backup set)

Add new File Backup Set x|

~Backup Schedule

Please schedule the hackup time.

Add Remaove | Properties
Cancel | = Previous | Mewt = |
f. Set the encryption algorithm, encryption mode and encrypting key for this backup set

(Hint: For the sake of simplicity, just select the [Default] radio button (your encrypting key
is set to be the same as your backup account password)
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viii.

a.

rEncryption Setting

" Default (Use Login Passward as Encrypting Key)
p -

Flease setup the encryption setting of the Backup Set.

[~ Do NOT use encryption.

Algorithm: IAES 'I

Made:
+ CBC (Cipher Block Chaining)

" ECE (Electronic CookBook)

Encrypting Key: |

Confirm Encrypting kKey: I

= Prewious

Cancel |

Mext =

Run Backup

Select the backup set you want to run on the left panel and press the [Start Backup] button

(») on the toolbar

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

Confirm Backup Start

X

Backup to
& Offsite Backup Server
" Local Hard Disk (Seed Load Utilit

Start the backup for [FileBackupSet-1] 7

Ok Cancel

Optinns ==

Note:

1. You can have more than one backup set in a backup account.
2. Please write the encrypting key down on paper and keep it in a safe place. If you lose your encrypting key,
you will not be able to restore your backup files.

6.3 Backup files to removable hard disk (seed loading)

If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of
time to perform the first full backup through the Internet. If you run into this problem, you can use the Seed
Loading Utility to backup your backup set to local hard disk (instead of directly to the backup server) and then
transport the backup data, using removable hard disk, to the offsite backup server. The administrator can then
load all your backup files from your removable hard disk into your backup account. This could then save you days
(even weeks) of performing your first full backup. Since subsequent backup will be incremental backup (only new
or updated files will be uploaded to the server) you should have no problems uploading your backup data

afterwards.

To perform seeding loading, please do the following:

i. Open OBM from the System Tray (see previous sections for details)

ii.  Setup your backup set (see previous sections for details)

iii. Select the backup set you want to run on the left panel and press the [Start Backup] button (»)
on the toolbar
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iv. Select [Local Hard Disk (Seed Load Utility)] to start backing up your files to local hard disk and
press the [OK] button

Confirm Backup Start x|

Backup to
" Offsite Backup Server
% Local Hard Disk (Seed Load Utility)

Start the hackup for [FileBackupSet-1] ¢

0] 4 Canceal Qptiong ==

V. Enter a directory where you want all backup files to be stored in the [Destination Directory] field
and press the [Start] button.

Please make sure you have enough free space in the directory specified. If you are going to
transport a removable hard disk to the offsite backup server, please enter a directory under your
removable hard disk here.

Backup Set  FileBackupSet-1
Backup Type: File

Destination Directory

IE \Seed-Loadin u-Dlrectnlﬁ

vi. You should get the message “Backup Completed Successfully” as shown below after all backup
files are spooled to the directory you specified.

Backup Set  FileBackupSet-1
Backup Type: File
Destination Directory

[ErSeed-Loading-Directory g

Collecting all files in this backup set.. Completed zl
Total Files =15

[1/5] Processed 'COMUTOEXEC BAT

[2/5] Processed 'Clboot ini'

[3/5] Processed 'Cadell img'

[4/5] Processed 'Cidwnetimg'

[5/5] Processed 'Cldrnet2.img’

Start running post-commands

Finished running post-commands

Backup Completed Successfully -

Processed: 3.1M ( 3206764 byte ) Start 1og I

vii. Transport the data specified in the [Destination Directory] field to the offsite backup server
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7 Restoring Files

This chapter describes different ways files can be restored from to the backup server

It is very important to write down your encrypting key on paper and keep it in a safe

place because there will be no way to restore your backup files if you lose your
encrypting key.

7.1 Restore backup files directly from backup server

You can use either OBM or the web restorer to restore backup files from the backup server.

Using OBM

You can restore your data from the backup server by following instructions below.
i. Open OBM from the System Tray (see previous sections for details)

ii. Select the [Restore] tab at the bottom part of OBM
181
Backup Set Backup Restore Tools View Help
|1 Save Setting | P> Restore Files

&) Restore Controller [ J Restore Source (FileBackupSet-1)
|& FileBackupSet-1]  Showfiles after Job |2007-01-16 (12:03:40) = | € Show all files

|»

Backup Server 20 11-16 {1 3:40)

—+F ' Jimages [2007-01-16 (12:01:21)
{4 %] aix.png (Date Modified: Tue 3/14/2006 12:46 PM Size: 21K)

4 |1 AD_logo JPG (Date Modified: Tue 3/14/2006 12:08 PM Size: 6k)
{4 %] apple.png (Date Modified: Tue 3/14/2006 12:45 PM Size: 20K)

& r_ apple_logo. jpg (Date Modified: Tue 3/14/2006 12:00 PM Size: 5k)
4 : B_linux.png (Date Modified: Tue 3/14/2006 12:42 PM Size: 22k)
4 : BSD.gif (Date Modified: Tue 3/14/2006 12:26 PM Size: 21K)

4 : BSD.png (Date Modified: Tue 31 4/2006 12:22 PM Size: 3k)

1| ‘: bsd_logo.png (Date Modified: Tue 3/14/2006 12:37 PM Size: 44k)
4 : hip-ux gif (Date Modified: Tue 3/14/2006 12:08 PM Size: 2k)

{4 %] hpux.png (Date Modified: Tue 31 4/2006 12:44 PM Size: 15K)

1| 4 linwcbmp (Date Modified: Thu 2/9/2006 5:19 PM Size: 53K)

1% =] linwe png (Date Modified: Sat 3/11/2006 11:52 AM Size: &k)

{41 % linux2 bmp (Date Modified: Sat 3/11/2006 11:51 AM Size: 13K)

4 %] logo.gif (Date Modified: Sat 31 8/2006 11:39 AM Size: 3K

{41 % mac_bmp (Date Modified: Thu 2/9/2006 5:19 PM Size: 149K)

{4 %) mac.png (Date Modified: Sat 3/11/2006 11:52 AM Size: 8k)

{41 %4 mac2 bmp (Date Modified: Sat 311172006 11:51 AM Size: 12K)

4 %) map.gif (Date Modified: Wed 3/22/2006 9:34 AM Size: 10K)

{4 %) open.png (Date Modified: Mon 41 0/2006 9:44 AM Size: 67K)

{4 |%) open2.png (Date Modified: Fri 11/5/2004 1:01 PM Size: 75K)

{4 ] solaris_logo.gif (Date Modified: Tue 31 472006 12:01 PM Size: 2K)

{4 %] solaris_logo.png (Date Modified: Tue 3/14/2006 12:28 PM Size: 8K) =l
& Backup ) Restore | I Log |
Backup Completed Successfully Quota (Remaining / Total). 9.86G /106G |Last Backup: 2007-01-15 21:00

iii. Select the backup set from which you would like files to be restored from the left panel

iv. Select the snapshot of your backup files that you would like to restore from the backup server by
using [Show files after Job] drop down list

v. Select the files that you would like to restore and press the [Restore Files] button on the toolbar
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x|

Backup Set: FileBackupSet-1 (FILE)
Restare files ta

. Brovse |

[~ Restore file permissions

Tirme Log |

Estimated Total Restare Time:
Estimated Restare Tirme:
Saving File Ta:

Restoring Speed:

Close | Start | Stop |

vi. Use the [Browse] button to select the directory to where you want files to be restored (or simply
select [Original location] to restore files to their original path)

vii. Files will be restored automatically as shown below (a file won’'t be downloaded from the backup
server again if an identical file exists on local path already)

.In Restore Files x|

Backup Set: FileBackupSet-1 (FILE)
Restare files ta

= Original location

' |citemp Browse |

¥ Restore file permissions

Time Log |
2007-01-1612:06:27 Start il
2007-01-1612:08:27 Downloading restare file list

2007-01-1612:08:27 Downloading .. ‘citemmimanes’ (Total 0 bytes)

2007-01-1612:08:27 "titemplimages” contains the same file permission. Skip restore file p..
2007-01-1612:06:27 Diownloading .. 'citempimagesiwindows bmp' (Total 8k ytes)
2007-01-1612:06:27 citemplimagesiwindows bmp Ak ntes) downloaded

2007-01-1612:06:27 "citemplimagesiwindows bmp" contains the same file permission. Sk...
2007-01-1612:06:27 Downloading ... 'citempimages\Unicpng' (Total 4k bytes)
2007-01-1612:06:27 citemplimages\Unix png (4k bytes) downloaded Ll

Estimated Total Restare Time: 0 sec (Total 479,33k Intes - 479,36k nytes restared)
Estimated Restare Time: 0 sec (Total 43,66k lytes - 43.66k bytes restared)

Saving File Ta: chitemmimagesibsd_logo.png
Restoring Speed: 479 4k bytesisecond

Close | Start | Stop |
‘End
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Using the web interface

You can restore your data from an Offsite Backup Server by following instructions below.
i. Logon to the Offsite Backup Server web interface

ii. From the top menu, click [File Explorer]

T Online Backup Services Management Console - Microsoft Internet Explorer =18] x|

Restore | Install Software FAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout
| Home
Delete I
B Backup Set Size Last Modified Zipped [Ratio]
T D FileBackupSet-1
Delete |

Note: 1. This shows all backup sets available within this backup account.
2. To restore backup files, please click the backup set link shown above to continue.
3. To delete a backup set, check the checkbox next to the backup set and press the [ Delete ] button.

&) Done [T T [ NLocalintranet
iii. Click the [Backup Set] link that contains the files that you want to restore

iv. Select the snapshot of your backup files that you would like to restore from the backup server by
using [Show files after Job] drop down list
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Restore | Install Software

3 Online Backup Services Management Console - Microsoft Internet Explorer

=181 x|
EAQs | Help | Select Language

Profile | Backup Set | File Explorer | Report | Statistics

Logout

Rows/Page: | 50 'I

() Home > FileBackupSet-1 > E:\ > images

& Show files after Job [2007-01-16 (1222) ¥| © Show all files  Show Jobs View

_Delste | _Restore |

& .

& apple_logo.ipg
S mac.bmp
]
&

solaris_logo.gif

A9 @

windows_logo.jpg

_Delste | _Restore |

Last Modified Zipped [Ratio]

2006/03/14 12:00 4k [3%)
2006/02/09 17:19 39k [73%)
2006/03/14 12:01 2k [0%])
2006/03/14 12:00 10k [7%]

Note:

[D] = Differential delta file
[I] = Incremental delta file

bl o ol ol ol

This shows all files / directories within a backup job of a backup set.

Files shown in light gray color refers to files retained in the retention area.

To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.

&

CT T M toalntane

V. If you want to see all the different versions of all files (shown as gray below), just choose the

[Show all files] radio button on the [File Explorer] page.

Files, which are shown in gray below (e.g. AIX_logo.JPG) are being stored in the retention area on
the backup server but you can still restore these files from the backup server.

Restore | Install Software

n Online Backup Services Management Console - Microsoft Internet Explorer

FAQs | Help | Select Language

Profile | Backup Set | File Explorer | Report | Statistics

Logout

Rows/Page: | 50 'I

| Home > FileBackypSet-1 > F:\ > images

" Show files after Job [2007-01-16(12:22) *| & Show all files  Show Jobs View

_Delete | _Restore |

ile / Directory

apple_logo.jpg
mac.bmp

solaris_logo.gif

aogod @
EeoR

windows_logo.jpg

_Delete | _Restore |

Last Modified Zipped [Ratio]

2006/03/14 12:00 4k [3%]

2006/02/09 17:19 39k [73%]
2006/03/14 12:01 2k [0%]
2006/03/14 12:00 10k [79%]

Note:

[D] = Differential delta file
[I] = Incremental delta file

Db

This shows all files / directories within a backup job of a backup set.

Files shown in light gray color refers to files retained in the retention area.

To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.

&] Done

T T Moclnganet

vi. Select the files that you would like to restore and press the [Restore] button on the toolbar

vii. A dialog shown below would appear
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18] x]
Restore | Install Software FAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

Please wait ... while applet is downloading

Please select the Java Virtual Machine you would like to use to restore your backup files and press the [ Restore ] button
below.

l Restore | < You should see a "Restore” button here

Troubleshooting:

i. Make sure you have clicked the "Yes' button on the security waming dialog box. If you have clicked the 'No' button already,
please restart your browser and try again.

< Back

&) Applet Restorer started [T T [ NLocalintranet
a. Press the [Restore] button

b.  Enter the directory to which backup files should be restored to in the [Restore files to]
textbox

i Online Backup File Restoring Manager - |EI|5|

Restore files to: IDZ\temp‘-images Browse |

Decrypting Key: |***

[2007-01-16 12:26:03] Stant

[2007-01-16 12:26:03] Downloading restore file list ..

[2007-01-16 12:26:03] Downloading ... "DMtemplimagesiAlX_logo JPG™ (Total 4k bytes)
[2007-01-16 12:26:03] "D:tempimages\aly_logo.JPG™ (4k bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "DXtempiimagesiapple_logo jpg” (Total 4k bytes)
[2007-01-16 12:26:03] "D:templimagesiapple_logo jpa”™ (4k bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "DMemplimagesimac.bmp” (Total 39k bytes)
[2007-01-16 12:26:03] "D:tempimagesinac.bmp” (39k bytes) downloaded

[2007-01-16 12:26:03] Downloading ... "DMemplimagesisolaris_logo.gif” (Total 2k bytes)
[2007-01-16 12:26:03] "D:tempiimagesisolaris_logo.gif’ (2K bytes) downloaded
[2007-01-16 12:26:03] Downloading ... "DMemplimageswindows_logo.jpg”™ (Total 10k bytes)
[2007-01-16 12:26:03] "D Memplimageswindows_logo.jpg” (10k bytes) downloaded
[2007-01-16 12:26:0:

Saving windows_logo.jpg from localhost

| 100%

Estimated Total Restare Time: 0 sec (Total 61.06k bytes - 61.07k bytes restored)

Estimated Restore Time: 0 sec(Total 10.08k bytes - 10.08k bytes restored)
Saving File Tao: D:tempiimageswindows_logo.jpg
Restoring Speed: 122 1k hytesisecond

Close | Startl Stop |
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c.
backup files

d. Press the [Start] button

7.2 Restore backup files from removable hard disk

Enter the encrypting key which will be used to decrypt your backup files upon restoring your

If you want to restore lots of backup files from the backup server and you find it too slow to restore all your
backup files from the backup server through the internet. You can ask your backup services provider to send you
all your backup files in removable hard disk (or CD/DVD). However, all backup files stored on backup server are

in encrypted format. You need to decrypt them back to their original format before you can use them. To decrypt
your backup files from removable media, please do the followings:

i. Open OBM from the System Tray

Select the [Tools] -> [Decrypt Files Wizard] from the menu

Backup Set Backup Restore Tools View Help

5| Save Setting P> Start Backu)
.|.'.‘ Backup Controller

= User Profile

[2% Unzip Local Copy

Set-1

=181 x|

i) p ce
] Backup Schedule
i Backup Filter
=] Command Line Tool
{*] Setting
e Encryption
iy Retention Policy
=] Extra Backup
& In-File Delta
= Local Copy

o Backup | € Restore | g Log |

Backup Set

Mame: FileBackupSet-1
1D: 1168919894093
Type: File Backup

Network Resources Authentication for Windows
Domain:

User Name:

Password:

Properties

¥ Run scheduled backup on this computer

E] Log Table (FileBackupSet-1)

£y

Type | Log Time

Backup Completed Successfully

|Quota (Remaining / Total): 9.86G / 10G |Last Backup: 2007-01-15 21.00

Use the [Browse] button to locate the “files” directory (provided by your backup provider in

removable hard disk or DVD) which contains the backup files that you want to decrypt
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fnr files Wigand
Full path to the [files] folder
Please enter the path to the [files] folder which contains the backup files that you want to decrypt.

Cancel | Pre |

iv. If you have more than one backup set under the “files” directory, select the [Backup Set] which
contains the backup files that you want to decrypt

|
~Backup Set
Please select the backup set.

¥ FileBackupSet-1

Cancel | = Previous |

v.  Select the snapshot of your backup files that you would like to restore from the removable media
by using [Show files after Job] drop down list
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.t Decrypt Files Wizard ﬂ

Please select the files that you want to decrypt

% Show files after Job |Currem ~| € showalifies
=-H Backup Server  [SIIEIN
=S 2007-01-16 (12:22:23)

E‘I—Dﬁimages 2007-01-168 (12:22:07)
\1'2] apple_logo.jpg (Date Modified: Tue 3M 452006 12:00 PM Size: 5k
.ﬂ mac.bimp (Date Modified: Thu 2972006 519 PM Size: 149K)
\:'] solaris_logo.gif {Date Modified: Tue 31472006 12:01 PW Size: 2k)
E‘Z] windows_logo jpd (Date Modified: Tue 311452006 12:00 PM Size: 11K)

Cancel | = Previous Mext =

If you want to see all the different versions of all files (shown as gray below), just choose the

Vi.
[Show all files] radio button on the [Decrypt Files Wizard] dialog.
Files, which are shown in gray below (e.g. AIX_logo.JPG) are being stored in the retention area on
the removable media (but you can still restore these files).
x|
~Please select the files that you want to decrypt
" Showfiles after Joh |Curren1 LI = Show all files
EI—B Backup Server
SHEIFA
E-Himages
[8) 21 _logo PG iDate Modified: Tue 3142006 12:08 PM Size: GK)
.5‘3 apple_logo jpa (Date Modified: Tue 3M 42006 12:00 PM Size: k)
Cﬂ mac.hmp (Date Modified: Thu 20972006 5:19 P Size: 149K)
.:'] solaris_logo.gif (Date Modified: Tue 371 452006 12:01 PM Size: 2k)
.5‘3 windows_logo.jpd (Date Modified: Tue 31 452006 12:00 PM Size: 11k)
= Previous Mext =
vii. Enter the directory to which you want the backup files to be restored to in the [Decrypt files to]

section and enter the [Decrypting Key] (the same as the encrypting key of this backup set)
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.In Decrypt Files x|

Backup Set: FileBackupSet-1 (FILE)
Decrypt files to

o

. | : Brawse |

[ Restaore file permissions

Decrypting Key:l

Time Log

Elapsed Time:
Current File Tirme:
Saving File To;
Diecrypting Spead:

Cloge | Start | Stop |

viii. Press the [Start] button

.In Decrypt Files x|

Backup Set: FileBackupSet-1 (FILE)
Decrypt files ta

 Original location

i+ Ie:ltemp Browse |

[~ Restore file permissions

Cecrypting Kev:l“*

Time Log
2007-01-1612:48:58 Start -
2007-01-1612:48:53 Initializing decrypt action ...
2007-01-1612:48:53 Cecrypting ... 'edtemplalx_logo PG
2007-01-1612:48:53 Cecrypted 'eMempial<_logo JPG' {4k ytes)
2007-01-1612:48:53 Cecrypting ... 'edtemplwindows_loga.jpg’
2007-01-1612:48:53 Cecrypted 'eMempiwindows_logojoa ¢ 0k bwtes)
007-01-1612:48:58  Decrypting .. ‘etemplsalaris_logol Decrpting ... ‘etemphwindows_logo.jp

AAAT A4 A4S Anon e n e Al L b i i mmam a8 ST Ly hm

Iﬂ_

Kl

Elapsed Time: 61k ytes decrypted. 0 sec elapsed.
Current File Time: 0 sec {Total 4k ytes - 4k iytes decrypted)
Sawing File To: elMempiapple_logojpa

Cecrypting Speed: 122k ntesisecond

Close | Start | Stap |

‘End
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7.3

IP addresses Restriction for Online Restore

Online file restore operation can be restricted by IP addresses. You can ask your backup service provider to
restrict online file restoration for your backup sets by IP addresses to only allow people from authorized IP
addresses to restore files from the backup server. To check if online file restore of any backup set is restricted

this way, please take a look at

the web interface of OBS, [Online Backup Services Management Console] ->

[Backup Set] -> [Online Restore IP restriction] (shown below).

Users are not allowed to update the [Online Restore IP restriction] directly. Please ask your backup services
provider to do the changes for you.

-2} Online Backup Services Management Console - Microsoft Internet Explorer 10 =1
Eestore | Install Software F&Qs | Help | Select Language
Erofile | Backup Set | File Explorer | Report | Statistics Logout

Command I ;I

Working Directory I
[Help] Post-backup command

1. Name I

[Add ]

Command |

orking Directory I
[Help] Online Restore IP restriction
1. Only from 192.168.1.10

to 192.168.1.200

oo | Reset

Key :
Name

Backup Source

Backup Schedule

Name of the backup set

l

[

Files/Directories that are to be included into or excluded from
the backup set

Schedules when backup should be performed automatically
Enable In-File Delta backup feature

Block size used to detect changes within backup files.

Enable In-File Delta
Block size
|@°| Done

l_ l_ l_ l_ l_ [« Local intranet
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8 In-File Delta Technology

The chapter describes what in-file delta technology is and how in-file delta can be used to backup large database
files (e.g. a 10GB Outlook.pst file) without uploading the whole database file everyday.

8.1 Overview

In-file delta technology is an advanced data block matching algorithm which has the intelligence to pick up
changes (delta) of file content between two files. Using this algorithm, daily backing up of large files (e.g. a 10GB
Outlook.pst file) over low-speed internet connection is made possible because it requires only the changes of
information (should be marginal) since the last backup to be sent over a low-speed internet connection to
complete the backup of a large file (here we assume that the full backup of the file has been saved on the backup
server already).

This is what will happen in the backup of a 10GB Outlook.pst file when it is backed up by OBM with in-file delta
technology.

i. The whole files (10GB), along with its checksum file, are backed up to the backup server. This can
be done directly through the internet or indirectly using the seed loading utility on a removable
hard disk.

ii.  When backup runs again later (normally the next day), OBM will download a checksum listing of
all data blocks of the full backup file (or last incremental backup file) from the backup server and
use it to pick up all changes that have been made to the current Outlook.pst file.

iii. Changes detected are then saved in a delta file which is uploaded to the backup server. A new
checksum file is generated and is also uploaded. (This delta file is assumed to be small because
the content of PST files doesn’t change a lot during daily usage)

iv. Subsequent backups of this 10GB Outlook.pst file will go through step ii and step iii again. As
explained, only a small delta file and checksum file will be uploaded to the backup server.

v.  With in-file delta technology, daily backing up of large file over low-speed internet connection is
now possible

Incremental in-file delta type

Incremental Delta will facilitate ease of backup. The delta is generated by comparing with the latest uploaded full
or delta file. The delta file generated is the smallest possible and uses the least bandwidth during backup. For
restoration, the full file and all delta files up to the required point-in-time is required to restore the file to a
specific point-in-time.

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday.

After the first full backup job, OBM will continue to generate and upload delta files instead of uploading the full
file until either one of the following two rules are true:

a) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting.

b) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio]
setting

Using incremental delta, the delta generated by comparing the current file with the latest uploaded full or delta
file is around 100MB.

Since the delta file size is around 100MB daily, the delta ratio (around 1%) will not trigger a full file upload.
Instead OBM will continue to generate and upload delta files until day 102 (assuming the full file was uploaded on
day 1) when the number of deltas generated exceeds the [Number of Delta] setting and triggers the upload of
the full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you don’t want to upload the
full file.

All delta files are generated with respect to changes made since the last incremental or full backup. This means
that the last full backup file and ALL incremental delta backup files are required to restore the latest snapshot of
a backup file.
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Differential in-file delta type

Differential Delta will facilitate ease of restore. The delta is generated by comparing with the latest uploaded full
file. The delta file generated grows daily and uses more bandwidth during backup. For restoration, the full file and
a single delta file is required to restore the file to a specific point-in-time.

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday.

After the first full backup job, OBM will continue to generate and upload delta files instead of uploading the full
file until either one of the following two rules are true:

¢) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting.

d) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio]
setting

Using differential delta, the delta generated by comparing the current file with the latest uploaded full file is
around 100MB for the 15 delta, 200MB for the 2™ delta, 300MB for the 3™ delta and so on.

Since the delta file grows by 100MB daily, the delta ratio for day 52 (delta file size is approximately 51x100=
5.1GB, assuming the full file was uploaded on day 1) being over 50% exceeds the [Delta Ratio] setting and
triggers the upload of the full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you
don’t want to upload the full file.

All delta files are generated with respect to changes made since the last full backup file (i.e. differential backup).
This means that only last full backup file and the last delta file are required to restore the latest snapshot of a
backup file. This means that other intermediate delta files are only required if you want to restore other
snapshots of a backup file.

Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular version
of a backup file non-recoverable and all other backups created by other delta files of the same file would still be
intact.

L8l

Backup Set Backup Restore Tools View Help
|51 save Setting | P> Start Backup [l o
'\.'.‘ Backup Controller (2 (. In-File Delta (FileBackupSet-1)

= User Profile
=@ FileBackupSet-1

¥ Enable In-File Delta

4[J Backup Source Block Size: [Auto 'lEMss
= Backup Schedule
Backup Filter Applyto files
=] Command Line Tool Minimum Size: [25 Mbytes
i ‘Sel‘llng
LaJ Encryption .
-F
W Retention Policy A LD
=] Extra Backup Default ||ncremema| LI
f

s n-File Delta
=& Local Copy ﬂ]
Upload full file when

F MNo. of Delta = [100

r
I Delta Ratio*= |50 ~| %
* Delta Ratio = Delta Size / File Size

7] Log Table (FileBackupSet-1) o
Type I Log [ Time I
& Backup | [*1] Reslore| | Log |
Backup Completed Successfully Quota (Remaining / Total): 9.86G /106G |Last Backup: 2007-01-15 21:00
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8.2 Block Size

The block size defines the size of data block being used to detect the changes between the last full or delta
backup file and the file sitting on the local computer right now. In general, the smaller the block size, the more
likely a matched data block can be found between the last backup file and the file on local computer. It, therefore,
produces a smaller delta file but it would require more processing power to detect these changes. On the other
hand, in-file delta backup running with larger block size will run faster but this will generally produce a larger
delta file.

In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size of
the file) for you.

8.3 Minimum File Size

The [Minimum File Size] setting defines the smallest file size a file must have before the use and application of in-
file delta backup technology.

If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup
technology won't be applied to this file and the whole file, instead of just the delta file, will be uploaded to the
backup server. It is not necessary to perform in-file delta backup on small files because backing up the whole file
doesn’t take too long anyway. Backing up the whole file instead reduces the time required to restore a backup file.

8.4 Uploading full file again

No. of Delta

The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be
generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to the
backup server instead.

For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting is
set to 100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, if
the [No. of delta] rule is disabled, it will keep generating delta files and uploading these delta files to the backup
server until the other delta rule forces a full backup (i.e. delta ratio exceeded). This setting is here to make sure
that there will always be a full backup file after a certain number of delta files have been generated.

Delta Ratio

The [Delta Ratio] setting is defined to be the size of a delta file divided by the size of its full backup file (i.e. the
percentage of changes detected between the last full backup file and the current file).

If the delta ratio calculated from the size of the generated delta file and the size of the full backup file is greater
than the [Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server.
It is done this way because the difference between backing up the whole file and the delta file is not significant
and it is better to upload the whole file instead to reduce the time required to restore the file.

The default setting of [Delta Ratio] is 50%. This means that if a file changes by more than 50%, the whole file,
instead of just the delta file, will be backed up and uploaded to the backup server.

8.5 Advanced In-file delta type

The [In-file delta] -> [Advanced] setting allows users to override default in-file delta type when on a certain
number of days (e.g. all Sundays or the 1% day of each month). This is useful if you want all in-file delta backups
to be incremental but you want to do a differential in-file delta backup on Saturdays as well as the full file
backups on the 1% day of every month. If you want to do this, simply configure [In-file delta] -> [Advanced] ->
[Advanced In-file Delta Type Setting] to what is shown below.
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Advanced In-File Delta Type Setting x|

~Weekly Variation (Override Default Setting)

[ Sunday m [ Thuraday Ih
™ Monday m I"I| Frictay Ih
" Tuesday m ¥ Saturday W
[T vednesday m

Svearly Wariation (Owerride Weekly Wariation or Default Setting)

¥ January Ih I+ July Ih
¥ February Im ¥ August m
[+ March Ih ¥ Septermber m
v April Ih v October m
v May Ih ¥ Movember Im
¥ June Im [¥ December m
rDate
& Day |1 vI

e frirst =] |sunday x|

Ok Cancel

With this setting, all backup Jobs on Saturdays will be differential in-file delta backups, backups for the 1% day of
each month will run a full backup. This ensures that all backup files will be backed up in full at a regular interval.
One benefit of this is that restore time will run faster because of less delta merging. Another benefit is that the
risk of a corrupted incremental delta file resulting in data loss is much lower because a full backup is always

available periodically.
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9

Backup/Restore Oracle 8i/9i

This chapter will describe in details how OBM backup your Oracle 8i/9i and how you can restore an Oracle 8i/9i
database using the backup files.

9.1 Requirements

OBM must be installed onto the computer that can connect to your Oracle 8i/9i server using TCP/IP

protocol.

Data from Oracle 8i/9i database will be backed up to a temporary directory before they are sent to
Offsite Backup Server. Please make sure you have sufficient space on your computer to store these
data when you run the backup job.

Database must be in archived log mode

To switch to archived log mode and enable automatic log archiving, please do the following:

a.

Set the parameters below in the PFILE to enable automatic archiving

log_archive_dest = [directory where archived logs will be stored]
log_archive_format = ARCH%S.LOG
log_archive_start = TRUE

Switch to archived log mode

SVRMGRL> connect internal;
SVRMGRL> startup mount;
SVRMGRL> alter database archivelog;
SVRMGRL> alter database open;

Enable Oracle JVM for Oracle 8i/9i, please do the following:

Please make sure shared pool size is larger than 50MB and java pool size is larger than

20MB in the PFILE. For example:

java_pool_size = 20971520
shared_pool_size = 52428800

Run the scripts below

For Oracle 8i

SVRMGRL> connect internal

SVRMGRL> @?/javavm/install/initjvm.sql;
SVRMGRL> @?/rdbms/admin/catalog.sq|l;
SVRMGRL> @?/rdbms/admin/catproc.sql;
SVRMGRL> @?/javavm/install/initdbj.sql;

For Oracle 9i

SQL> connect sys/change_on_install as sysdba
SQL> @7?/javavm/install/initjvm.sql;

SQL> @?/xdk/admin/initxml.sql;

SQL> @?/xdk/admin/xmlja.sql;

SQL> @?/rdbms/admin/catjava.sql;

For Oracle 10
Oracle JVM is enabled by default. No additional steps required.

JAVASYSPRIV role is granted to system account

You can grant this role to system account by executing:

SQL> grant JAVASYSPRIV to system;
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9.2 Overview

OBM will backup your Oracle database by taking the following steps.

Vi.

Vii.

Note:

Connect to the Oracle database using SQL*NET over TCP/IP
Run all Pre-Commands of this backup set
If the backup type to run is [Database Backup type],

a. all data files in each of the tablespace(s) selected are copied to the temporary directory
specified by this backup set

b. if there are temporary files in the database, the script to re-create the temporary files are
generated to a file located in the temporary directory specified by this backup set

C. all non-default initialization parameters will be spooled to an initializing file located in the
temporary directory specified by this backup set

d. all control files will be copied to the temporary directory specified by this backup set

e. all archived log files will be copied to the temporary directory specified by this backup set
If the backup type to run is [Archived Log Backup type],

a. all archived log files will be copied to the temporary directory specified by this backup set
Run all Post-Commands of this backup set

Upload all files copied to the temporary directory to the Offsite Backup Server

Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled

If your Oracle database is running on Windows, please install OBM onto the company running the Oracle database
if OBM is to backup this Oracle database. This would shorten the time required to backup the Oracle database.
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9.3 How to backup an Oracle Database

Please follow the instructions below to backup your Oracle database to the Offsite Backup Server.
i. Install OBM onto your computer
ii. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
3

3

Backup and Eestart
Backup and Shutdown

Help
Stop Bunndng Backup

Exit

TTED 1446

iii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Oracle Database Backup Set]

1ol x|
| Backup View
File Backup Set
Lahee Backup Bet bl MSSGLBaCkupSet-1
M5 Exchange Backup Set
ME SOL Server Backup Set
o {SOLBackupSat1
W/S3L Backp Be rosof SGL Server Backup
or: ase Backup Se
1 BackupSet 7 SQL Server
= ackupSet- k
= [Hi) MySQLBackupSet-1 Login 10:  sa
() Backup Source Password:
iy Backup Schedule
[ command Line Taol - |
Ly setting
&) Encryption
|'1| Log Table (MSSQLBackupSet-1) 7
Type | Log I Time
Backup I LDGI
‘Welcome to Onling Backup Manager Quoia (Remaining J Total): 49,961 506 Last Backup: 2004-07-22 14:32
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b. Enter a name for your backup set

Add new cle
Backup Set
Please type a name for this Backup Set.

Name: [OracleBackupSet-1
Type: Oracle Database Server Backup

Oracle Database Server

Login ID: [svsiem

Password: |

Host: |

Port [1521
siD: |

Next = | Cancel |

C. Enter the system password, the Oracle Database Server Host Name, TNS Port and SID

d. Select the tablespace(s) you want to backup

Backup Source
Please select tablespaces to be backed up

™ L Oracle Database Sarver
[ ¥y SYSTEM
[~ ¥ OEM_REPDSITORY
¥y RES
I'_E TEMP
[ USERS
[ D

Temporary disk space uged for s1oring spool fles

|c1Backupioraciene Change |
« Previous Neat = | Cancel |

e. Enter a temporary location to store the database file(s) before they are sent to an Offsite
Backup Server

f. Set the backup schedule for database backup and archived log backup

Backup Schedule
Flease schedule the backup time.

3, Control & Init File, Archived ack
lArchived Loy

hedule (Type: Archived Logs, Waekly - Mc

K — il |

Add | Remoe | Properties |

< Previous | Neat = Cancel |
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Mame: |Database - complete BackupSchedule
~Backup

f+ Database - complete
" Database - differential

~ Transaction log

~Type

= Daily i+ \Weekly " Monthly = Custom

~Day

Eackup on the following dayis) every week:
[~ Sunday I~ Monday [~ Tuesday [~ Wednesday

[~ Thursday  Iv Friday [~ Saturday
—Start

Stant Time {hh:mm): |21 VI:IDD VI
~Stop

Stop on completion (Full Backup)

[4]:4 | Cancel |

Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day transaction log
backup by adding more than one daily transaction log backup schedule to your backup set.

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Add new Orpscle Dadabase Backup Sat x|
Encryption Sefing
Please setup the encryption setting of the Backup Set

™ Do NOT use encryption

wigonthm: [N ~ |

Mode:
& CBC (Cipher Elock Chaining)

 ECE (Electronic CookBook)

Encrypting Key: [
Confirm Encrypting ey I

= Previous Neat = Cancel |

Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.

iv. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select the backup type (e.g. Database Backup, Archived Log Backup) you would like to
perform

) Tpe (DracleBackupSet-1) x|

Backup

= Database (Tablespaces, Control & Init File, Archived Logs)

 Archived Logs

OK Cancel

c. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.
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arm Backup Start x|

Backup to

~ Offsite Backup Server

" Local Hard Disk (Seed Load Utilmy)

Start the backup for [OracleBackupSat-1] 7

9.4 How to restore an Oracle Database

Please follow the instructions below to restore your Oracle 8i/9i databases from an Offsite Backup Server.

Download the backup files from the Offsite Backup Server

Please refer to the [Quick Start - Backup File] section for information on how to download backup
files from Offsite Backup Server.

Put all data files back to their original locations

Control files, data files and archived logs are stored on Offsite Backup Server along with their full
path information. You just need to put all these files back to their original locations when
performing a database restore.

Put the PFILE back to its default location

Oracle 8i: $ORACLE_HOME/dbs/init<SID>.ora
Oracle 9i: $ORACLE_HOME/admin/<SID=>=/pfile/init.ora

Restore Database

(if Oracle 8i) Use Server Manager to restore you database by doing the following:
a. Run Oracle Server Manager (svrmgrl)

b. Connect to the target database

C. Startup mount

d. Reapply all transactions from the archived log files

e. Open database

Oracle 8i Example:

$ svrmgrl
SVRMGRL> connect i nternal

SVRMGR> startup nount;
ORACLE instance started.

Total System d obal Area 95874448 byt es
Fi xed Size 64912 bytes

Variabl e Size 52744192 bytes
Dat abase Buffers 40960000 bytes
Redo Buffers 2105344 bytes

Dat abase nount ed.

SVRMGRL> recover database using backup controlfile

ORA-00279: change 419671 generated at 06/14/03 02:51: 49 needed for thread 1

ORA- 00289: suggestion : /data/ora815/vin/archi ve/ ARCHO000000225. LOG

ORA-00280: change 419671 for thread 1 is in sequence #225

ORA-00278: log file '/data/ora815/vin/archi ve/ ARCHO000000224. LOG no | onger needed for this
recovery

Specify |og: {<RET>=suggested | filenane | AUTO | CANCEL}

AUTO

Log applied.

ORA-00279: change 547222 generated at 06/18/03 19:58:26 needed for thread 1

ORA-00289: suggestion : /data/ora815/vin/archi ve/ ARCHO000000384. LOG

ORA-00280: change 547222 for thread 1 is in sequence #384

ORA-00278: log file '/data/ora815/vin/archi ve/ ARCHO000000383. LOG no |onger needed for this
recovery

ORA- 00308: cannot open archived | og '/data/ora815/vin/archi ve/ ARCHO000000384. LOG

ORA-27037: unable to obtain file status

Linux Error: 2: No such file or directory
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Additional information: 3

SVRMGR> recover database using backup controlfile until
ORA- 00279:
ORA- 00289:
ORA- 00280:
Specify log: {<RET>=suggested |
CANCEL

Medi a recovery cancel | ed.
SVRMGR> al ter database open resetl ogs;
St at ement processed.

suggestion :
change 547222 for thread 1 is in sequence #384
filename | AUTO | CANCEL}

cancel
change 547222 generated at 06/18/03 19:58: 26 needed for thread 1
/ dat a/ or a815/ vi n/ ar chi ve/ ARCH0000000384. LOG

(if Oracle 9i) Use Recovery Manager to restore you database by doing the following:

a. Run Oracle Server Manager (rman)
Connect to the target database

C. Startup mount

Open database

Reapply all transactions from the archived log files to the last sequence

Oracle 9i Example:

C:\>rman nocat al og

Recovery Manager: Release 9.2.0.1.0 - Production

Copyright (c) 1995, 2002, Oracle Corporation. Al

RMAN> connect target

connected to target database (not started)
RVAN> startup nmount

connected to target database (not started)
Oracle instance started

dat abase nount ed

Total System d obal Area 269556596 bytes
Fi xed Size
Variabl e Size
Dat abase Buffers
Redo Buffers

453492 bytes
243269632 bytes
25165824 bytes
667648 bytes
RVAN> recover database until sequence=63 thread=1;
Starting recover at 24-JUN-03
al | ocated channel: ORA DI SK_1
channel ORA DI SK_1: sid=11 devtype=Di SK

starting nedia recovery

archive log thread 1 sequence 56 is already on disk as file
C: \ ORACLE\ ORADATA\ VI N\ ARCHI VE\ 1_56. DBF

archive log filenane=C:\ ORACLE\ ORADATA\ VI N\\ ARCHI VE\ 1_56. DBF
archive |og filename=C:\ ORACLE\ ORADATA\ VI N\\ ARCHI VE\ 1_57. DBF
archive log filenane=C:\ ORACLE\ ORADATA\ VI N\ ARCHI VE\ 1_58. DBF
archive |log filename=C:\ ORACLE\ ORADATA\ VI N\ ARCHI VE\ 1_59. DBF
archive log filenane=C:\ ORACLE\ ORADATA\ VI N\\ ARCHI VE\ 1_60. DBF
archive |log filename=C:\ ORACLE\ ORADATA\ VI N\\ ARCHI VE\ 1_61. DBF
archive log filenane=C:\ ORACLE\ ORADATA\ VI N\ ARCHI VE\ 1_62. DBF

nedi a recovery conpl ete
Fi ni shed recover at 24-JUN-03

RVAN> al ter database open resetl ogs;

dat abase opened

rights reserved.

t hread=1
t hread=1
t hread=1
thread=1
t hread=1
t hread=1
t hread=1

sequence=56
sequence=57
sequence=58
sequence=59
sequence=60
sequence=61
sequence=62
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10 Backup/Restore Microsoft SQL Server 7.0/ 2000

This chapter will describe in details how to use OBM to backup your Microsoft SQL Server 7.0 / 2000 server and
how you can restore your Microsoft SQL Server 7.0 / 2000 server from the backup files.

10.1 Requirements

i. OBM must be installed onto the computer running Microsoft SQL Server.

ii. Data from Microsoft SQL Server will be backed up to a temporary directory before they are sent
to Offsite Backup Server. Please make sure you have sufficient space on your computer to store
these data when you run the backup job.

10.2 Overview

OBM will backup your Microsoft SQL Server database(s) by taking the following steps:
i. Before running any backup activities, OBM will run all Pre-Commands of the backup set.

ii. For each database that is to be backed up, OBM will issue a database / transaction log backup
command to Microsoft SQL Server to backup each database to a Microsoft SQL Server database
backup file (*.bak file) and save it in the temporary directory you specified.

iii. After all *.bak files have been spooled to the temporary directories, OBM will run all Post-
Commands of the backup set.

iv. Upload all files copied to the temporary directory to the Offsite Backup Server.

V. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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10.3 How to backup Microsoft SQL Server database(s)

Please follow the instructions below to backup your Microsoft SQL Server databases using OBM.

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backuop and Logoff 4
3
3

Backup and Festart
Backup and Shutd own

Help
Stop Running Backop P

Exat

TTED 1446

ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MS SQL Server Backup Set]

1ol x|
Backup  View
File Backup Set
Lahee Backup Bet bt MSSQLBackupSet1
M5 Exchange Backup Set
M3 ar Backup Set
T (SQLBackupSet-1
S LT T roson SL Server Backup
Oracle Database Backup Sel
1 BackupSet-T oL sener
= ackupSet )
= (i) MySQLBackupSet1 Login 10: s
() Backup Source Password:
iy Backup Schedule
[ command Line Taol o I
Y setting
&) Encryption
(4] Log Table (MSSOLBackupSet-1) @
Type | Log I Time
Backup I I-Dﬂl
‘Welcome 1o Online Backup Manager Quota (Remaining / Tofal): 499G/ 500 LastBackup: 2004-07-22 14:32

b.  Enter a name for your backup set

Add n =z

Backup Set
Flease type a name for this Backup Set

Server Backup Set x|

MName: [MSSOLBa;kque1-1

Type: Microsoft SAL Server Backup
Microsoft SQL Server
LoginID: [a

Password: |

Mext = | Cancel
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C. Enter the Microsoft SQL Server administrator username and password

d. Select the database(s) you want to backup

Backup Source
Flease select databases 10 be backed up.

™ O Microsoft SGL Server
[ 1 master
ru
™ 1 model
™ 1 msdb
" 1 pubs
™ 1 Northwind
I abe
[T 1 vincent
™ W new_model

Temporary disk pace used for storing spool files

[cBackupMssaLServer Change
= Previous Mexd = Cancel I

e. Enter a temporary location to store the backup files before they are sent to an Offsite
Backup Server

f. Set the backup schedule for full database backup and transaction log backup

arver Backup Set x|

Backup Schedule
Flease schedule the backup time.

Datat ackupSchedule (Type: Dat ey -

Transaction log BackupSchedule (Type: Log, Weekly - Monday, Tu

4 | L'

Add | Remove | Properties |

= Previous Mext = | Cancel

(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day

transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Seffing
Flease setup the encryption setting of the Backup Set

[ Do NOT use encryption
Algorithm:
Mode

& CBC (Cipher Block Chalning)

 ECB (Electronic CookBook)
Encrypting Key: [
Confirm Encrypting Key: |

= Previous Mext = | Cancel

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select the backup type (e.g. Complete, Differential, Transaction Log) you would like to
perform

Backup

@ Database - complets
" Database - differential

" Transaction log

oK Cancel

C. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

Confimm Backup St

Backup to

Start the backup for MSSGL BackupSet] 7

10.4 How to restore Microsoft SQL Server database(s)

Please follow the instructions below to restore your Microsoft SQL Server databases from an Offsite Backup
Server.

i. Download the backup files (.bak) from the Offsite Backup Server

Please refer to the [Quick Start - Backup File] section for information on how to download backup
files from Offsite Backup Server.

ii.  Open Microsoft SQL Enterprise Manager

You can open Microsoft SQL Enterprise Manager from [Start Menu] -> [Program] -> [Microsoft
SQL Server] -> [Enterprise Manager]

iii. (Optional) Restore “master” database

You need to restore “master” database if you:
a. are rebuilding all your databases from scratch

have changing any server-wide or database configuration options

have added logins or other login security-related operations.

have created or removed logical backup devices.

have configured the server for distributed queries and remote procedure calls, such as
adding linked servers or remote logins.

caeo

You do not need to restore your master database if you just want to restore a user database. For
more information on Microsoft SQL Server “master” database, please visit
http://www.microsoft.com/sql/.

To restore “master” database, please do the following:

a. Start Microsoft SQL Server in “Single User Mode”

1. Right click your Microsoft SQL Server and select [Properties]
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‘14 UL Server Enterprise Manager - [Console Root' Microsoft SOL ServersiSOL Server Group\i
T Conscle  Window  Help
| adion vew ook || & = [A@E X TRE @ %
Tree | Databases 8 lbems
] Cansale Ract u u

) Morosaft SOL Servers

=40 50L Server Group abe master

=]

=l0lx|
|=18).%]

N PUBG

U U u

msdb N thwired

o

pubs teenpdb
Mew SOL Server Registration. ..
Edit QL Server Registration properties...,
Delete SOL Server Regstration

®

LoLoL

Discormect

Pase

fOpens property sheet for the current selaction.

2. Press the [Startup Parameters] button

SOL Server Properties - WINZODOD-EN E
Gereral |

x|

Dafsbase Settngs |
Secunty

Server Seltings |
Memoy | Processor |

WINZ0000-EN

f_‘l Name:
Product:
Dpesating systen
Product vession:
Language:
Platfom

05 memony:
Processors:

Fioct dwectory:
Code page:

AutoStart pobcies when the operabng system starts

3

™ Autostart
™ Autostart

Startup parameters. . |

SOL Sesver Enterpie
Windows NT - 5.0[2195)
7.00623

Engiizh [United States)
NT INTEL %8B

256(MB]

1

FAMSSOLY

CP1252

SOL Serves Agent
MSDTC

o]

Cancel | Help

3. Add a “-m” parameter to the [Startup Parameters]

Pararmeter

-

Exigting parameters

-dC:%Program Files\Microzoft SOL Server
-2 5Program FilestMicrozaft SOL Server
-IC:\Pragram Filesihicrozoft SOL Servers

KN

ok |

i

Cancel

Bemawve |

| Heb

4. Restart Microsoft SQL Server

From [Enterprise Manager], right click your Microsoft SQL Server and select [Stop] and

then [Start].
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7 50U Server Enterprise Manager - [Console Root'Microsoft SOL Servers\SOL Server 6 =10] x|
| Console yndow Help =121

| aon vew ook || @ o @@ XERD @ kN MOERG

Tree | | WINZ0000-EN (Windows NT) 5 Ttems
1 Corsole Rook .
= € Meroscft S servers Getting Started Taskpad
-4 50U Server Group
) :_ 2] Dat. Mew 50U Sarver Regstration. .. . =
=1 Edit SQL Server Registration properties. .. - ]-‘ r: o
w1 Dedete SOL Server Registration t h B
: 3 Disconnect Tdotabese 'SQLServer  export data
i B Pause
oy St
= Mew »
4] Dat. all Tasks »
- Mar
4] sen View »
%] Sup  Mew ‘Window from Here
Delate
Refresh
Properties
Help
[f 501 serve Enterprine Manoger - [Console oot Microsol S Servers i
|1 Console window Help [INETES|

| acion vew ook || & = @@ X®ER(@ |k [N PO EEB

Tres | | SQL Server Group 1 Ttem

] Corsole Rook | l

= ) Micro: e

= OE. up| WINZDODO-EN
2 uﬂm Mews SOL Server Registration...
(Tt gde SQL Server Registration properties. .

Delete SOL Server Registration
Connect
New (3
Al Tasks 3
New Window from Here
Delate
Refresh

‘ Properties
Help

b. Restore “master” database

1. From [Enterprise Manager] -> [Tools] -> [Restore Database]

‘ta SOL Server Enterprise Manager - [Console Root\Microsoft SOL Ses 10l x|
[B Greh_tpi b T
| acton wew Toos |4 =+ @@ | XEF R R[N MG BRG
'lml Diata Transformation Services * | ow NT) S ltems
Job
[ Consale Roct N
B Mcroscrs » § Started Taskpad
= P I .
- 4B S0t Server Query Ansyzer ? =
3 5QL Server Profiler i L)
i wizerds...
-0
%) Database Mantenance Flanner...
Backup Database. .. "
| Restore Database...__________|
S0 Server Configuration Properties. ..
External Tools. ..
Fork...
e

2. Select [master] in the [Restore as database] drop down list

3. Select the [From device] radio button.
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4. Press the [Select Devices] button.

l

General | Dptions |

,”3 Bestore as database:  [master =

Restore: € Database " Flegroups o fles  From device
Parameters
Deeyices: ‘

[_
% Restore backup set

+ Dgtabaze - complate

" Databage - differential

™ Transaction lag

™ File of flegroup

™ Read backup set information and add to backup history

oK Cancel Hel

5. From the [Choose Restore Devices], press the [Add] button.

5
‘When the backup & restored, SOL Server will attempt bo 1estore from the
e devices listed below.
Backup st [Unkrowsn]
Restore from: & Digk c
Decsnms e

T x| EEER
Meda verfication aption
™ Only reztore from media with the following name:

DK Cancal

6. From the [Choose Restore Destination] panel, press the [...] button to choose your
master backup (*.bak) from your backup files

l

= Choose the fle name or backup device o use for the:
=) resiore operation. Backup devices can be craated foi fies
that you uge requently.

& [File name |F \MSSOLTVBACKUPA .

" Backupdevice: | =l

o

7. Press the [OK] button, to start restoring the “master” database.

C. Restart Microsoft SQL Server in “Normal Mode”
1. Remove “-m” parameter from the [Startup Parameters] as in previous step
2. Restart your Microsoft SQL Server as in previous step

iv. (Optional) Restore “model”, “msdb” and “distribution” database

You need to restore “model” database if you have changed the database template of your SQL
Server.

You need to restore “msdb” database if you have changed the scheduling information or you want
to restore the backup and restore history of your databases.
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You need to restore “distribution” database if you are running the replication components of SQL
Server.

You do not need to restore these databases if you just want to restore a user database. For more
information on Microsoft SQL Server “model”, “msdb” and “distribution” database, please visit
http://www.microsoft.com/sql/.

You need to restore each of these databases one by one. To restore any of these databases,
please do the following:

a.

b.

From [Enterprise Manager] -> [Tools] -> [Restore Database]

Select the database to be restored in the [Restore as database] drop down list

Select the [From device] radio button.

Press the [Select Devices] button

Press the [...] button to choose your backup files (*.bak) for the database to be restored

Press the [OK] button

V. Restore user database(s)

For each of the database you would like to restore,

a.

b.

C.

g.

From [Enterprise Manager] -> [Tools] -> [Restore Database]
Select the database to be restored in the [Restore as database] drop down list

Select the [Database] radio button.

CrrTa— 1
General ] Dptions |
‘Tﬁ Bestore a5 database: [sbe =
Restore: & Datsbase " Flegroups o files ™ From device
Patameters
Show backups of datsbae .
First backup to restore: [13m1/20m 185243 =]
r [
Restore | Type | Backup set date | Sae [ Restore from | Backup set name
v Lj 13/1/2000 1 0Kb CAMSSOL
| | I
oK I Cancel | Help |

From the [Show backups of database] drop down list, select the database to be restored

From the [First backup to restore] drop down list, select the snapshot of the database you
would like to restore to.

You can restore your database to the snapshot of your database at any point of the time
between the time you did your full backup and the time you did your last subsequent backup.

Change the [Restore From] entry

If you backup files (*.bak) are not in the default directory, you need to update the full path
to your backup files by pressing the [Properties] button.

Press the [OK] button

vi. All database(s) restored successfully
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11 Backup/Restore Lotus Domino / Notes

This chapter will describe in details how to use OBM to backup your Lotus Domino server / Notes client5/6 / 6.5

and how you can restore your Lotus Domino server / Notes client 5/ 6 / 6.5 from the backup files.

11.1 Requirements

i. OBM must be installed onto the computer running Lotus Domino server / Notes client.

ii. Data from Lotus Domino server / Notes client will be backed up to a temporary directory before
they are sent to Offsite Backup Server. Please make sure you have sufficient disk space on your
computer to store these data when you run the backup job.

iii. Lotus Domino server must runs with archive transaction logging enabled

To set up transaction logging in archive style, please do the following:

a. Ensure that all databases to be logged reside in the Domino data directory, either at the root

or in subdirectories.

b.  From the Domino Administrator, click the Configuration tab.

a. In the "Use Directory on" field, choose the server's Domino Directory.

b.  Click Server Configuration, and then click Current Server Document.

C. Click the Transactional Logging tab.

d. Complete these fields, and then save the document.

Field

Enter

Transactional Logging

Choose Enabled. The default is Disabled.

Log path

Path name location of the transaction log.

The default path name is \LOGDIR in the Domino
data directory, although it is strongly recommended
to store the log on a separate, mirrored device,
such as a RAID (Redundant Array of Independent
Disks) level O or 1 device with a dedicated
controller.

The separate device should have at least 1GB of
disk space for the transaction log. If you are using
the device solely for storing the transaction log, set
the "Use all available space on log device" field to
Yes.

Logging style

Choose Archive. The default is Circular.

Maximum log space

The maximum size, in MB, for the transaction log.
Default is 192MB. Maximum is 4096MB (4GB).
Domino formats at least 3 and up to 64 log files,
depending on the maximum log space you allocate.

Use all available
space on log device

Choose one:

. Yes to use all available space on the device for
the transaction log. This is recommended if you
use a separate device dedicated to storing the
log. If you choose Yes, you don’t need to enter
a value in the "Maximum log space" field.

. No to use the default or specified value in the
"Maximum log space" field.

Automatic fixup of
corrupt databases

Choose one:

. Enabled (default). If a database is corrupt and
Domino cannot use the transaction log to
recover it, Domino runs the Fixup task, assigns
a new DBIID, and notifies the administrator that
a new database backup is required.
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. Disabled. Domino does not run the Fixup task
automatically and notifies the administrator to
run the Fixup task with the -J parameter on
corrupt logged databases.

Runtime / Restart This field controls how often Domino records a
performance recovery checkpoint in the transaction log, which
affects server performance.

To record a recovery checkpoint, Domino evaluates

each active logged database to determine how

many transactions would be necessary to recover
each database after a system failure. When Domino
completes this evaluation, it:

. Creates a recovery checkpoint record in the
transaction log, listing each open database and
the starting point transaction needed for
recovery

. Forces database changes to be saved to disk if
they have not been saved already

Choose one:

e Standard (default and recommended).
Checkpoints occur regularly.

. Favor runtime. Domino records fewer
checkpoints, which requires fewer system
resources and improves server run time
performance.

. Favor restart recovery time. Domino records
more checkpoints, which improves restart
recovery time because fewer transactions are
required for recovery.

Notes:

You can only run transaction log backup if you have transaction logging enabled and you are
using archive mode. This command does not apply if you have transaction logging enabled not
in archive mode or if transaction logging is not enabled at all. If you try to issue it, you will
receive an error message.

11.2 Overview

OBM will backup your Lotus Domino server / Notes client by taking the following steps:

Vi.

Run all Pre-Commands of this backup set
If the backup type to run is [Database Backup type],

a. all file(s) / database(s) selected are copied to the temporary directory specified by this
backup set

b.  the notes.ini file, if selected, will be copied to the temporary directory

C. only filled log extents will be copied to the temporary directory, and the Domino server is
notified of their availability for reuse (for Domino server only)

(for Domino server only) If the backup type to run is [Transaction Log Backup type],

a. only filled log extents will be copied to the temporary directory, and the Domino server is
notified of their availability for reuse

Run all Post-Commands of this backup set
Upload all files copied to the temporary directory to the Offsite Backup Server

Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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11.3 How to backup Lotus Domino / Notes database(s) / file(s) on
Windows

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using
OBM.

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
Backup and Festart 4
Backup and Shutdown  ®

Help
Stop Running Backop P

Exat

[ 1446
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set]

e =101x]
B Backup  View
e BT
Remaove » - MSSQLBackupSet1
Save M3 Exchange Backup Set
Exit M3 S0L Server Backup Set S
! chup
il QL Backup Set
& pEser, oL Backip roso BOL Server Backup
r Oracle Database Backup Set soLs
erver
+- (@9 BackupGet-7 i
=[S MySQOLBackupSet-1 Login[D:  3a
I3 Backup Source Password:
it Backup Schedule
3;:;?;:3 nd Line Tool Properies I
5 Encryption
[4] Log Table (MSSQLBackupSer1) @
T\rpe] Log Time ]
Backup | Log
‘Welcome to Online Backup Manager! |auota (Remaining / Total): 499G / 506G |Last Backup: 2004-07-22 14:32

b. Enter a name for your backup set

X
Backup Set
Please lype a name for this Bac h.lp Set.

Name: [LotusBackupSet-1
Type: Lotus Domino Server Backup
Lotus

notes.ini: [D \LotusiDominoinotes. ini

Cancel Frey Mext =
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C.

d.

e.

f.

Select the Backup Set Type (Lotus Domino Server Backup / Lotus Notes Client Backup)

Select the database(s) / file(s) you want to backup

X

Backup Source
Please select files orfand directories to be backed up

= (@ Lotus Domino -
B O o

& (1 domino

4 Cd gtrhome

B Cnelp

B C11IBM_TECHNICAL_SUPPORT

M CiNotes

B4 Cl logdir

FA 1 mail =
| | +
Temporary directory for storing backup files
Change I

]C ‘Backupilotus
¥ Remove tlemporary files after backup

Cancel « Previous Nexd »
_cancel | _cprovous | _Nat> |

WO R R EEE

Enter a temporary location to store the backup files before they are sent to an Offsite
Backup Server

Set the backup schedule for Database Backup

Backup Schedule
Flease schedule the backup time.

dackup Schedule (Type: Datab

Transaction Log Backup Schedule (Type: Transaction log, Weekly

| J 0|

Add I Remove | Froperies |

Cancel |

= Previous | Mext =

Set the backup schedule for Transaction Log Backup (for Domino server only)

(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Sefing
Flease setup the encryption setting of the Backup Set

I~ Do NOT use encryption

Algorithm: {Twofish ‘I

Mode:
 CBC (Cipher Block Chalning)
" ECB (Electronic CookBook)
Encrypting Key: [
Confirm Encrypting Key: |

= Previous | Mext = Cancel |

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select the backup type (e.g. Database, Transaction Log) you would like to perform (for
Domino server only)

Select Backup Type (LotosBackupSet-1) x|
Backup
@ Database (notes ini, Databases, Files, Transaction Logs}

" Transaction Logs

il Cancel |

c. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

" Lacal Hard Disk (Seed Load Uility)

Start the backup for [LolusBackupSet1] 7

oK Cancel I
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11.4 How to restore Lotus Domino / Notes database(s) / file(s) on
Windows

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from an
Offsite Backup Server.

Install Lotus Domino server / Notes client back to its original folder (if required)

Install OBM

Please refer to the [Installation] section for information on how to install OBM onto your computer.

Shutdown Lotus Domino Server

If you want to perform a full domino restore (restore all databases and files):

a.

d.

e.

Download the backup files to be restored from the Offsite Backup Server and save them
back to its original location. It includes notes.ini, all backup files from the lotus domino data
directory and all archived transaction logs

Modify the “DominoRecover.bat” located under the bin directory of the OBM installation to
reflect your setup. You need to specify the lotus executable directory.

For example change the PROGRAM_DIR to:
PROGRAM_DIR=C:\Lotus\Domino

Run “DominoRecover.bat” and press ‘Y’ to continue.
For example: C:\program files\obm\bin\DominoRecover.bat

This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus
data directory (e.g. C:\Lotus\Domino\Data). You should see something similar to the screen
below.

Media Recovery Example:

C:\program fil es\ obm bi n>Doni noRecover . bat
Medi a Recovery Utility for Lotus Domino 5.0 or above

Pl ease nake sure that you have done the follow ng:

1. Reinstall Lotus Donmino on this conputer in the same directory

2. Restore Notes.ini to the Lotus Domno installation directory
(e.g. C:\Lotus\Donino)

3. Restore Donino Data directory back to the directory defined
in Notes.ini (e.g. C\Lotus\Doni no\Data)

4. Restore all archived transaction logs to the directory defined
in Notes.ini (e.g. C\Lotus\Doni no\Data\logdir)

Continue ? (Y) or (N vy

Runni ng nedi a recovery ...

Pl ease wait, creating new transaction logs in directory: C:\logdir\

02/ 12/ 2003 14:39:19 Recovery Manager: Restart Recovery conplete. (0/0
dat abases needed full/partial recovery)

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
02/12/ 2003 14:39:22 Recovery Manager: Media Recovery conplete for

C:\ Lot us\ Domi no\ Dat a\ adni n4. nsf, |ast update applied .

Backup file C:\Lotus\Doni no\Data\adm n4. nsf recovered.

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
02/ 12/ 2003 14:40: 57 Recovery Manager: Media Recovery conplete for
C:\ Lot us\ Domi no\ Dat a\ statrep. nsf, |ast update applied .

Backup file C:\Lotus\Dom no\Data\statrep.nsf recovered.

C:\program fil es\ obm bi n>

All content of all database(s) are now rolled forward to the last committed transaction found
in the last archived transaction log.

Restart Lotus Domino server
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V. If you just want to restore a single database:

a. Download the database file to be restored from the Offsite Backup Server and save them
back to its original location.

b.  (optional) If you need to perform media recovery on this database, please download all
archived transaction logs and save them back to its original location

C. Modify the “DominoRecover.bat” located under the bin directory of the OBM installation to
reflect your setup.

For example we will recover the “admin4.nsf” and have restored the file to
C:\restore\notesdata, change the tags to:
PROGRAM_DIR=C:\Lotus\Domino
INPUTFILE=C:\restore\notesdata\admin4.nsf
RESTOREDB=C:\Lotus\Domino\Data\admin4.nsf
RECDATE=18/01/2007
RECTIME=00:02

d. Run “DominoRecover.bat”.

You should see something similar to the screen below.

Media Recovery Example:

C:\program fil es\ obn>Doni noRecover . bat
Medi a Recovery Utility for Lotus Domino 5.0 or above

Runni ng nedi a recovery ...

Restart Analysis (0 MB): 100%

18/ 01/ 2007 14:42:15 Recovery Manager: Restart Recovery conplete. (0/0
dat abases needed full/partial recovery)

Medi a Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
18/ 01/ 2007 14:42:17 Recovery Manager: Media Recovery conplete for

C:\ Lot us\ Domi no\ dat a\ adni n4. nsf, |ast update applied .

Backup file C:\Lotus\Doni no\data\adm n4. nsf recovered.

C:\ Lot us\ Doni no>

e. All content of the database are now rolled forward to the last committed transaction found in
the last archived transaction log.

f. Restart Lotus Domino Server
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11.5 How to backup Lotus Domino / Notes database(s) / file(s) on

Linux

Please make sure that the user running OBM have sufficient privileges to read and write to the “notesenv” file
located in the “bin” subdirectory of where OBM is installed. This file is used by OBM to store the location of the

domino/notes application executables. e.g. use chmod to set read, write & execute permissions

# cd $OBM_HOME/bin
# chmod 777 notesenv

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using

OBM.

i. Open OBM by typing th

# cd $O0BM_HOME

e following in a terminal

# ./bin/BackupManager.sh

ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set]

Backup Sel | Barkup Restore Tools View Help

Online Backup Manager

.-_x Remove

| = New ¥ | File Backup Set
¥ B Sistem State Ba

5| 5ave Seming | l? Backup

Set

H Exit =
-
Lﬁ M35 SOL Se arkup Se .
| MySQL Backup Set
|& Oracle Database Backup Set
[ Properties |
[¥] Run scheduled backup on this compuier
Log Table (FileBackupSet-1) 0
Type| Log Time
| X Backup ¥ 115

‘Welcome to Online Backup Manager!

Quota (Remaining / Total): 93 29G / 100G Last Backup: 2007-01-29 17:43

b.  Enter a name for your backup set

d Add new Lotus Backup Set E
~Backup Set

Flease type a name for this Backup Set.

Mame: |LotusBackupSet-1

Type: Lotus Domino Server Backup

~Lotus

notes.ini: flocal/notesdata/notes ini Change |
Cancel < Previous Mext >
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Select the location of the “note.ini” file. The default path for this will be in the
/local/notesdata folder.

Select the database(s) / file(s) you want to backup

=

Add new Lotus Backup Set x

-Backup Source
Pleass selact filas orfand directories to be backed up
% (@ Lows Dorning: -
¢ M Dara
©- [4 ] Deskiop
© [A (118 _TECHNICAL SUPPORT
€[4 (] ofic
€[4 1 domino
&[4 ] girhome
& A dhelp
e[ iNetes
&[4 1 mail

T emporary directory for storing backup files—————

fvarfbackup/Lotus Change |
[¥ Remove temporany files after barkup
Cancel < Previous Nexi >

Enter a temporary location to store the backup files before they are sent to an Offsite
Backup Server. Please make sure that the user running OBM have sufficient privileges to
read and write to this location and sufficient space is available.

Set the backup schedule for Database Backup

=

Add new Lotus Backup Set | % |

Backup Schedule
Please schedule the backup time

|Dalanase BackupSchedule (Type: Database; Weekly — Fri:layﬂ
[Transaction log BackupSchedule (Twpe: Transaction Logs; ey

soc |[ Remove || propenies |
Cancel < Previous Next >

z Database BackupSchedule Properties z
Name: |Patabase BackupSchedule |
rBackup

® Database {notes.ini, Databases, Files, Transaction Logs)
 Transaction Logs

rType
C Daily

® Weekly ) Monthly r Custom

~Day
Backup on the following day(s) every waek:
[ Sunday [0 Monday [ Tuesday [ Wednesday
[C Thursday [ Fnday [[] Saturday

Start Time fhhemm)y: (21« |2 00 >

rStop

Stop on completion (Full Backup)

Ok Cancel

Set the backup schedule for Transaction Log Backup (for Domino server only)
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day

transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

Set the encryption algorithm, encryption mode and encrypting key for this backup set
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> Add new Lotus Backup Set

1

~Encryption Setring
Please setup the encryption setting of the Backup Set.

) Default (Use Login Password 25 Encrypting Key)
® Custom

[l Do MOT use encryotion.

Algorithrm: | AES -
Mode:
® CEC {Cipher Block Chaining)

' ECB (Flectranic CookBook)
Encrypiing Key |
Confirm Encrypting Key: |

Cancel < Previous Hext >

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

iii. Run Backup

a.

d.

Select the backup set you want to run on the left panel and press the [Start Backup] button

)

Select the backup type (e.g. Database, Transaction Log) you would like to perform (for
Domino server only)

Select Backup Type (LotusBackupSet-1) E

 Backup
‘® Darabase (notes.ini, Darabases, Files, Transaction Logs)

) Transaction Logs

Ok Cancel

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server.

Conlirm Backup 5 ksl

Backap
® Offsitz Jackup Serwor
7 Local Hard Dis< (Seed Load Liility)

Start the harkop fre [ atusRarknpset-1] #

[ ok | cance || opons>> |

You should get something similar to the screen shot below.
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Online Backup Manager =
Backup Set Backup Restore Tools Yiew Help

|5l save Sening | P M stop Backup
5‘, Backup Controller ! & Backup Sei - LotusBackupSei-1
=2 user Profile ~Backup Set

-2 nq‘:i_nlusﬂa[ku;ﬁel—l
9 Barkup Source

ackup Schedule

Mame: LotusBackupSet-1 ‘:1
Type: Lotus Domino Server Backup -
F=

{2 Log Table {LotusBackupser-1)
Type | Log | Time |
Star [ Linux 2.6 9-42 ELlsmp (localhost), OBM 5.2 1.0 Fi01/30 01:58:21]
arl running pre-commands 130 01:58:22]
Finished running pre-commands 130 01:58:22
Stari backing up Motes.ini to " fvarfbackupfLotus /1170093109 130 01:58:22
End backing up Motes.ini 130 01:58:22]
Stari backing up updated files/databases to " fvarfbackupfLotu 130 01:58:22]
Backing up " flocalfnotesdata,/domino fhtmlfDAD fsetup. exe” 1/30 015827
*flocalfnotesdata/doming /htmlfDAD fsetup.exe” backup succes. 1/30 01:58:39]
Backing up "flocal fnotesdata/domino fhtml/favicon.ico™ 130 01:58:39]
*flocaljnotescdata/doming fhtmlffavicon.ico” backup successiully 1/30 01:58:41]
cking up *flocal fnotesdata/domino fhtml/dwa?. cab® 130 01:58:41]
alfnotesdatafdomino htmlfowa7 cab” backup successiully. 1/30 01:58:42]

Backing up "flocal fnotesdata/domino fhtml/chwa? W cab™ 130 01:58:42]
*flocaljnotescdata/domino fhimldwa7 ¥ cab” backup successiully 1/30 0158 43]
Backing up *flocal fnotesdata/domino fhtml/dwa7res_en dil" 130 01:58:44]
*flocaljnotescdata/doming fhimlfdwa7res_en dil backup succes 1/30 0158 45]
Backing up "flocal fnotesdata/domino fhtmlfiNotes&. cab® [2007 0130 01:58:45]

| O eackup [V Restore | & /loa |
Backing up *flocal fnotesdara/dominofhtml fiMotesé. .. |Quota (Remaining f Totaly 99.29C § 100G Last Backup: 2007-01-29 17:43

11.6 How to restore Lotus Domino / Notes database(s) / file(s) on
Linux

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from an
Offsite Backup Server.

i. Install Lotus Domino server / Notes client back to its original folder (if required)

ii. Install OBM

Please refer to the [Installation] section for information on how to install OBM onto your computer.
iii. Shutdown Lotus Domino Server
iv. If you want to perform a full domino restore (restore all databases and files):

a. Download the backup files to be restored from the Offsite Backup Server and save them
back to its original location. It includes notes.ini, all backup files from the lotus domino data
directory and all archived transaction logs. If you encounter any access problems, please try
restoring using the “root” user.

b.  Make sure that the owner and group permissions of the restored files are the notes user
For example: # chown —R notes:notes /local/notesdata

This will assign the owner and group to all files and directories within /local/notesdata.

C. Modify the “DominoRecover.sh” located under the bin directory of the OBM installation to
reflect your setup. You need to specify the data directory and the lotus executable directory.

For example change the DATA_DIR and LOTUS tags to:

DATA_DIR=/local/notesdata
LOTUS=/opt/ibm/lotus

d. Make sure the current user is the notes user before running the “DominoRecover.sh”.
e. Run “DominoRecover.sh” and press ‘Y’ to continue.
For example: #./usr/local/obm/bin/DominoRecover.sh

This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus
data directory (e.g. /local/notesdata). You should see something similar to the screen below.
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Media Recovery Example:

bash-3.00$ cd /usr/local /obni bin
bash- 3. 00$ ./ Doni noRecover. sh
Medi a Recovery Utility for Lotus Domino 5.0 or above

Pl ease nmake sure that you have done the follow ng:

1. Reinstall Lotus Donmino on this conputer in the same directory

2. Restore Notes.ini to the Lotus Domno installation directory
(e.g. /local/notesdata)

3. Restore Donino Data directory back to the directory defined
in Notes.ini (e.g. /local/notesdata)

4. Restore all archived transaction logs to the directory defined
in Notes.ini (e.g. /local/notesdata/logdir)

Continue ? (Y) or (N) y

Runni ng nmedi a recovery ...

directory /local/notesdata// already exists

Pl ease wait, creating new transaction logs in directory: /local/notesdata/logdir/
02/01/2007 11:38:43 AM Recovery Manager: Restart Recovery conplete. (0/0 databases
needed full/partial recovery)

02/01/2007 11:38:45 AM Recovery Manager: Assigning new DBIID for

/1 ocal / not esdat a/ names. nsf (need new backup for media recovery).

Medi a Recovery Replay (0 MB): 100%

02/ 01/ 2007 11:38:45 AM Recovery Manager: Media Recovery conplete for

/'l ocal / not esdat a/ df ¢/ df c100. nsf, |ast update applied .

Backup file /local/notesdatal/dfc/df cl100. nsf recovered.

Medi a Recovery Replay (0 MB): 100%

02/01/2007 11:38:46 AM Recovery Manager: Media Recovery conplete for
/'l ocal / not esdat a/ hel p/ decsdoc. nsf, |ast update applied .

Backup file /local/notesdatali Notes/hel p70_i wa_en. nsf recovered.
Medi a Recovery Replay (0 MB): 100%

02/ 01/ 2007 11:38:50 AM Recovery Manager: Media Recovery conplete for
/'l ocal / notesdata/ mai | / notes. nsf, |ast update applied .

Backup file /local/notesdatal/ mail/notes.nsf recovered.
bash- 3. 00$

f. All content of all database(s) are now rolled forward to the last committed transaction found
in the last archived transaction log.

g. Restart Lotus Domino server

V. If you just want to restore a single database:

a. Download the database file to be restored from the Offsite Backup Server and save them
back to its original location.

b. (optional) If you need to perform media recovery on this database, please download all
archived transaction logs and save them back to its original location

c. Modify the “DominoRecover.sh” located under the bin directory of the OBM installation to
reflect your setup.

For example we will recover the “admin4.nsf” and have restored the file to
/restore/local/notesdata, change the tags to:
DATA_DIR=/local/notesdata
LOTUS=/opt/ibm/lotus
INPUTFILE=/restore/local/notesdata/admin4.nsf
RESTOREDB=/local/notesdata/admin4.nsf
RECDATE=18/01/2007
RECTIME=22:41

d. Make sure the current user is the notes user before running the “DominoRecover.sh”.

e. Run “DominoRecover.sh”.

You should see something similar to the screen below.

Media Recovery Example:

bash-3.00$ cd /usr/local /obn bin
bash- 3. 00$ ./ Doni noRecover. sh
Medi a Recovery Utility for Lotus Domino 5.0 or above

directory /local/notesdata// already exists
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Recovering backup file ...

Restart Analysis (0 MB): 100%

18/ 01/ 2007 03:35:56 PM Recovery Manager: Restart Recovery conplete. (0/0 databa ses
needed full/partial recovery)

Medi a Recovery Replay (1 MB): 30% 50% 80% 100%

18/ 01/ 2007 03:35:57 PM Recovery Manager: Media Recovery conplete for /local/res
tore/local / not esdat a/ adni n4. nsf, |ast update applied .

Backup file /local/restore/local/notesdatal adm n4. nsf recovered.

Taki ng dat abase /1 ocal / not esdat a/ admi n4. nsf offline ...

Restoring database /| ocal / not esdat a/ adm n4. nsf

fromrecovered backup file /local/restore/local/notesdatal/adm n4.nsf ...
Dat abase file /local/notesdata/adm n4.nsf restored from/local/restore/local/not
esdat a/ admi n4. nsf

Bringi ng database /| ocal / not esdat a/ admi n4. nsf online ...

Program conpl et ed successful ly.
bash- 3. 00$

f. All content of the database are now rolled forward to the last committed transaction found in
the last archived transaction log.

g. Restart Lotus Domino Server
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12 Backup/Restore Microsoft Exchange Server

This chapter will describe in details how to use OBM to backup your Microsoft Exchange Server 2000 / 2003 and
how you can restore your Microsoft Exchange Server 2000 / 2003 from the backup files.

12.1 Requirements

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please
refer to http://www.microsoft.com/exchange/ for more information.
or
Microsoft Exchange Server 2003.

ii. OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003.

iii. Data from Microsoft Exchange Server will be backed up to a temporary directory before they are
sent to Offsite Backup Server. Please make sure you have sufficient space on your computer to
store these data when you run the backup job.

12.2 Overview

A Microsoft Exchange Server 2000/2003 stores its data in Windows Active Directory as well as in its databases.
To fully backup a Microsoft Exchange Server 2000/2003, you need to backup the following components:

i. Windows System State

The Windows System State contains the information about your Windows system, including
Windows Active Directory. A Microsoft Exchange Server 2000 / 2003 stores some of its
configuration, e.g. email accounts and mailbox properties, inside Windows Active Directory. It is
important that Windows Active Directory is backup properly when backing up a Microsoft
Exchange Server.

Active Directory is stored inside a Windows Server running as Windows domain controller. If your
Exchange Server is a domain controller, you can simply backup the Windows System State of
your Exchange Server. If your Exchange Server is running as a member server, you will need to
install another copy of OBM onto the domain controller to backup the Windows System State of
inside the domain controller.

For more information on Active Directory, please refer to
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp

ii. Microsoft Information Store
Exchange Server stores all emails and documents inside its databases, which are grouped
together as storage groups inside Microsoft Information Store. It is important that Microsoft
Information Store is fully backup when backing your Exchange Server.

iii. Microsoft Site Replication Service
Microsoft Site Replication Service is installed automatically when exchange server site replication
feature is enabled. Microsoft Site Replication stores its runtime and configuration information
inside its own database. If you are running your Exchange Server with Site Replication Service
enabled, please make sure that you backup the site replication database as well.

iv. Microsoft Key Management Service (Exchange 2000 only)
Similarly, if you have setup your Exchange Server with Key Management Services enabled, please
make sure that you backup the key management database as well.

OBM will backup your Microsoft Exchange Server by taking the following steps:
V. Run all Pre-Commands of this backup set
vi.  If the backup type to run is [Database Backup type],
a. Windows System State will be backed up to a temporary directory specified in its backup set

b.  All exchange database(s) selected are backed up to a temporary directory specified in its
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backup set
vii. If the backup type to run is [Transaction Log Backup type],

a. New transaction log extents generated since last backup will be copied to the temporary
directory

viii. Remove transaction log extents backed up from the Exchange Server
iX. Run all Post-Commands of this backup set
X. Upload all backup files from the temporary directory to an Offsite Backup Server

Xi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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12.3 How to backup Microsoft Exchange Server

Please follow the instructions below to backup your Microsoft Exchange Server 2000 / 2003 using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
3

3

Backup and Festart
Backup and Shutd own

Help
Stop Running Backop P

Exat

T 1446

ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Backup Set]

o =10] x|
Ba Backup View
“ File Backup Set l
Remava »  Lotus Backup Set 1- MSSQLBackupSat1
Save
Exit MS S0L Senver Backup Set
3 [SOLBackupSet1
TIITOOET  pesol Backup Set
=-[EMesaL rosof BAL Server Backup
« (#1M5Ext  Oracle Database Backup Set s
enver
= (31 BackupSet-7
= (G WyEOLBackupSet 1 ~alkd S
({3 Backup Source Password:
figy Backup Schedule
[ Command Line Tool Propetiss
O setting
& Encryption
1] Log Table (MSSQLBatkupSet1) o
Type I Log Time |
Backup | Log

‘Welcome to Online Backup Manager!

Quota (Remaining f Total): 49.9G /500 |Last Backup: 2004-07-22 14:32

b.  Enter a name for your backup set

Backup Set
Please type a name for this Backup Set.

Name: |MSExchangeBackupE&et-1

Type: Microsoft Exchange Server Backup

revioL | Newt =

Cancel |

c. Select the database(s) to be backup
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Backup Source
Please select Database 1o be backed up.

= 4= My Computer -
[ 84 System State
S :?chmsoﬂExthangeBer\fer
= =3 WIN2000SVR
=7 (% Microsoft information Store
= [T @ First Storage Group
[T 3 Mailbox Store (WINZ000SYR)
¥ 3 Public Folder Store (WIN20005VR)
- 7 o EER
FF 3 anc
W 3 acct
M 3 mail2 Ll

Temporary directory for storing backup files

IC'lBackuleSExnhange Change |
< Previous | MNex = Cancel I

If this Exchange Server is also a domain controller of this Active Directory, select the
[System State] checkbox as well. Otherwise, please install OBM to the domain controller of
this Active Directory and select the [System State] checkbox on that computer

Enter a temporary directory for storing the backup files before they are sent to an Offsite
Backup Server

Set the backup schedule for Database Backup

Backup Schedule
Flease schedule the backup time.

Transaction Log Backup Schedule (Type: Transaction log, Weekly

| J 0|

Add I Remove | Froperies |

= Previous | Mext = Cancel |

Set the backup schedule for Transaction Log Backup

(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day
transaction log backup by adding more than one daily transaction log backup schedule to
your backup set)

Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Sefing
Flease setup the encryption setting of the Backup Set

I~ Do NOT use encryption

Algorithm: {Twofish ‘I

Mode:
 CBC (Cipher Block Chalning)

" ECE {(Electronic CookBook)
Encrypting Key: [
Confirm Encrypting Key: |

= Previous | Mext = Cancel |

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
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CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
iii. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select the backup type (e.g. Database, Log Files) you would like to perform

" Log Files

o |_om |

c. Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server
and press the [OK] button

x|

" Local Hard Disk (Seed Load Utility)

Start the backup for [MSExchangeBackupSet-1] ?

il Cancel I

d.  You should get something similar to the screen shot below.

! : ; =101 x|
Backup Set  Backup View
=L ]
@ Backup Controller 2¢ | #1Backup Set - MSExchangeBackupSet-1
-ﬁ IU:.er S Backup Set
& Backup Source Marne: MEExchangeBackupSet1
i Backup Schedula Type:  Microsof Exchange Sarver Backup
Foom [—
S Encryption
[%] Log Table (MSExchangeBackupSet1)
Type I Log Time
3 Star [2004/01/31 13:53.47] 4|
&) Start running pre-commands [2004/01/31 13,53:47]
&) Finished running pre-commands [2004/01/31 13:53:47]
&) Using Temparary Directory - FABackupMSExchangel1 071124 .. [2004/01/31 13:53.47]
) Start Microsoft Exchange backup [2004/01/31 13:53:47]
&)  [Starf] Exchange Server - "WIN2Z0005VR" [2004/01/31 13:53:47]
&) [Star] Senice - “Microsoft Information Store” [2004/01/31 13:53:47]
) [Start] Storage Group - "First Storage Group® [2004/01/31 13:53:47]
B [Star]] Database - "Mailbox Store (WINZODOSVRY" [2004/01/31 13:53.47]
] Backing up 'E\Program Files\Exchsnrimdbdataipriv edb’ [2004/01/31 13:53:47]
&) Backing up E\Program FilesExchsnmimdbdatalprivl stm’ [2004/01/31 13:53:48)
B [End] Database [2004/01/31 13:53.51]
i [Star] Database - "Public Folder Store (N2000SVRY" [2004/01/31 13:53:51]
&) Backing up E\Program FilesiExchermmdbdatapubl adb’ [2004/01/31 13:53:51]
)] Backing up 'E-\Program Files'Exchsnrimdbdataipubt stm’ [2004/01/31 13:54:19]
i [End] Database [2004/01/31 13:54:22]
) [Star]] Backing up log files . [2004/01/31 13:54:22]
] Backing up ‘E-Program Files\ExchsnmimdbdatzlE0DDD0E. [2004/01/31 13:54:23] j
Backup | Log
Backing up E\Pragram Files\ExchsnnSGAacct stm' .. |Quota (Remaining / Tatal): 48.06G / 506 |Last Backup: 2004-01-31 10:42

12.4 How to restore Microsoft Exchange Server

Please follow the instructions below to restore Microsoft Exchange Server 2000 / 2003 from an Offsite Backup
Server.

i. Prepare the system for your Exchange Server (if required)

Install the original version of Windows and Exchange Server (with the same level of service pack
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installed as in the original system) back to your computer

Restore Windows Active Directory (if required)

If you have re-installed Windows, please download the Windows System State backup file, named
[SystemState.bkf], from Offsite Backup Server and then use [NTBackup.exe] to restore your
Windows System State to its backup time from the backup file by following the instructions below:

a. Run [NTBackup.exe] from [Start] -> [Run]
b.  Press the [Restore Wizard] button and then press the [Next] button

C. Press the [Import] button and use the [Browse] button to select the backup file
[SystemState.bkf] downloaded

d. Select the checkbox next to the description that matches your backup file
e. Press the [Next] button and then the [Finish] button

Install OBM (if required)

Please refer to the [Installation] section for information on how to install OBM onto your computer.
Startup the [Microsoft Information Store] services from Windows Services
Restore exchange database(s) from backup:

a. Download the database backup files to be restored from the Offsite Backup Server (or find
the cached copy available in the temporary directory defined in your backup set) and save
them to your hard disk (please make sure the directory structure is the same as it appears
on the browser), namely:

->[C:]

-->[backup]

---->[ABC]

------ >[Microsoft Information Store]
________ >[First Storage Group]
__________ >[Mailbox Store(ABC)]
_______________ >Privl.edb
_______________ >Privl.stm

__________ >[Public Folder Store(ABC)]
_______________ >Publ.edb
_______________ >Publ.stm

__________ >E0000001.log

b. If the database to be restored exists on your computer already, please dismount it from the
services using [Start] -> [Program] -> [Microsoft Exchange] -> [System Manager]

C. Use [ExchangeRestore.exe] from the [bin] directory under the installation directory of OBM
(e.g. C:\Program Files\OBM\bin\ExchangeRestore.exe) to restore the exchange database(s).

Simply run [ExchangeRestore.exe] to print the usage

ExchangeRestore.exe Usage:
C:\ Program Fi [ es\ OBM bi n> ExchangeRest ore. exe

M crosoft Exchange Server 2000/2003 Backup Recovery Uility

Usage:
ExchangeRestore DI R=pat h SERVER=server TEMP=t enpDir [ SERVI CE=service [ STORAGE=st
orage [ DATABASE=dat abase]]]

D R Directory containing all backup files
SERVER Nanme of Exchange Server to be restored
TEMP Tenporary directory to be used during restore
Pl ease specific a path with plenty of free space
SERVICE Nane of Exchange Service to be restored. It nmust be either
"M crosoft Information Store", "Mcrosoft Key Management Service"

or "Mcrosoft Site Replication Service"
STORAGE Nane of storage group to be restored
DATABASE Name of database to be restored

Exanpl es:
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1. To restore an exchange server:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\ Tenp"

2. To restore the information store:
ExchangeRestore DI R="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Tenp"
SERVI CE="M crosoft Information Store"

3. To restore an exchange storage group:
ExchangeRestore DI R="C:\ Backup" SERVER="ExchangeServer" TEMP="C:\Tenp"
SERVI CE="M crosoft Infornation Store" STORAGE="StorageG oupl"

4. To restore an exchange dat abase:
ExchangeRestore DI R="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Tenp"
SERVI CE="M crosoft Infornation Store" STORAGE="StorageG oupl"
DATABASE=" Dat abasel"

wher e
" C:\ Backup" is the directory containing all backup files
"ExchangeServer" is the server nane of an exchange server
"C:\ Tenp" is the tenporary directory to be used
" St orageG oupl” is the name of a storage group
" Dat abasel" is the nane of a database

d. (Example 1) To restore all databases from backup available in [F:\Backup] to an exchange
server named [WIN2000SVR] using the temporary directory [F:\Temp], you can use this
command:

E:\Program Files\OBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp"
SERVER="WIN2000SVR"

Exchange Server Recovery Example:

E:\ Program Fi | es\ OBM bi n> ExchangeRestore DI R="F:\Backup" TEMP="F:\ Tenp"
SERVER="W N2000SVR"

M crosoft Exchange Server 2000/2003 Backup Recovery Utility

[Start] Exchange Server - 'WN2000SVR
[Start] Service - 'Mcrosoft Information Store'
[Start] Storage Group - 'First Storage G oup'

[Start] Database - 'Mailbox Store (W N2000SVR)'

Restoring file 'E\Program Fil es\ Exchsrvr\ ndbdat a\ privl. edb’'
Restoring file 'E\Program Fil es\ Exchsrvr\ndbdata\privl. stm

[ End] Database - ' Mailbox Store (W N2000SVR)'

[Start] Database - 'Public Folder Store (WN2000SVR)'
Restoring file 'E\Program Fil es\ Exchsrvr\ nmdbdat a\ publ. edb’
Restoring file 'E\Program Fil es\ Exchsrvr\ ndbdat a\ pub1. st ni

[ End] Database - 'Public Folder Store (WN2000SVR)'

[Start] Restoring transaction log - 'First Storage G oup'
Restoring Log File 'F:\Tenp\restore.tnp\First Storage G oup\E00000B3. | 0g'
Restoring Log File 'F:\Tenp\restore.tnp\First Storage G oup\ EO0000B4. 1| og'

[End] Restoring transaction log - 'First Storage G oup'

[Start] Applying transaction log ...

[ End] Applying transaction |og

[End] Storage Group - 'First Storage G oup'
[Start] Storage Group - 'S&'

[Start] Database - 'acct’

Restoring file 'E\Program Fil es\ Exchsrvr\ S&\ acct . edb’
Restoring file 'E\Program Fil es\ Exchsrvr\ S&\ acct. stni

[ End] Database - 'acct’

[Start] Restoring transaction log - 'SQ&'

Restoring Log File 'F:\Tenp\restore.tnp\S&\ E0100072. | og'
Restoring Log File 'F:\Tenp\restore.tnp\S&\ E0100073. | og'

[End] Restoring transaction log - 'SG'

[Start] Applying transaction log ...

[End] Applying transaction |og

[End] Storage Group - 'SQ&'
[End] Exchange Server - 'W N2000SVR

E: \ Program Fi | es\ OBM bi n>

e. (Example 2) To restore the database named [mail] in storage group [SG5] from backup
available in [F:\Backup] to an exchange server named [WIN2000SVR] using the temporary
directory [F:\Temp], you can use this command:

E:\Program Files\OBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp"
SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" STORAGE="SG5"
DATABASE="maill"

Exchange Server Recovery Example:

E:\ Program Fi | es\ OBM bi n> ExchangeRestore DI R="F:\Backup" TEMP="F:\ Tenp"
SERVER="W N2000SVR' SERVI CE="M crosoft Infornation Store" STORAGE="SG5"
DATABASE=" i | "

M crosoft Exchange Server 2000/2003 Backup Recovery Uility

[Start] Storage Group - 'SG&'

[Start] Database - '‘mail"

Restoring file 'E\Program Fil es\ Exchsrvr\ SG5\ nai | . edb’
Restoring file 'E:\Program Fil es\ Exchsrvr\ SG5\ mai | . st ni
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[End] Database - "mail"

[Start] Restoring transaction log - 'SG5'
Restoring Log File 'F:\Tenp\restore.tnp\SG\ E0300012. | 0g" ...
Restoring Log File 'F:\Tenp\restore.tnp\SG\ E0300013.10g" ...
[End] Restoring transaction log - 'SGB'

[Start] Applying transaction log ...

[End] Applying transaction |og

[End] Storage Group - 'SG5'

E:\ Program Fi | es\ OBM bi n>
f. Repeat the same procedure for each database to be restored to the Exchange Server.

g. You can use [Start] -> [Program] -> [Administrative Tools] -> [Event Viewer] to check if
there are any errors generated from the exchange databases restoring activities.

vi. However, if ExchangeRestore.exe still cannot mount the restored files and returns with strange
errors, e.g. bad signature, or null errors. Then Exchange server might have incorrectly spooled
the backup files in the first place. Please try to mount the restored database and log files
manually by the following instructions:

a. In MS Exchange System Manager, dismount both the Mailbox Store and Public Folder Store
from the server.

b. Copy all the restored database files to the MDBDATA folder (By default, the MDBDATA folder
is located under C:\Program Files\Excgsrvr\)

Mailbox Store:
- privl.edb
- privl.stm
Public Folder Store:
- publ.edb
- publ.stm

C. Run "eseutil /r" to apply the transaction log files to bring the database to a consistent state,
e.g.:

C.\ Program Fi | es\ Exchsrvr\ MNDBDATA> ..\bin\eseutil /r e00

The above command will try to bring all the databases handled by the transaction log files
starting with “e00” located in “C:\Program Files\Exchsrvr\MDBDATA” into clean shutdown
state.

d. Run "eseutil /p" to repair the database files, e.g.:

Program Fi | es\ Exchsrvr\ NDBDATA> ..\ bin\eseutil /p privl. edb

C
C:.\ Program Fi | es\ Exchsrvr\ NDBDATA> ..\bin\eseutil /p publ.edb

——

e. Mount both Mailbox Store and Public Folder Store to the Server through the MS Exchange
System Manager.

vii. Completed
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13 Backup/Restore Windows System State

This chapter will describe in details how to use OBM to backup Windows System State and how you can restore
your Windows System State from backup.

13.1 Requirements

Microsoft Windows XP Professional / 2003
OBM must be installed onto the computer containing the system state you want to backup
Windows system state will be backed up to a temporary file before it is sent to OBS. Please make

sure you have sufficient space on your computer to store the temporary file when you run the
backup job.

13.2 Overview

OBM will backup your Microsoft Exchange Server by taking the following steps:

Run all Pre-Commands of this backup set
Windows System State will be backed up to a temporary directory specified in its backup set
Run all Post-Commands of this backup set

Upload the Windows System State backup files from the temporary directory to an Offsite Backup
Server

Remove the Windows System State temporary backup files from the temporary directory if
[Setting] -> [Temporary Directory for storing backup files] is enabled
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13.3 How to backup Windows System State

Please follow the instructions below to backup Windows System State using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
3

3

Backup and Festart
Backup and Shutd own

Help
Stop Running Backop P

Exat

[ 1446
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set]

-loix]
| Backup Set Backup Restore Tools View Help
| File Backup Set
(A Remove  » Syste
|| save Setting ' Lotus Backup Set
@ e | MS Exchange Backup Set
| | MSExchange Mail Level Backup Set
|0 MS SQL Server Backup Set
[ MySQL Backup Set tication for Windows
|@ Oracle Database Backup Set

User Name:
Password:

Froperties |

¥ Run scheduled backup on this computer

{] Log Table (FileBackupSet-1) "
Time | Log | Time

" Backup [ &) Restore] @ Log|

|Well:ume to Online Backup Manager! |Quota (Remaining / Total): 9.86G /106G |Last Backup: 2007-01-16 12:22

b.  Enter a name for your backup set
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Add new System State Backup Set x|

rBackup Set
Please type a name for this Backup Set.

Mame: IS\,rstemStateElackupSet-1|

1D 1169008343437
Type: Systemn State Backup

Cancel | = Previous | Mext =

C. Use the [Change] button to configure the [Temporary directory for storing backup files]
setting and check the [Remove temporary files after backup] if you want temporary files to
be removed automatically after backup

Add new System State Backup Set x|

~Backup Source

E- ' My Computer
L, Systerm State

~Temparary directory for storing backup files

IC:‘tEIackup‘tSystemState Change |

¥ Remove temporary files after backup

Cancel | = Previous | Mext =

d. Enter a temporary directory for storing the backup files before they are sent to an Offsite
Backup Server

e. Set the backup schedule for this backup set
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Add new System State Backup Set x|

~Backup Schedule

f.

Please schedule the hackup time.

Add

Remave | Properies |

= Previous |

MNext =

Cancel |

Add new System State Backup Set

X

~Encryption Setting
Please setup the encryption setting of the Backup Set.

" Default (Use Login Passward as Encrypting Key
(ol

[™ Do MOT use encryption.

Algarithim: IAES 'I

Mode:
¥ CBC (Cipher Block Chaining)

" ECE (Electronic CookBook)

Encrypting Key: |

Confirm Encrypling Key: I

= Previous

Cancel |

MNext =

Set the encryption algorithm, encryption mode and encrypting key for this backup set

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

iii. Run Backup

a.

Select the backup set you want to run on the left panel and press the [Start Backup] button

)

Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server

and press the [OK] button
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Backup to

" Local Hard Disk (Seed Load Utility)

Start the backup for [MSExchangeBackupSet-1] ?

il Cancel I

You should get something similar to the screen shot below.

. -0l x|
Backup Set  Backup View
=L ]
@ Backup Controller 2¢ | #1Backup Set - MSExchangeBackupSet-1
-ﬁ IU:er Profile Backup Set
& Backup Source Marme: MSExchangeBackupSet1
i Backup Schedule Type:  Microsof Exchange Sarver Backup
3Cnr\t|manuune‘[:|nl T |
3 Setting
S Encryption
|4 Log Table (MSExchangeBackupSet-1)
Type I Log Time
3 Star [2004/01/31 13:53.47] 4|
A)  Start running pre-commands [2004/01/31 13,53:47]
&) Finished running pre-commands [2004/01/31 13:53:47]
&) Using Temparary Directory - FABackupMSExchangel1 071124, [2004/01/31 13:53.47]
Q Start Microsoft Exchange backup [2004/01731 13:53:47]
&)  [Starf] Exchange Server - "WIN2Z0005VR" [2004/01/31 13:53:47]
&) [Star] Senice - “Microsoft Information Store” [2004/01/31 13:53:47]
) [Start] Storage Group - "First Storage Group® [2004/01/31 13:53:47]
ey [Star]] Database - "Mailbox Store (WINZODOSVRY" [2004/01/31 13:53.47]
] Backing up 'E\Program Files\Exchsnrimdbdataipriv edb’ [2004/01/31 13:53:47]
&) Backing up E\Program FilesExchsnmimdbdatalprivl stm’ [2004/01/31 13:53:48)
B [End] Database [2004/01/31 13:53.51]
i [Star] Database - "Public Folder Store (N2000SVRY" [2004/01/31 13:53:51]
&) Backing up E\Program FilesiExchermmdbdatapubl adb’ [2004/01/31 13:53:51]
)] Backing up 'E-\Program Files'Exchsnrimdbdataipubt stm’ [2004/01/31 13:54:19]
5] [End] Database [2004/01/31 13:54:22]
Y [Starl] Backing up log files . [2004/01/31 13:54:22]
] Backing up ‘E-Program Files\ExchsnmimdbdatzlE0DDD0E. [2004/01/31 13:54:23] j
Backup | Log
Backing up E\Program Files\ExchsnviSGNacct sim' .. Quota (Remaining / Total): 48.06G / 506 |Last Backup: 2004-01-31 10:42

13.4 How to restore Windows System State

Please follow the instructions below to restore Windows System State from an Offsite Backup Server.

i. Install OBM (if required)

Please refer to the [Installation] section for information on how to install OBM onto your computer.

ii. Restore the Windows System State Backup File (i.e. SystemState.bkf) from the backup server

iii. Use [NTBackup.exe] to restore your Windows System State to its backup time from the backup
file by following the instructions below:

a.

e.

Run [NTBackup.exe] from [Start] -> [Run]
Press the [Restore Wizard] button and then press the [Next] button

Press the [Import] button and use the [Browse] button to select the backup file
[SystemState.bkf] downloaded

Select the checkbox next to the description that matches your backup file

Press the [Next] button and then the [Finish] button

iv. Completed
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14 Backup/Restore Individual Brick Level Backup for Microsoft

Exchange Server

14.1 Requirements

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please
refer to http://www.microsoft.com/exchange/ for more information.
or
Microsoft Exchange Server 2003.

ii. OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003.

14.2 Overview

Brick Level Backup for Microsoft Exchange Server is not designed to fully protect an Exchange server, but to
facilitate easy backup and fast restore of individual emails, contacts, calendars, tasks etc. The brick level restore
cannot fully recover the Information Store after a disaster. If used, a brick level backup must be utilized in
conjunction with full Information Store Backup, in order to fully protect the exchange server.

14.3 Granting Privileges

Brick Level Backup requires “Full Mailbox Access” permission for the user running OBM. Normally, OBM can
acquire the permission on it's own but if you encounter ‘Access Denied’ errors you need to manually grant access
privileges to the user running OBM using one of the following instructions below:

For one specific mailbox

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox:
1  Start Active Directory Users and Computers.
2 On the View menu, ensure that the Advanced Features check box is selected.
3 Right-click the user whose mailbox you want to give permissions to and choose Properties.
4 On the Exchange Advanced tab, click Mailbox Rights.

5 Notice that the Domain Admins and Enterprise Admins have both been given Deny access to Full Mailbox
access.

6 Click Add, click the user or group who you want to have access to this mailbox, and then click OK.
7  Be sure that the user or group is selected in the Name box.

8 In the Permissions list, click Allow next to Full Mailbox Access, and then click OK.

9 Click Ok all the way out.

10 Restart the Microsoft Exchange Information Store.

For mailboxes located within a specific mailbox store

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox found on a
specific mailbox store:

1 Start Exchange System Manager.

2  Drill down to your server object within the appropriate Administrative Group. Expand the server object
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and find the required mailbox store within the appropriate Storage Group. Right-click it and choose
Properties.

3 In the Properties window go to the Security tab.
4 Click Add, click the user or group who you want to have access to the mailboxes, and then click OK.
5 Be sure that the user or group is selected in the Name box.

6 In the Permissions list, click Allow next to Full Control, and then click OK.

~

Click '‘Apply' and 'OK'

8 Restart the Microsoft Exchange Information Store.

For mailboxes located within a specific server

1 Start Exchange System Manager.

2  Drill down to your server object within the appropriate Administrative Group. Right-click it and choose
Properties.

3 In the Properties window go to the Security tab.

4 Click Add, click the user or group who you want to have access to the mailboxes, and then click OK.
5 Be sure that the user or group is selected in the Name box.

6 In the Permissions list, click Allow next to Full Control, and then click OK.

7  Click Ok all the way out.

8 Restart the Microsoft Exchange Information Store.
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14.4 How to backup Individual Brick Level Backup

Please follow the instructions below to backup all individual items within your Microsoft Exchange Server 2000 /
2003 using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
3
3

Backup and Festart
Backup and Shutd own

Help
Stop Running Backop P

Exat

[ 1446
ii. Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Mail Level Backup Set]
=18 x|

Backup Bet Backup Restore Tools View Help

@iFenoe b G System State Backup Set —
|| save Seting |4 Lotus Backup Set
i Exit |#) MS Exchange Backup Set

pSet1

|0 MS SQL Server Backup Set

BO4093

lup
B MyS0L Baciup Set Lrces Authentication for Windows
|@ Oracle Database Backup Set
User Name:
Password:

Properies

™ Run scheduled backup on this computer

] Log Table (FlleBackupSer1)
Type | Log | Time |

& Backup | &) Restore | & Log|
Welcome fo Online Backup Manager!

Quota (Remaining / Total): 9 B6G 106G |Last Backup: 2007-01-1916:58

b. Enter a name for your backup set
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Add new MS Exchange Backup Set !II
- Backup Set

Please type a name for this Backup Set.

Name: [MSExMailLevelBackupSet-1|
1D: 1169197729785
Type: MS Exchange Mail Level Backup

Cancel | = Previous | Next »

c. Select the email account(s) to backup

- Backup Source
Please select Database to be backed up.
Name |
= 4 SOL-WIN2000
'1" [ 3 Mailbox Store
-] &9 Public Folder Store

x|

From/To |

cancel | <Previous | Nex> |

- Backup Source
Please select Database to be backed up.

Name |
E- 3 SOL-WIN2000

=~ (43 Mailbox Store

-] 23 ADMINISTRATOR

-7 23 JANE DOE

-] 238 JOHN. SMITH

=[] 23 SYSTEMMAILBOXS
+-[] 59 Public Folder Store

x|

From/To |

cancel | <Previous | Nex> |
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Add new MS Exchange Backup Set x|

Backup Source
Please select Database to be backed up.

Name [ FomiTo |
E- 3 SOL-WIN2000
=~ 3 Mailbox Store
[] 23 ADMINISTRATOR
23 JANE DOE
8 calendar

@) Deleted ltems
43 Drafts
B3 Inbox
ﬁJDumaI
| Motes
B3 Outbox

s-b L] Sent tems

w4 o Tasks
-84 JOHN.SMITH =l

Cancel | < Previous I Next =

You can drill down to select individual items.

d. Set the backup schedule

Add new MS Exchange Backup Set x|

Backup Schedule
Please schedule the backup time,

Add Remaove I Properties I

Cancel | < Previous I Next =

BackupSchedule-1 Properties |

Mame: IEackupSchedule-1
~Backup
MS Exchange Mailbox

~Type
" Daily  wgekly O Maonthly © Custam

~Day
Backup everyday

~Start
Start Time {hh:mrm): |21 vI:IIJIJ 'l
~Stop

* Stop on completion (Full Backup)

" Stop aﬂerle hour(s)

Ok | Cancel |

e. Set the encryption algorithm, encryption mode and encrypting key for this backup set
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Add new ™S Exchange Backup Set

Encryption Setting
Please setup the encryption setting of the Backup Set.

" Default {Use Login Password as Encrypting Key)
- !C_ =

™ Do NOT use encryption.

Algorithm: |AES sl
Mode:
(* CBC (Cipher Block Chaining)

" ECB (Electronic CookBook)

Encrypting Key: |

Confirm Encrypting Key. |

Cancel | = Previous

Next »

iii. Run Backup

a.

Backup to

f* Offsite Backup Server
& Local Hard Disk {(Local Copy)

" Local Hard Disk (Seed Load Utility

Start the backup for [MSExMailLevelBackupSet-1] 7

0K | Cancel |

x|

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)

Select the backup set you want to run on the left panel and press the [Start Backup] button
)

Select [Offsite Backup Server] to start backing up your files to an Offsite Backup Server and
press the [OK] button

Confirm Backup Start

You should get something similar to the screen shot below.
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L1 Dnline Backup Manager

Backup Set Backup Restore Tools View Help

=181 %]

| sava Seting P> Start Backup [l 200 Ecciup

\oy Backup Controller

[La)

' User Profile

—{ § Setiing
—iay Encryption

=
{5 Backup Bchedule
] Command Line Tool

iy Retention Policy
=] Exfra Backup
= Local Copy

|| Backup Set- MSExMailLevelBackupSet-1
Backup Sat ﬂ
Mame: MSExMailLevelBackupSet-1
1D 1169197720785
Type: WS Exchange Mall Level Backup =
@ Log Table 10 7]
Type I Log | Time |—
D Start [Windows 2000 (s0-win2000), OBM 5.2.1.0] [2007M01A917:09:55] | &f
@ start running pre-commands 1200710119 17:09:55]
D Finighed running pre-commands |2007/01719 17:09:55)
L Reading backup source from hard disk. [2007/01/19 17:09:55)
0 Downloading server file list.. (200770119 17-:09:55]
DO D serverflie list.. C [2007/0119 17:08:55]
@  Reading backup source from hard disk . Complated 1200710119 17:09:55]
D Gefting all filas which have been added.. |2007/01/19 17:09:56]
€ Getting all files which have been added... Completad |2007/01/19 17:09:58)
() Getting all files which have been deleted (20070119 17-09:57)
0 Gething all fles which have been deleted . Completed (2007701519 17:09:57]
@ Mumber Of E-mail Account Remair="g" [2007/01719 17:09:57]
D) Exist E-mail Account |2007/01/19 17:09:57]
) JANEDOE |2007/01/19 17:09:57)
i) Total Mew E-mail Account= 1 (200770119 17-:09:57)
4 JANEDOE (2007001019 17-08:57]
@ Total Deleted E-mall Account= 0 [2007/01719 17:09:57]
@ Total New Mail =& [2007/01/19 17:09:57]
) Total Deleted Mail= 0 [2007M0111817:09:57)
0 [119] [New Directory] Upleading "SOL-AWINZ000* (200770119 17-:09:58]
G0 [2119) New Directory] Uploading *SOL-WIMZ000Wailbox Store” (200710119 17-09:58)
0 [319] MNew Directory] Uploading "SOL-WINZ000Wailbox S10relUMNE DOE” [2007/01/19 17:09:58]
@ [4N 9] [New Directory] Uploading “SOL-WINZ000WMailbox StoreUANE. DOECalendar’ [2007/01/19 17:09:58]
L [519] [New Mail] Uploading 100% of “S0L-WIN2000WMailbox StorelAANE DOEVCalendantest appointmant® |2007/01/19 17:09:59)
0 [6019) [Mew Mail] Uploading 100% of “S0L-WIN 2000\ ailbo StorelAANE DOEVCalendantest appointment... (200770119 17-:09:59)
G0 [719] New Mail| Uploading 100% of “SOLAMNZ000Wallbox StorelANE DOEICalendanaas” (2007101149 17-10:00)
ff,\- [81 9] [New Directory] Uploading “SOL-WINZO00Wailbox StoreWANE DOEVContacts® (2007019 17:10:00)
£7) 1011 00 Phlovws Misill | Ininartine 1 ANG Af"GALSATMINNMMaihow Clars) INE NNEY antarieiact rnnr a7 nam 2

& Bavkup [ Restore [ [ Log|

Backup Compléled Successiully

|Guota (Remalning / Tatal): 9 BEG / 106 |Last Backup: 2007-01-1916:58

14.5 How to restore Individual Brick Level Backup

Please follow the instructions below to restore individual emails, contacts, calendars, tasks etc. from an Offsite
Backup Server back into your exchange server. Please note that individual brick level can only be restored using

the OBM client.

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup
Backup and Logotf
Backup and Restart

Backup and Shutd own

3
3
3
3

Help

Stop Bunning Backop  F

Ezat

[ 1446

ii. Choose the [Restore] tab and select the items you want to restore
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=~ Backup Server

EHDE S0L-WINZ000

&g Mailbox Store

=

LA
0 8 Jou

2007-01-18 (17:09:55) »

=8 JANE DOE
- calendar

Subject ezt appointment (Received: Tue B1/2006 3:00 AM Size: 6K)
Subject test appaintment? (Received: Tue 812006 11:00 AM Size: By
Subject asa (Receied: Tue BM/Z006 12:00 PM Size: B&)

=& Contacts
LA g test (Date Modified: Fri 11192007 5:09 PM Size: 5K

%) Deleted tems
HOCa Drans
-0 inbox

Subject testing email (Received: Tua 8172006 2:40 PM Size: 10K)
mal

HOkd Notes
O Outbox
5023 Sent ltems
—0 e

iii. Press the [Restore Files] button

.1 Restore Files

I v T

iv.

Press [Start]
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.EnRestore Files |

Backup Set: MSExMailLevelBackupSet-1 (Microsoft Exchange Mail (MAPI)

Time | Log |

2007-01-1917:16:50 Start

2007-01-191716:50 Downloading restare file list ..

2007-01-191716:50 Same mail "SoL-WIN2000WMailbox StorelJANE. DOBEWCalendantest appaoi...
2007-01-191716:50 Same mail "SoL-WIN2000WMailbox StorelJANE. DOBEWCalendantest appaoi...
2007-01-1917:16:50 Same mail "SOL-WIN2000Wailbox StorelJANE.DOEWCalendanaas” exist..
2007-01-1917:16:50 Same mail "SOL-AWIN2000W ailbox StoretJANE. DOBEVC ontactsitest " exist..
2007-01-191716:50 Same mail "SoL-WIN2000WMailbox StorelJANE. DOBUnhodtesting email” ...
2007-01-1917:16:50 End

Estimated Total Restore Time: 0 sec (Total -39.31k bytes - 0 bytes restared)

Estimated Restare Time: 0 =ec {Total 0 bytes - 0 bytes restared)
Saving File Tao:
Restaring Speed: 0 bytesrsecond
Close | Start | Stop |
|End

v. Restore complete. Please logon to exchange to get the restored items.
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15 Backup/Restore MySQL Server

This chapter will describe in details how to use OBM to backup your MySQL server and how you can restore your
MySQL server from the database backup files.

15.1 Requirements

OBM must be installed onto the computer running MySQL server.

Data from MySQL server will be backed up to a temporary directory before they are sent to
Offsite Backup Server. Please make sure you have sufficient space on your computer to store
these data when you run the backup job.

There must be a MySQL account can be used to connect from localhost.
Add two new MySQL accounts for Backup Manager

mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost’
-> |IDENTIFIED BY 'some_pass';

mysql> GRANT ALL PRIVILEGES ON *.* TO ‘root'@'localhost.localdomain’
-> |IDENTIFIED BY 'some_pass';

mysql> FLUSH PRIVILEGES;

They are superuser accounts with full privileges to do anything with a password of some_pass.

15.2 Overview

OBM will backup your MySQL server by taking the following steps:

Run all Pre-Commands of this backup set

All database(s) (either local or external) selected are backed up to a temporary directory specified
in its backup set

Run all Post-Commands of this backup set
Upload all backup files from the temporary directory to an Offsite Backup Server

Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for
storing backup files] is enabled
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15.3 How to backup MySQL server on Windows
Please follow the instructions below to backup your MySQL server using OBM:

i. Open OBM

Right click OBM icon available in the system tray and choose [Open]

Backup 4
Backup and Logoff 4
3

3

Backup and Festart
Backup and Shutd own

Help
Stop Running Backop P

Exat

T 1446

ii. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set]
Create a backup set

a. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set]

=01
3 ackup  View
[ new s [T
Remave b Lotus Backup Set - MBSQLBackupSert
Save ME Exchange Backup Set
Exit ME SOL Server Backup Set
o e oLBackupSet1
&[] WESGL! rozoft SOL Server Backup
= #|MgExr  Ovacle Database Backup Set | .
+ (31 BackupSet-7 ——
= [Hi) MySOLBackupSet-1 ol L
Lgy Backup Source Fassword: ™
G Backup Schedule
B command Line Tool Properties |
0§ Setting
& Encryption
(%] Log Table (MSSOLBackupSet-1) e
Trme | Log | Time |
Backup I Log I
|Walcome fo Online Backup Manager Quota (Remaining / Totaly 49,96 1 506G |Last Backup: 2004-07-22 14:32

b.  Enter a name for your backup set

Backup Sat
Please type a name for this Backup Set.

Name: |MySQLBackupSet1

Type: MySOL Backup
MySQL
User Name: roat

Password: [~

Hostlocalhost

Port [3306

Path to mysqldump

[camysanvin Change |

:-;l

Cancel I
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C. Enter the root password, the MySQL server TCP/IP port number and the path to MySQL
backup utility (mysqgldump)

d. Select the database(s) to be backup

Backup Source
Please select databases to be backed up.

= @ 8 sl
W 1 abc
[ i menagerie
F W mysql
= 1) test

Tempaorary directory for storing backup files

Ic‘ BackupySaL Change I
= Pravious | Cancel

e. Enter a temporary directory for storing the backup files before they are sent to an Offsite
Backup Server, e.g. C:\Backup\MySQL

f. Set the backup schedule for Database Backup

Backup Schedule
Flease schedule the backup time

Add I Remaove I Properies I

Cancel |

= Previous |

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set

Encryption Setfing
Flease setup the encryplion setting of the Backup Set.

I~ Do NOT use encryption,

Algorithm: InES -

Mode:
& CBC (Cipher Block Chaining)
" ECB (Electronic CookBook)
Encrypting Key:  E—
Confirm Encrypting Key: [

<Previous |||

Cancel |

(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm,
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.)
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iii. Run Backup

a. Select the backup set you want to run on the left panel and press the [Start Backup] button

)

b.  Select [Off-site Backup Server] to start backing up your files to an Offsite Backup Server
and press the [OK] button

x|

~Backup to
& Off-site Backup Server

 Local Hard Disk (Seed Load Utility)

Start the backup for [MySQLB:

pSet1] ?

Cancel |

C. You should get something similar to the screen shot below.

age =101 x|
Backup Set  Backup View
=L
9 Backup Conlraller 2 | 14 Backup Set- MySOLBackupSet1
| £ User Profile Backup Set =
& () OracleBackupSet-1
& @) Lotus Notes Name: MySQLBackupSer1
- (L) MESALBackupSe1 Type: MySGL Backup
= [#) MSExchangeBackupSet-1 MySOL
& B BackupSerT
i g"ub User Name: roct
L4y Backup Source Passworg: ™
B et Host localnost
ommand Ling Too
_:.a.smg ! Part 3306
8 Encryption [Pt to mysaldurmp [
CAmysghbin
- =
() Log Table (MySQLBackupSet-1) o
Trpe | Log | Time |
j) Start [2004/07/22 16:47:01] | 4]
(&)  Startrunning pre-commands (2004/07722 16:47:01]
&)  Finished running pre-commands [2004/07/22 16:47:01]
&) Using Termporary Directory - 'CABackupiMySQL 0BBTE0442718 |2004/07/22 16:47:01]
(&) [Starl] Backing up database ‘mysql'to ‘mysql.sal’ |2004/07/22 16:47:01]
3  [Ena 1200407722 164701 _|
) Startrunning post-commands |2004/07/22 16:47:01] ﬂ
Backup I I-WI
[Finished running past-commands [Guota (Remaining f Total): 49.9G 1 505 |Last Backup: 2004-07-22 14:32
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15.4 How to backup MySQL server on Linux (command line mode)

If you want to setup OBM to backup MySQL server running on Linux using command line mode, please do the

followings:

Vi.

Vii.

viii.

Create a backup account on OBS

Logon to the web interface of OBS using the backup account created in the previous step (doesn’t

matter if it is not from the Linux server running the MySQL server to be backed up)

Create a new backup set by pressing the [Backup Set] -> [Add] button

Select the [Backup Set] -> [Type] -> [MySQL Database Server] radio button and press the
[Update] button (which can be found at the bottom of the page)

Setup all [Backup Set] -> [Database Backup Setting]

Settings

Descriptions

MySQL Username (e.g
root)

A MySQL user account that has backup access to the
databases to be backed up (e.g. root). Please refer to
the [Requirements] section for details

MySQL Password

Password of the MySQL user account being used

Host

IP address / Hostname of the MySQL Server, e.g.
localhost

MySQL Connection
TCP/IP Port

TCP/IP port used to access the MySQL Server (default:

3306)

Path to MySQL backup
utility (mysgldump)

Full path to where mysqldump can be found (e.g.
/usr/bin/mysqldump)

Temporary Spooling
Directory

A temporary directory to be used to store all MySQL
database dump files before they are uploaded to the
backup server

Enable Delete Temp. File

Whether to delete the temporary MySQL database
dump files after they are uploaded to the backup
server

Setup the [Backup Set] -> [Backup Source] setting

> Add an “MySQL” entry to the [Backup Source] if you want to backup all databases under

this MySQL Server

> Add two entries, “MySQL/databasel” and “MySQL/database2”, to the [Backup Source] if
you want to backup both “databasel” and “database2” under this MySQL Server

(Please use “\” instead of “/” if the MySQL server to be backed up is running on Windows

instead of Linux)

Setup the [Backup Set] -> [Backup Schedule] by pressing the [Add] link next the the “Backup

Schedule” sub-title

Install OBM onto the Linux server running MySQL server (Please refer to the [2.1 Installation of
OBM] section for details. The command line mode installation instructions are available on the

web interface)

Completed

If you have started up the OBM backup scheduler in the previous step, selected databases will be
backed up automatically at scheduled time
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15.5 How to restore MySQL server

Please follow the instructions below to restore MySQL server from an Offsite Backup Server.

i. Download the database backup files to be restored from the Offsite Backup Server

Please refer to the [5.3 Restoring file] section for information on how to download backup files
from Offsite Backup Server.

ii. Restore the database named [db_name] from the database backup file [db_name.sql]:

a. Connect to the MySQL server

(Windows) C:\> mysql
(Linux) [root@server ~]# mysql

b. Create the database to be restored
mysql> CREATE DATABASE IF NOT EXISTS db_name

c.Restore the database backup file back into the MySQL server

mysgl> use db_name ;
mysql> source db_name.sql ;

If db_name.sql is not located in the current directory, please specify the full path to the
db_name.sql file in the command above.

iii. Repeat the same procedure for each database to be restored to the MySQL Server.

iv. Completed
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16 Email Reporting

Offsite Backup Server makes use of the email system to keep you informed with the status of your backup
activities. Please make sure your contact information within the backup system is correct to receive the reports

described in this chapter.

16.1 New User Report

When a new backup account is added to the backup server, a new user report will be delivered to the contact
email(s) of the new account. The New User Report contains the following information:

Sample Report

VYWelcome to Online Backup Services

Login Mame
1. Login to our homepage Password
Alias
2. Follow the "User's Guide" to start using our backup Language
SEEE) Contact

Backup Guota

Further Information: Backup Server

Iffurther assistance is necessary, please refer to the FAQS

Generated at: SatJun 21 09:32:36 HKT 2003

Getting startoc: Usorseting

tMewhccount

spwd

s Mew Testing Account Mame
:English
LUSEr@waUr-company. com
150
rhackupyour-company.com

section.
Key Description
Login Name Login hame
Password Password
Alias Alias
Language Preferred Language for your backup report
Contact Email Address that will be used to contact you
Backup Quota |Backup quota
Backup Server |Backup server
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16.2 Forgot Password Report

If you have forgotten your password, you can use the [Forg

ot Password] feature available on the web interface to

have your password delivered to you through email. (Please refer to “Retrieve Forgotten Password” section in the

next chapter for more information on how to retrieve your
contains the following information:

forgot password report.) The Forgot Password Report

Sample Report

Request for forgotten password

the page above and you are receiving this email in errar,
please contact us.

2. What should you do after reading this email 7
Your current password is shown under the user setting.
You are suggested to change your password to a mare
easily remembered password and delete this email to
avoid any third party naining your password.

FAGS: User Setting

1. Why are you receiving this report? Login Mame :MewAccaunt
Yihen a user visits the forgot password page and requests  Password Tpwd
forthe lost passwoard ofthis backup account, all registered  Alias sMew Testing Account Mame
contacts of this particular account will receive a password Language :English
reminder email. Ifnone of the contact person has visited Contact T USer@yoUr-COmpanTy.corm

Generated at: SatJun 21 09:47:14 HKT 2003

Key Description

Login Name |Login name

Password Password

Alias Alias

Language Preferred Language for your backup report
Contact Email Address that will be used to contact you
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16.3 Backup Job Report

For each backup job you have run, a backup job report will be sent to you by email. This report contains a
summary for the backup job that was run and a full listing of all files being backed up by the backup job. The
backup summary report contains the following information:

Sample Backup Summary Report

Online Backup Job Report

Generated at: SatJun 21 10:00:05 HKT 2003

Backup Job Summary User Setting

Backup Time @ 21-Jun-2003 0957 - 21-Jun-2003 09:47 Lagin Mame L MewAccount

Status : Backup finished successfully Alias s Mew Testing Account Mame
Mew Files™ 1 [9K] Language :English

Updated Files* 1 [49k] Contact TUSEr@EyOU-COmPAany.com

Deleted Files™ @1 [4K]
Moved Files* @1 [3K]

*LInit=Mo. of Files [Total Size] Backup Setting

Backup Source s Oy Documentt
Afull listing of all backup files is available in the attached file.

Backup Statistics

Backup Data Size* s T [34k]
Retention Area Size™ 2 [13k]

Backup Guota s S0
FAQs: Remaining Quota  : 49.7M
1. Why are you receiving this report? *Unit= Mo. af Files [Total Size]
You are receiving this report because you are registered
as one ofthe contacts ofthis Online Backup account and
this particular account has performed a backup job
recenthy.
2. What if you have exceeded your quota?
Ifyour recyele hin size is not empty, you can emply your
recycle hinto free up more space. Please contact us for
more information on how to increase your storage guota.
If further assistance is necessary, please referto the FAGs
section.
Key Description
Backup Time The time when the backup job ran
Backup Status The overall status of the backup job. Normally, you should see “Backup
finished successfully” in this field. If you happen to get something else,
please consult the attached full report for more information.
New Files Total number and size of backup files added to your backup set
Updated Files Total number and size of backup files updated in your backup set
Deleted Files Total number and size of backup files deleted from your backup set
Moved Files Total number and size of backup files relocated in your backup set
Login Name Login name
Alias Alias
Language Preferred Language for your backup report
Contact Email Address that will be used to contact you
Backup Source All files/directories that will be backed up
Backup Data Size The total backup data stored in the data area
Retention Area Size |The total backup data stored in the retention area. Old copies of updated
or deleted backup files are retained in the retention area for the number of
days as specified by the retention policy of the backup set before they are
removed from the system.
Backup Quota Backup Quota
Remaining Quota Remaining Quota
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The full backup report, which contains a full listing of all files backed up by the backup job, is attached to the

backup job report email as a zip file. You need to unzip it before you can read the full report.

Sample Report

Full Ba

Generated at: Sat Jun 21 10:00:05 HKT 2003

ckup Report

Backup Set ;| BackupSet-0 Mew files* 1 [9k bytes
Backup Job 2003-06-21 (09:58) Updated files* 1 [9k bytes
Backup Status|: | Backup finished successfully Celeted files™® 1[4k bytes
Backup Timeﬂ: 2003-06-21 09:57 - 2003-06-21 09:57 Moved files* 1 [3k bytes

Type
Info
Info
Info
Info

bW
Z
=)

* Unit = Number of files [Total file size]

Backup Logs

Timestamp

2003-08-21 0957
2003-06-21 09:57
2003-06-21 09:57
2003-06-21 09:57

Backup Logs

Start running pre-commands
Finished running pre-commands
Start running post-commands
Finished running post-commands

Mo. Files

1 CihTesthlibWNew DANIEL.DOC Al

New Files

*compressed
Last Modified
2003-06-21 09:57

Size*

No. Files

Updated Files
Size*
1 CivTest\libhDAMIEL.DOC ak

*compressed
Last Modified
2003-06-21 0957

MNo. Files

1 CihTestyib\DANIEL_A BAK 4l

Deleted Files
Size*

*compressed
Last Modified
1996-11-29 15:45

MNo. Files

Moved Files

Size* Last Modified

1 CHTestKINGL.BAK -= CiiTestilibiKINGL BAK 3k 2003-06-05 12:35
Key Description

Backup Set The name of the backup set

Backup Job The name of the backup job (which is the start time of the backup job)

Backup Status

The overall status of the backup job. Normally, you should see “Backup
finished successfully” in this field. If you happen to get something else,
please consult the attached full report for more information.

Backup Time The time when the backup job ran

Backup Log All messages logged when running this backup job

New Files Total number and size of backup files added to your backup set
Updated Files Total number and size of backup files updated in your backup set
Deleted Files Total number and size of backup files deleted from your backup set

Moved Files

Total number and size of backup files relocated in your backup set

New File List

Full list of all backup files added to your backup set

Updated File List

Full list of all backup files updated in your backup set

Deleted File List

Full list of all backup files deleted from your backup set

Moved File List

Full list of all backup files relocated in your backup set
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16.4 Setting Change Report

After you have updated your user profile or backup setting, a setting change report will be sent to you. This
report allows you to track record of the changes that have been made to your backup account.

Sample Report

Backup Setting Changes Report

Why are you receiving this report ?

You are receiving this report since your persanal ar backup
sefting has been updated. Please confirm the infarmation
shown on the right is correct. Please make sure your setting is
not updated by sameane on your cantact list. Ifnone of them

Generated at: SatJun 21 11:00:00 HET 2003

User Setting

Lagin Mame : Mewdccount

Alias s Mew Testing Account Mame
Languange :English

Contact LUSer@yoUr-campany.com
Backup Cuota L a0mM

makes this changes, change your passward, carrectyour
setting and =see ifthis happens again. Ifthis happens again,

please contact us for further investigation.

If further assistance is necessary, please refer to the FAQS

section.

Backup Set - BackupSet-0

Source(s) + GOy Documentt
Schedulels) rMone

Filter tMone

Retention Policy s Keep deleted files for 7 days
Transfer Size 1 266K hytes
Pre-Command(s) rMone

Post-Command(s) :Mone

Key Description

Login Name Login hame

Alias Alias

Language Preferred Language for your backup reports
Contact Email Address that will be used to contact you

Backup Quota

Backup Quota

Backup Source(s)

All backup sources of the backup set

Backup Schedule(s)

All backup schedules of the backup set

Filter(s)

All backup filters of the backup set

Retention Policy

The retention policy of the backup set

Transfer Size

The transfer block size of the backup set

Pre-Command(s)

All Pre-Command(s) of the backup set

Post-Command(s)

All Post-Command(s) of the backup set
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16.5 Inactive User Reminder

You will receive an inactive user reminder in email if your account has been left inactive for the period of 7 days
(or the period specified by the system administrator). This is to remain you that you have not been running
backup for more 7 days. If you are a free trial user, your account will be removed from the system automatically
if the system can track no records of your backup activities in the next 30 days after receiving this report.

Sample Report

Inactive User Reminder

Generated at: SatJun 21 11:53:38 HET 2003

Why are you receiving this report ? User Setting
Laogin Mame s hewdsccount
You are receiving this report because this backup account has  Alias Mew Testing Account Mame
heen inactive for 30 days. Ifthis accaunt stays inactive for Language :English
another 30 days, this account will he rermaved fram aur Cantact L USERENOUR-COMpPany.com

system automatically without further notice. The following is
the hackup activity of this account;

Last Login Time : 2003-06-21 10:18 A
Last Backup Time : 2003-06-21 09:57 A

Iffurther assistance is necessary, please refer to the FAQS

section.
Key Description
Login Name Login nhame
Alias Alias
Language Preferred Language for your backup reports
Contact Email Address that will be used to contact you

Backup Quota

Backup Quota

Last Login Time

The last time you logon to the backup system

Last Backup Time

The last time you ran a backup job
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17 Web Features

Other than the features of OBM described in the previous chapter, the web interface of Offsite Backup Server
provides you access to some additional features that are not available in OBM. This chapter describes each of

these features

in details.

17.1 Install OBM

Before you can use OBM, you have to download the OBM installer from the web interface of Offsite Backup Server
and install OBM onto your computer. Please refer to the installation section (Chapter 2) for information on how to
install OBM onto your computer.

17.2 Upd

ate User Profile

You can update your user profile by using the [Profile] panel available on the web interface. To change your
profile, just make any changes to your profit on the panel shown below and press the [Update] button.

=101x
Restore | Install Software EaQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

User Summary

Quota Data Area* Retention 4rea*

Total Restore®

500 g1k [ 3] 14M[1] 5.2M[5]

* Unit : Compressed Size [Total Mo, of Files]
User Profile [ demo ]
Alias * [Demonstration Account
Language =|English j
Timezone * [ GuMT+08:00 (HKT) =]
Contact 1. Mame |Dero Account [Rernove]

Ermnail |demo@your—company.com

2. Name | [Add]
Ermnail |

Add-on Modules : Microsoft Exchange Server (Enable) , Microsoft SQL Server {(Enable)
Oracle Database Server (Enable) , MySQL Database Server (Enable)

Lotus Domino (Enable) , Lotus Motes {Enable) In-File Delta (Enable)

Update | Resetl

&l [ [ [ [w

-

Key Description

Quota Backup Quota

Data Area Total number and size backup files stored in the data area
Retention Area Total number and size of backup files stored in the retention area
Total Upload Total number and size of backup files uploaded to the backup server

Total Restore

Total number and size of backup files restored from the backup server

Login Name Login name

Display Name Alias of your backup account

Language Preferred Language for your backup report
Time Zone Your Time zone

Contact Email Address that will be used to contact you
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17.3 Request Forgotten Password

If you have forgotten your password, you can retrieve it by simply entering your login name or your registered
email address on the [Password Request] form and press the [Request] button. Your password will be sent to
your registered email address automatically.

=10l x|
Install Software FaQs | Help | Select Language
Logon | Forgot Password ?

Password Request

-Easy to use
-Fully Autormated G
-Daily backup Email: I

-Save you time and
SRR Reguest
At a glance: How to retrieve your forgotten password?

-Baclkup your data

S:i;omatlcally Every i. Enter either your "Login Mame" or "Email" in the
form above
-Aceess your dat_a ii. Pressthe [ Request ] button
anywhere, anytime ii. You should receive your passward immediately
-Retain all backup files, via email
even those that have
been deleted
-Backup your data to
our secure data center
-Fire? Earthquake?
Typhoon? Your data is
always safe

Login Name: |demD|

1] (e Y

17.4 Restore/Delete/Undelete Backup Files

Using the [File Explorer], you can browse through the backup data (both current and previous versions) on OBS.
You can select any current backup files to Restore or Delete. You can also select any deleted backup files (in gray)
to Undelete.

7} Online Backup Services Management Console - Microsoft Internet Explorer =18 x|

Restore | Install Software EAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout
Rows/Page: |50 'I
J Home > FileBackupSet-1 > 2007-01-16 (12:22) > F:\ > images

" Show files after Job |2DD?-D1-16 (12:22) ﬂ ' Show all files & Show Jobs View

Delete | Restore | Undelete |

& File / Directory Size Last Modified Zipped [Ratio]
M ..

@ A

Delelwel Restore Undelete

Note: 1. This shows all files / directories within a backup job of a backup set.
2. Files shown in light gray color refers to files retained in the retention area.
3. To restore files/directories, check the checkbox next to the files/directories and press the [ Restore ] button.
4. To delete files/directories, check the checkbox next to the files/directories and press the [ Delete ] button.
5. [D] = Differential delta file
6. [I] = Incremental delta file
] %J Local intranet
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17.5 Review Backup Jobs

In addition to reviewing your backup activities from the email report and from OBM, you can also review any of
your backup Jobs by using the [Report] panel available on the web interface. To review a backup job, just select
the required backup job from the [Backup Set] and [Backup Job] drop down list.

=1l ]
Restore | Install Software FAQs | Help | Select Language
Profile | Backup Set | File Explorer | Report | Statistics Logout

GETE T S FileBackupSet-1

=% More Information?

Job Statu_s : Backup finished successfully Detai!e -rg,g A Detailed Repart is
Backup Time : 2005/06/28 22:16 - 2005/06/28 22:17 (HKT) Report S8 . Cice
New Files* 0[0bytes ] Data Area 861k bytes
Updated Files* 0[0bytes ] Retention Area | 1.4M bytes
Deleted Files* 1[1.4M bytes ] Total Upload 2.2M bytes
Moved Files™* 0[0bytes ] Backup Quota 500M bytes

* Unit = Number of files [ Total file size ] Remaining Quota 497.8M bytes

@ [T 4
Key Description
Job Status The overall status of the backup job. Normally, you should see “Backup

finished successfully” in this field. If you happen to get something else, please
click the [Detailed Report] images on the page.

Backup Time The time when the backup job ran

New Files Total number and size of backup files added to your backup set
Updated Files Total number and size of backup files updated in your backup set
Deleted Files Total number and size of backup files deleted from your backup set
Moved Files Total number and size of backup files relocated in your backup set

Backup Data Size [The total backup data stored in the data area

Retention Area The total backup data stored in the retention area. Old copies of updated or
Size deleted backup files are retained in the retention area for the number of days
as specified by the retention policy of the backup set before they are removed
from the system.

Total Upload Total number and size of backup files uploaded to the backup server

Backup Quota Backup Quota

Remaining Quota [Remaining Quota
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You can open the [Full Backup Report] to review all information logged by a backup job by clicking the [Detailed
Report] image on the [Report] panel.

Full Backup Report

Fu II Backu p Report Generated at: Sat Jun 21 10:00:05 HKT 2003

Backup Job Summary Backup Job Statistics

Backup Set BackupSet-0 Mew files* 1 [9k bytes
Backup Job 2003-06-21 (09:58) Updated files* 1 [9k bytes
Backup Status| : | Backup finished successfully Deleted files* 1 [4k bytes
Backup Time 2O03-06-21 09:57 - 2003-06-21 09:57 Moved files* 1 [3k bytes

* Unit = Mumber of files [Total file size

No Type Timestamp Backup Logs

1 Infa 2003-06-21 09:57 Start running pre-commands

z Info 2003-06-21 09:57 Finished running pre-commands
3 Info 2003-06-21 09:57 Start running post-comrmands

4 Info Z003-06-Z1 09:57 Finished running post-commands

Backup Logs

Files

1 CivTestilibyNew DANIEL.DOC ak

*compressed
Last Modified
2003-06-21 09:57

MNew Files
Size*

Files

Updated Files
Size*
1 CATestyibvDANIEL.DOC ak

*compressed
Last Modified
2003-06-21 057

Files

1 C:\TestylibhDANIEL_A.BAK alk

Deleted Files
Size*

*compressed
Last Modified
1996-11-29 15:45

Files

1 CTesthINGL.BAK -= CTestilibyKINGL.BAK 3k

Moved Files
Last Modified
Z003-06-05 12:35

Size®

Parameter Description
Backup Set The name of the backup set
Backup Job The name of the backup job (which is the start time of the backup job)

Backup Status

The overall status of the backup job.

Backup Time

The time when the backup job ran

Backup Log

All messages logged when running this backup job

New Files

Total number and size of backup files added to your backup set

Updated Files

Total number and size of backup files updated in your backup set

Deleted Files

Total number and size of backup files deleted from your backup set

Moved Files

Total number and size of backup files relocated in your backup set

New File List

Full list of all backup files added to your backup set

Updated File List

Full list of all backup files updated in your backup set

Deleted File List

Full list of all backup files deleted from your backup set

Moved File List

Full list of all backup files relocated in your backup set

17.6 Review Storage Statistics

You can review the amount of data you have stored on the backup server and uploaded to the backup server on
each day by opening the [Statistics] panel available on the web interface. To review your storage statistics for a
different month, just select the month you are after by selecting from the [Month] drop down list.
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=101 x|
Restore | Install Software FAQs | Help | Select Lanquane
Profile | Backup Set | File Explorer | Report | Statistics Logout
e
Storage Usage Summary Month (vrr-mMe)y: | 2005-06 &
Retention Area* 2%
2005-06-01 816.5M [ 3076 ] gz26.2M [ 3112 ]
2005-06-02 768.5M [ 3081 ] 7ra.2M [ 3111 ]
2005-06-03 763.5M [ 3081 ] Fre.2M [ 3111 ]
2005-06-04 0 7AE.5M [ 3084 ] Fa0.4am[ 3119 ]
2005-06-05 209.7M [ 1394 ] 1,006.6M [ 4616 ] 436.2M [ 2691 ] 119G [ 6010 ]
2005-06-06 209.7M [ 1394 ] B65.3M [ 4518 ] 0[0] 1.05G [ 5912 ]
2005-06-07 209.7M [ 1394 ] 865.3M [ 4518 ] n[o0] 1.05G [ 5912 ]
2005-06-08 209.7M [ 1394 ] 868.3M [ 4515 ] 0[0] 1.05G [ 5912 ]
2005-06-09 96.6M [ 1536 ] 1,000.2M [ 5259 ] 65.9M [ 914 ] 1.07G [ 6825 ]
2005-06-10 98.6M [ 1536 ] 875.2M [ 5288 ] 0[o0] 973.9M [ 6824 ]
2005-06-11 95.6M [ 1536 ] 875.2M [ 5285 ] 0[0] 973.9M [ 6524 ] b
2005-06-12 96.6M [ 1536 ] 875.2M [ 52588 ] 0[0] 973,9M [ 6624 ]
2005-06-13 98.6M [ 1536 ] 875.2M [ 5288 ] 0[0] 973.9M [ 6824 ]
2005-06-14 S6.4M [ 343 ] 917.7M [ 6041 ] 186k [ 60 ] a74M [ 6884 ]
2005-06-15 S56.4M [ 843 ] 917.7M [ 6041 ] 0[o0] 974M [ 6554 ]
2005-06-16 S6.4M [ 843 ] 917.7M [ 6041 ] 0[o0] 974M [ 6654 ]
2005-06-17 66.7M [ 1140 ] 9158.2M [ 6066 ] 10.9M [ 322 ] 9G4.9M [ 7206 ]
2005-06-18 66.7M [ 1140 ] 915.2M [ 6066 ] 0[0] 954.9M [ 7206 ]
2005-06-19 66.7M [ 1140 ] 915.2M [ 6066 ] 0[o] 9G4,9M [ 7206 ]
2005-06-20 66.7M [ 1140 ] 915.2M [ 6066 ] 0[o0] 964.9M [ 7206 ]
2005-06-21 £6.5M [ 1075 ] 918.4M [ 6131 ] 0[0] 954.9M [ 7206 ]
2005-06-22 £6.5M [ 1075 ] 915.4M [ 6131 ] 0[o0] 954,9M [ 7206 ] =l
[ e 4
Key Description
Date The date the following statistics are collected
Data Area Total number and size of backup files stored in the data area on a particular

date

Retention Area
particular date

Total number and size of backup files stored in the retention area on a

Uploaded Size
particular date

Total number and size of backup files uploaded to the backup server on a

Total Storage
particular date

Total number and size of backup files stored under your backup account on a
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18 Further Information
18.1 FAQs

Please see if your question has already been answered in our FAQs available on our website.

18.2 Contact Us

You can backup your data to an Offsite Backup Server by following instructions below.

Open OBM from the system tray

Choose [View] -> [About] from the top menu

g p b =101 %]
Backup Set Backup Restore Tools  View
[ Save Sefting  » StartBackup ® ©i  UserProfile
Backup
¢ Backup Controller x R BackupSet-1
1 Loz
T
i Backup Schedule e ke - _
] Backup Filter Network Resources Authentication for Windows
™ Command Line Tool Domain:
f setting User Name:
5 Encryption Password:
[ In-File Delta
&5 Local Copy Properties I
#- [ MSSALBackupSet-1
& (@) OracleBackupSet-1 [¥ Run scheduled backup on this computer
@ (¥ MSExchangeBackupSet-1
& @i LotusBackupSet-1
- (s MySQLBackupSet-1
| Log Table (FileBackupSet-1) o
Type | Log Time |
d) Start [2005/06/28 16:59:07] ﬂ
9 Start running pre-commands [2005/06/28 16:59:07]
\‘9 Finished running pre-commands [2005/06/28 16:59:07]
i) Downloading server file list.. [2005/06/28 16:59:071 ll
@ Backup | ¢ Restore | |1y Log |
|Bal:kun Completed Successfully |Quota (Remaining / Total): 500M / 500M |Lasi Backup: 2005-06-28 14:51

Contact your backup service provider using the information shown in the [About] dialog box

Online Backup Manager

x|

Online Backup Manager
Version4.8.1.1d

Backup Service Provider

Company: Backup Provider Company Limited
Backup Server: 192.168.0.22

Company Website: vwww backup-provider com
Email: support@backop-provider.com
Telephone: + (oo :000e0000
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